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Introduction

Welcome to the Hyperion Essbase Installation Guide. This guide helps you install 
Hyperion® Essbase® OLAP Server, the Hyperion Essbase sample applications, 
Hyperion Essbase Application Manager, Hyperion Essbase Spreadsheet Add-in, 
Hyperion Essbase Application Programming Interface (API), and Hyperion 
Essbase SQL Interface. It also provides information about hardware and 
network-protocol requirements.

This introduction contains the following topics:

● “Who Should Read This Book” on page xi

● “What’s in This Book” on page xii

● “What You Should Know Before You Start” on page xii

● “Conventions Used in This Book” on page xiii

● “Additional Documentation Sources” on page xiv

● “Hyperion Essbase HTML Documents” on page xvi

● “Ordering Printed Documentation” on page xviii

Who Should Read This Book
This book is for Hyperion Essbase system administrators who need to install and 
configure Hyperion Essbase server software on a Windows NT, Windows 2000, 
Windows 95, Windows 98, or UNIX platforms. It also assists Hyperion Essbase 
system administrators in setting up sample applications, working with network 
protocols, and helping client users install client software.

This book is also for client users who need to install client software. 
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What’s in This Book
This book describes the following:

● How to install server software from the Hyperion Essbase CD-ROM to 
Windows NT, Windows 2000, Windows 95, Windows 98, and UNIX servers.

● How to upgrade or register a server when new options or additional ports are 
licensed.

● How to set up the sample applications for client users.

● How to install client software on a network or local drive, from the network 
or CD-ROM. This includes Hyperion Essbase Application Manager, 
Hyperion Essbase Spreadsheet Add-in, and the Runtime Client.

● How to install the Hyperion Essbase API software.

● How to install the Hyperion Essbase SQL Interface software.

● How to use a different network protocol.

● How to set up your computer to use non-English versions of Hyperion 
Essbase.

● How to configure a stand-alone computer to run Personal Essbase.

● How to uninstall Hyperion Essbase software.

Additional information can be found in the readme.txt file.

What You Should Know Before You Start
Before you begin, make sure you have all the software, the documentation, and the 
Registration Card. These items are provided in the Hyperion Essbase package. 
Then do the following:

1. Read the Hyperion Essbase Start Here booklet.

2. If you are upgrading, determine whether you will be installing on a new 
computer or on the existing computer that is currently running Hyperion 
Essbase. If on the current computer, determine whether you will be installing 
in the existing directory or in a new directory. 

3. If you are upgrading from Release 5.x on the current computer, first back up 
your 5.x application and database files to another directory.
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4. Know the operating system of your server and your installed network 
protocol.

5. Ensure that you have the disk space and the memory that is required for the 
Hyperion Essbase products you plan to install, as documented in the Hyperion 
Essbase Start Here booklet.

6. Install Hyperion Essbase products in the following order:

a. Hyperion Essbase OLAP server and sample applications

b. Hyperion Essbase SQL Interface

c. Hyperion Essbase Application Manager

d. Hyperion Essbase Spreadsheet Add-in for 1-2-3

e. Hyperion Essbase Spreadsheet Add-in for Excel

f. Hyperion Essbase Runtime Client

g. Hyperion Essbase Application Programming Interface (API). 

Note: It is not required that you install all of the above products. On 
Windows platforms, you can install these products 
simultaneously from the CD-ROM.

Conventions Used in This Book
This book uses several formatting styles to indicate actions that you should take 
or types of information that you need. The following table lists each document 
convention.

Table i: Document Conventions 

Example Description

1, 2, 3 Numbered items indicate procedures to follow in a 
specific order.

● Bulleted items indicate a list of related items.

Product Dimension names and member names appear in regular 
font.

\ESSBASE Names of files and directories appear in This Font. 



xiv ■ Hyperion Essbase Installation Guide

Additional Documentation Sources
In addition to the Hyperion Essbase Installation Guide for Release 6.1, the 
Hyperion Essbase documentation set includes the following:

● The Hyperion Essbase Start Here booklet, which provides late-breaking 
information as well as the most important installation and migration 
information for Release 6.1 of Hyperion Essbase.

● The Hyperion Essbase Documentation Roadmap, which lists all the Hyperion 
Essbase documentation and tells you where to access the online information.

● The Hyperion Essbase New Features booklet, which contains the 
documentation roadmap and describes the new features that are provided in 
Release 6.1 of Hyperion Essbase.

● The Hyperion Essbase Quick Path Card (QPC) for Release 6.0, which 
provides an overview of the tasks involved in creating, using, and maintaining 
Hyperion Essbase databases.

● The Hyperion Essbase OLAP Server Database Administrator’s Guide, which 
explains the architecture of Hyperion Essbase, how to design databases, how 
to design calculations, how to set up Hyperion Essbase security, how the 
database is stored, and how to optimize Hyperion Essbase. The online 
Hyperion Essbase OLAP Server Database Administrator’s Guide includes the 
information for Release 6.1 of Hyperion Essbase, while the printed version 
does not.

Enter Specific text that you must type as well as keyboard 
keys appear in bold type.

Hyperion Essbase 
System Login dialog 
box

Names of dialog boxes and their controls, such as text 
boxes, and list boxes, appear in regular font.

Hyperion Essbase 
Installation Guide

Titles of books appear in italics. Italics also indicate 
important terms and special emphasis.

File > Open The greater than symbol (>) indicates a menu followed 
by an individual menu command in that menu.

Table i: Document Conventions (Continued)

Example Description
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● The Hyperion Essbase Application Manager online help file, which explains 
how to use the Application Manager user interface.

● The online Technical Reference in the DOCS directory, which lists and 
describes Hyperion Essbase functions, calculation commands, report 
commands, MaxL syntax, ESSCMD commands, and configuration file (.CFG 
file) settings for Release 6.1.

● The Hyperion Essbase Quick Technical Reference for Release 6.0, which 
provides syntax for Hyperion Essbase functions, calculation commands, 
report commands, ESSCMD commands, and configuration file (.CFG file) 
settings.

● The Hyperion Essbase Spreadsheet Add-in User’s Guide for Release 6.1, 
which explains how to use Hyperion Essbase Spreadsheet Add-in features 
with Microsoft Excel or Lotus 1-2-3 for Windows. This guide is provided 
in the \ESSBASE\DOCS\CLIENT directory in.PDF format for online 
viewing and printing in Adobe Acrobat Reader (Version 3.0.1 or later). 
Adobe Acrobat Reader is provided on the Hyperion Essbase CD-ROM, 
and can also be downloaded from http://www.adobe.com.

● The Hyperion Essbase Spreadsheet Add-in online help files, which explain 
how to use Hyperion Essbase Spreadsheet Add-in and provide all the 
spreadsheet macros and VBA functions.

● The online API Reference in the DOCS directory for Release 6.1, which lists 
and describes programmatic functions available through Hyperion Essbase 
API, and provides information to help you start programming with these 
functions.

● The Hyperion Essbase MaxL User’s Guide, which provides a conceptual 
overview of Maxl and its components. It also provides examples to help 
you get started in using MaxL to manage security and to perform 
administrative tasks on Hyperion Essbase databases. This guide is 
provided in the \ESSBASE\DOCS\CLIENT directory in .PDF for online 
viewing and printing in Adobe Acrobat Reader.

● The Hyperion Essbase SQL Interface Guide, which contains information 
on how to set up systems to load data by means of Hyperion Essbase SQL 
Interface. This guide is provided in the\ESSBASE\DOCS\CLIENT 
directory in.PDF format for online viewing and printing in Adobe 
Acrobat Reader (Version 3.0.1 or later). Adobe Acrobat Reader is 
provided on the Hyperion Essbase CD-ROM, and can also be downloaded 
from http://www.adobe.com.

http://www.adobe.com
http://www.adobe.com
http://www.adobe.com
http://www.adobe.com
http://www.adobe.com
http://www.adobe.com
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Hyperion Essbase HTML Documents
The Hyperion Essbase API and Hyperion Essbase Application Manager products 
include the online API Reference, the Technical Reference, the Hyperion Essbase 
OLAP Server Database Administrator’s Guide, and a Documentation Roadmap in 
HTML format. To view these documents, you must have the following:      

● Hyperion Essbase API or Hyperion Essbase Application Manager installed 
with the documentation on your server or client computer, or access to the 
HTML documentation on the CD-ROM or on a network drive.

● A Web browser such as Netscape Navigator (Version 4.0 or later) or Microsoft 
Internet Explorer (Version 4.0 or later) installed on your computer.

Note: If you installed the Hyperion Essbase OLAP Server or Hyperion 
Essbase Application Manager, the MaxL Language Reference is  
installed to Docs\Techref\Maxl. If you selected to install the  
complete online HTML documentation, this documentation is part of 
the Technical Reference, and you should follow the steps below to 
view. If you did not select the HTML documentation option, you can 
still view the standalone MaxL Language Reference by launching 
maxlref.htm in your Web browser.

➤ To view Hyperion Essbase HTML documentation:

1. Start your browser.

2. Open\ESSBASE\DOCS\INDEX.HTM wherever Hyperion Essbase API or 
Hyperion Essbase Application Manager is installed (either on the local area 
network or your local computer); for example,

C:\HYPERION\ESSBASE\DOCS\INDEX.HTM

The INDEX.HTM starting page is displayed.

● You can also access the HTML documentation from the Hyperion 
Essbase CD-ROM. From the root of the CD-ROM, open 
DOCS\INDEX.HTM.

● The links in the Hyperion Essbase Publications List work only for 
documents you selected to install when you installed the Hyperion 
Essbase API or Hyperion Essbase Application Manager.
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From the starting page, you can link to the API Reference, the Technical 
Reference, the Hyperion Essbase OLAP Server Database Administrator’s 
Guide, and the Documentation Roadmap.

Figure i: HTML Documentation Starting Page: Access by Opening 
INDEX.HTM 



xviii ■ Hyperion Essbase Installation Guide

Using a Recommended Web Browser
It is recommended that you use Microsoft Internet Explorer (Version 4.0 or later) 
or Netscape Navigator (Version 4.0 or later) to view Hyperion Essbase HTML 
documents. 

Acquiring a Recommended Web Browser
If you have a Web browser and are connected to the Internet, you can download 
recommended browsers from the Web sites shown in the following table:

Microsoft Internet Explorer is included with Windows platforms. Netscape 
Navigator can be downloaded for free from Netscape’s Web site. You can also 
purchase either browser from your software dealer.

Note: After you obtain a Web browser, you do not need to have Internet 
connectivity to read Hyperion Essbase HTML documents because 
they are installed on your local or network drive. 

You can telephone Microsoft at (800) 426-9400 or Netscape at 
(650) 937-2555. 

You are responsible for the legal licensing of these browsers. 

Ordering Printed Documentation
A catalog of the printed documentation is available from the Hyperion Solutions 
Support Web page at http://www:hyperion.com. You can order printed 
manuals by calling Hyperion Solutions Client Support at 1-877-901-4975 between 
8:00 A.M.-8:00 P.M., EST. You must request each manual by its full name and 
part number.

Table ii: Web Browsers

Product Web Site

Microsoft Internet 
Explorer

www.microsoft.com/windows/ie/download/ 

Netscape Navigator home.netscape.com/download/  

http://www.microsoft.com/windows/ie/download
http://www.home.netscape.com/download
http://www.hyperion.com
http://www.hyperion.com
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Chapter

1
Product Components and 
Software Registration

Welcome to the Hyperion Essbase family of products. Hyperion Essbase operates 
in a client-server environment. When you set up the Hyperion Essbase system, you 
create a Hyperion Essbase OLAP Server and configure clients to access the server.

This chapter contains the following topics:

● “Verifying Your Shipment” on page 19

● “Registering Hyperion Essbase Software” on page 21

● “Identifying the Installation Steps” on page 23

Hyperion Essbase product components include base system components and  
add-on products, which you license separately.  

Verifying Your Shipment
The Hyperion Essbase base system contains the following items: 

● The Hyperion Essbase OLAP Server software, containing the Hyperion 
Essbase server, the sample applications, and the setup program.

● The Hyperion Essbase Application Manager software, which is a Hyperion 
Essbase administration tool.

● The Hyperion Essbase Spreadsheet Add-in software for the Spreadsheet 
Add-in platform of your choice, enabling your spreadsheet application to 
work with the Hyperion Essbase server.

● A Software Registration Letter, containing the license number of your server.

● The Hyperion Essbase Start Here booklet, containing information that you 
should read before installing Hyperion Essbase, especially if you are 
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● Migrating from an earlier release.

● This book, Hyperion Essbase Installation Guide.

If you purchased additional Hyperion Essbase products with your base system, 
you will also receive documentation for the Hyperion Essbase products you 
licensed. The documentation set is described in “Additional Documentation 
Sources” on page xiv.

Adding Hyperion Essbase Integral Products
Hyperion Essbase has several add-on products that are an integral part of Hyperion 
Essbase although you license them separately. They include the following: 

● Hyperion Essbase SQL Interface

● Hyperion Essbase Currency Conversion

● Hyperion Essbase Spreadsheet Toolkit (including VBA for Excel for 
Windows)

● Hyperion Essbase Runtime Client

● Hyperion Essbase Partitioning 

For more information, contact your software provider.

Note: If you licensed one or more of these Hyperion Essbase products with 
your base system, your Hyperion Essbase Release 6.1 license number 
enables access to these products when you install the base system. 

Adding Separate Hyperion Essbase Products
Hyperion Essbase also has several products that are independent of the base 
system. They contain their own installation programs and documentation. You  
license them separately. These products include the following:    

● Hyperion Integration Server  

● Hyperion Essbase Application Programming Interface (API) 

● Microsoft SQL Server Interface

For more information, contact your software provider.
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Registering Hyperion Essbase Software 
Each Hyperion Essbase installation requires a license number. The Software 
Registration Letter lists your license number. This license number is unique for 
your server license. Your license number is encoded to identify and enable the 
options and capacity that you licensed. The letter lists all of the options you 
licensed and the number of ports available.    

Note: Keep this letter in a secure place for future reference.

When you receive your Hyperion Essbase shipment, verify that the correct options 
and number of ports are available. If the shipment does not contain the correct 
options, contact your software provider.

Entering License Numbers
During the installation of the Hyperion Essbase OLAP server and Hyperion 
Essbase Application Manager, you are prompted to enter your license number. 
Enter the license number exactly as it appears on your Software Registration 
Letter—as a sequence of sixteen alphanumeric digits followed by a single hyphen 
and the remaining digits.  

When you license additional products that are integral to Hyperion Essbase or 
extend their capacity, you will receive a new license number that reflects the 
additional options. Table 1 summarizes the integral products and ports that you 
can add. These products and port additions do not require you to install anything, 
but do require you to register the license number you received when you licensed 
the product.        

 

Table 1: Integral Product Registration Summary 

Additions to Hyperion Essbase Install and Register Register Only

Adding an Integral Product

Hyperion Essbase SQL Interface ✔

Hyperion Essbase Currency 
Conversion

✔

Hyperion Essbase Spreadsheet 
Toolkit (including VBA for Excel 
for Windows)

✔
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➤ To register a new license number: 

1. Stop the Hyperion Essbase server. 

If you are not sure how to stop the server, see Chapter 44, “Running Hyperion 
Essbase, Applications, and Databases,” in the Hyperion Essbase OLAP Server 
Database Administrator’s Guide.

2. Run the REGISTER utility. On Windows platforms, REGISTER resides in the 
\HYPERION\ESSBASE\BIN directory on the server. On UNIX platforms it 
resides in the /hyperion/essbase/bin directory on the server.  

3. Enter the new license number.

4. Start the Hyperion Essbase server.

Be sure that you read the README.TXT file included with the Hyperion Essbase 
installation. You can find this file in the\ESSBASE directory after installation is 
complete.

Installing and Registering Separate Products
When you license a separate product from Hyperion Solutions, you will need to 
install it from its CD-ROM. During the installation, you are asked for your license 
number. Enter the license number that you received with the product; for example, 

Hyperion Essbase Partitioning ✔

Hyperion Essbase Runtime Client ✔

Adding Ports

Licensing additional ports ✔

Table 1: Integral Product Registration Summary (Continued)

Additions to Hyperion Essbase Install and Register Register Only
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if you have licensed Hyperion Integration Server (HIS), type the number exactly 
as it appears on the HIS Software Registration Letter. Table 2 summarizes the 
integral products and ports that you can add.

 

The license number that you enter is embedded in the following Hyperion Essbase 
system files and validated each time you use Hyperion Essbase:

● essbase.exe 

● esssvr.exe 

● essadmin.exe 

● essexcln.xll 

● lsx123.dll 

The remaining chapters in this guide describe the installation steps for different 
platforms. The software must be installed in a specific order.

Identifying the Installation Steps
Before installing Hyperion Essbase, you should establish a working client-server 
environment based on a Named Pipes Services or TCP/IP protocol. Hyperion 
Essbase clients cannot communicate with the Hyperion Essbase server if the 
environment is not properly established. For information on supported network 
configurations, see Chapter 9, “Network Configuration Notes.”    

Table 2: Add-on Product Registration Summary 

Adding a Separate Product Install and Register Register Only

Hyperion Integration Server  ✔

Hyperion Essbase Application 
Programming Interface (API) 

✔

Microsoft SQL Server Interface ✔
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The following steps list the order in which the Hyperion Essbase system 
components must be installed:    

1. The Hyperion Essbase OLAP Server software and sample applications on the 
server computer

Note: The sample applications contain examples that are useful when 
learning to use Hyperion Essbase. You should install the sample 
applications to ensure that these learning aids are available.   

2. Hyperion Essbase SQL Interface on the server computer

3. Hyperion Essbase Application Manager on a client computer

4. Hyperion Essbase Spreadsheet Add-in on a client computer

5. Hyperion Essbase Runtime Client on a client computer

6. Hyperion Essbase API on a software development environment

Note: It is not required that you install all of the above products. 
On Windows platforms, you can install products simultaneously 
from the CD-ROM, and the installation program will install them 
in the correct order.

Be sure that you read the online Hyperion Essbase Installation Guide and 
README.TXT file included with the Hyperion Essbase installation for the latest 
information. You can find the Hyperion Essbase Installation Guide in the 
\essbase\docs\client directory after you have installed Hyperion Essbase. You can 
find the README.TXT file in the\ESSBASE directory after installation is 
complete.
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Chapter

2
Windows Server Installation

Hyperion Essbase OLAP Server is available for Windows NT or Windows 
2000-based Pentium computers. Personal Essbase is available for Windows 95, 
Windows 98, Windows NT, and Windows 2000 (Personal Essbase for Windows 
NT and Windows 2000 is available only for computers with Intel 
microprocessors).  

Read this chapter for information on system requirements, directories created, 
environment settings, and starting the Hyperion Essbase server on Windows 
platforms.

If you are installing Personal Essbase, first skip to “About Installing Personal 
Essbase” on page 47 and “Limitations of a Personal Essbase Server” on page 48 
to learn how to successfully configure Personal Essbase client and server software 
on the same computer.

This chapter contains the following topics:

● “Windows Server Requirements” on page 26

● “About Installing Server Software on Windows” on page 27

● “Installing Server Software on Windows” on page 29

● “Optimizing Network Throughput on Windows NT” on page 35

● “Starting the Hyperion Essbase Server” on page 37

● “Running Hyperion Essbase Agent as a Windows NT or Windows 2000 
Service” on page 40

● “Anticipating the Next Step” on page 46

● “Configuring and Running Personal Essbase” on page 47



26 ■

Windows Server Installation

Hyperion Essbase Installation Guide

Windows Server Requirements
The Hyperion Essbase server and Personal Essbase server for Windows platforms 
require a system that meets specific requirements. These requirements are 
described in Table 3.       

Table 3: Hyperion Essbase Server Windows System Requirements

Component Requirements

Microprocessor Pentium or higher

RAM 64 MB 1

1 The base recommendation for running Hyperion Essbase and its sample applications is 
64 MB. Start with this amount, and then allocate additional memory per Table 4 to 
accommodate your Hyperion Essbase application.

Windows version for   
Hyperion Essbase 
server

Windows NT 4.0 or Windows 2000 on Pentium

Windows version for 
Personal Essbase server

Windows 95 B, Windows 98, Windows NT 4.0, or 
Windows 2000 with Pentium

Disk space Approximately 60–80 MB for the server software and 
the sample applications

See Chapter 5, “Sample Applications.”

Network protocol Named Pipes or TCP/IP

JavaTM platform Java Runtime Environment version 1.2.2 or later, 
Java API for XML Parsing version 1.01 

Table 4: Allocating Additional Memory for Hyperion 
Essbase Server on Windows Platforms

Hyperion Essbase 
Component Approximate Amount of Memory Required

Code and static data 10 MB

Database outline 400 bytes per member

Index, data, data file, 
and calculator caches

Per the settings shown in the “Database Cache Settings 
Migration” table in the Hyperion Essbase Start Here 
booklet.
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About Installing Server Software on Windows
If you are upgrading from Release 5.x, first back up your 5.x application and 
database files to another directory.

You can install Hyperion Essbase server and client software at the same time from 
the CD-ROM. You can also install client software from a network drive.   

Some of the new features in Hyperion Essbase Release 6.1 require new license 
numbers. See Chapter 1, “Product Components and Software Registration,” for 
information on the software registration process.

Installing Hyperion Essbase SQL Interface or Hyperion Essbase Application 
Programming Interface is treated separately. See Chapter 8, “SQL Interface 
Installation” or Chapter 7, “API Installation.”

See the Hyperion Essbase Start Here booklet for important information on 
migrating your applications.   

Network Protocol Files
Network protocol files implement the TCP/IP or Named Pipes protocol that you 
select when you install Hyperion Essbase server or client software. The network 
protocol file for server software is ESSNET.DLL. Additionally, the client software 
(for example, Hyperion Essbase Spreadsheet Add-in) is installed with a separate 
ESSNET.DLL. Network protocol files reside in the BIN directory with the 
Hyperion Essbase program files.      

If you have more than one Hyperion Essbase server computer and the servers use 
different network protocols, you must install the client software in multiple 
directories, one for each network protocol.

For example, you can install Hyperion Essbase Spreadsheet Add-in for a Named 
Pipes server in N:\HYPERION\ESSBASE, and Hyperion Essbase Spreadsheet 
Add-in for a TCP/IP server in T:\HYPERION\ESSBASE. The two installations use 
different ESSNET.DLL files.
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Security
The ESSBASE.SEC file stores information about users, passwords, groups, 
privileges, and applications. Each time you successfully start the Hyperion 
Essbase Agent, ESSBASE.EXE (ESSBASE on UNIX platforms), Hyperion Essbase 
makes a backup copy of the security file (ESSBASE.BAK). If you attempt to start 
the Agent and a password prompt is not displayed or your password is rejected, no 
backup file is created. You can restore from the last successful startup by copying 
ESSBASE.BAK to ESSBASE.SEC. Both files are in the BIN directory where you 
installed the Hyperion Essbase server.      

Release Compatibility
It is recommended that you install the Release 6.1 server with Release 6.1 
client products. Client products include Hyperion Essbase Application Manager, 
Hyperion Essbase Spreadsheet Add-in, and Hyperion Essbase Runtime Client. 
Release 5.x or Release 6.0 clients work with the Release 6.1 server, but with 
feature limitations. For example, you cannot take advantage of the attribute 
dimension feature of Release 6.0 if you use Hyperion Essbase Application 
Manager Release 5.0.2 with a Release 6.0 server.

Using versions of a client that are later than the server version is not recommended 
or supported.

CAUTION: If you install one Release 6.1 client, you should make all 
clients on the same computer, including Hyperion Essbase 
Application Manager and Hyperion Essbase Spreadsheet 
Add-in, Release 6.1. Release 6.1 clients share.DLL files 
that may not work with earlier clients.
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Installing Server Software on Windows
The Hyperion Essbase server installation program, SETUP.EXE, performs the 
following operations:

● Copies Hyperion Essbase files to the\ESSBASE\BIN directory (or to the 
directory you specify) on your hard disk

● Copies, if you choose, Hyperion Essbase sample application files to 
the\ESSBASE\APP directory (or to the directory you specify) on your hard 
disk

● Installs an ESSNET file for supported network protocols: TCP/IP or 
Named Pipes

● Installs, if you choose, the Java Runtime Environment to the 
\ESSBASE\JAVA\JRE directory and sets the JVMODULELOCATION 
parameter in the essbase.cfg file

● Creates new directories for a new installation

● Updates existing directories if you have a previous release of Hyperion 
Essbase installed

● Updates, if you choose, the Windows environment settings

To enable the Java-based features of Hyperion Essbase, you must install Java on 
the computer running the Hyperion Essbase server. For more information about 
installing Java, see “Manually Installing Java” on page 196.

Installation Procedure
Install Hyperion Essbase server software on Windows platforms by running the 
installation program from the root directory of the CD-ROM.

➤ To install server software from the Hyperion Essbase CD-ROM to a computer 
running Windows NT, Windows 95, Windows 98, or Windows 2000:    

1. Insert the CD-ROM into the CD-ROM drive.

2. Run SETUP from the root directory of the CD-ROM.

3. Follow the prompts, and provide the information requested.

To cancel installation at any time, click the Cancel button and then the Exit 
Setup button. 
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4. When prompted, enter your license number exactly as it is shown on your 
registration letter.

See Chapter 1, “Product Components and Software Registration,” for more 
information on registration.

5. When the Select Components dialog box is displayed, select the Server 
products check box. 

This selection installs the Hyperion Essbase server and sample applications, 
as well as Hyperion Essbase SQL Interface (if that is included in your license 
agreement). To narrow the selection, go to step 6. To continue, go to step 7. 

The Java Runtime Environment (JRE) and Java API for XML Parsing (JAXP) 
is included as an optional installation component. The JRE and JAXP must be 
installed to enable the Java-based features of Hyperion Essbase. If you have 
already installed a compatible version of the JRE, you must configure it to run 
with Hyperion Essbase. For more information, see “Manually Installing Java” 
on page 196.

The installation program displays the product components for your license 
agreement and operating system.   

6. Click the Change button to view selected components or to select a subset of 
server components in the Select Sub-components dialog box (see Figure 1). 
Leave all options selected to select all server products, or deselect the server 
products that you do not want to install.  

Figure 1: Selecting Server ProductsSelecting Server Products

 



Windows Server Installation

2

■ 31Hyperion Essbase Installation Guide

7. When you finish selecting your options, click Continue, and then click Next 
in the Server Products dialog box.

8. In the Choose Server Destination Location dialog box, specify the directory 
where you want to install the server products that you have selected, and click 
Next.  

Unless another installation of Hyperion Essbase exists on the computer, the 
default directory is C:\HYPERION\ESSBASE. Click Browse to select or type 
the name of another directory. If you type the name of a directory that does not 
exist, the installation program creates the directory for you. 

Figure 2: Choosing Where to Install Server Products

9. In the Choose Network Protocol dialog box, select your network protocol, 
and click Next. 

10. In the Update Environment dialog box, select the environment updates that 
you want the installation program to perform, and click Next.    

a. If you are installing the Hyperion Essbase server, select whether the 
installation program updates environment variables and adds a program 
group to the Start menu.
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b. If you are installing Hyperion Essbase SQL Interface, select whether 
Open Database Connectivity (ODBC) registry information is to be 
updated.

Your old ODBC registry information will be appended to, but not 
overwritten, if you select Yes.

11. In the Check Setup Information dialog box, review the panel that 
summarizes your installation choices, and do one of the following:

●  To allow the installation program to begin copying files, click Next. 

● To revise your choices, click Back.

● To exit the installation program, click Cancel. 

12. In the Setup Complete dialog box, leave the check box selected and click 
Finish to view the Readme file.      

13. If you chose to let the installation program update the Path and 
%ARBORPATH% environment variables, do one of the following to allow the 
environment changes to take effect:

● On Windows NT or Windows 2000, log out and log in again, or reboot 
your computer. 

● On Windows 95 or Windows 98, reboot your computer.

Directories Created
The installation program creates a directory structure including the following:  

HYPERION
     ESSBASE
            APP
            BIN
            DOCS
               TECHREF
                 MAXL
            JAVA
            LOCALE
            PERLMOD
  

If you select to install the Java Runtime Environment to enable custom-defined 
functions and macros, a JAVA directory with files and subdirectories is also created 
under ESSBASE.
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In addition to a Readme file and the subdirectories listed above, the ESSBASE 
directory contains an *.ISU file for each installed server or client component 
and a file named Essunins.dll, which facilitates uninstalling the software.

CAUTION: Do not move, rename, or delete the *.ISU files in the 
ESSBASE directory. Do not rename the ESSBASE directory 
or any subdirectories or files beneath it. Alteration of the 
installed Hyperion Essbase files and directories prevents 
their successful uninstallation. In the event that you want to 
move Hyperion Essbase to another directory or revert to an 
earlier release, you will need to completely uninstall it first. 
For more information about uninstalling, see Chapter 10, 
“Advanced Installation Topics.”

The BIN directory contains the Hyperion Essbase server software. This now 
includes MaxL, a linguistic interface you can use via the MaxL Command Shell 
(essmsh.exe) or the Essbase Perl module (Essbase.pm) to automate most 
Hyperion Essbase system-administration tasks.      

The APP directory stores Hyperion Essbase application files as they are created. 
Each application is stored in a subdirectory under the APP directory. Each database 
in an application is stored in a separate subdirectory under the subdirectory of the 
application. 
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For example, suppose that you create two applications on the server: Finance and 
Marketng. Then you add two databases to the Finance application, Currency and 
Main, and two databases to the Marketng application, Product and Sales. The 
server directory structure looks like this:

C:\HYPERION\ESSBASE
      APP
         FINANCE
             CURRENCY
             MAIN
         MARKETNG
             PRODUCT
             SALES
      BIN
      DOCS
         TECHREF
             MAXL
      JAVA
      LOCALE
      PERLMOD

Note: Hyperion Essbase stores an activity log file for each application in the 
directory of each application. (In this example, there are log files in 
the FINANCE and MARKETNG directories.) Log files track all user 
requests made to the application or to databases within the 
application. 

The DOCS\TECHREF\MAXL directory contains the MaxL Language Reference, 
which you will need in order to use MaxL, the new multi-dimensional access 
language for Hyperion Essbase.

The JAVA directory contains the Java software to support the Java-based features 
of Hyperion Essbase. If you choose to automatically install Java from the 
Hyperion Essbase installation program, this directory contains the Java Runtime 
Environment and the Java API for XML Parsing.

The LOCALE directory contains the character-set files necessary for all the 
languages that Hyperion Essbase supports, including English. For non-English 
versions, you also need to create the ESSLANG environment variable. For 
more information about ESSLANG, see Chapter 10, “Advanced Installation 
Topics.” 
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The PERLMOD directory contains the files and documentation you need to add the 
Essbase Perl Module (essbase.pm) to Perl, enabling you to embed MaxL 
statements in Perl programs. You must install Perl yourself. For more information, 
see the MaxL Language Reference in the DOCS\TECHREF\MAXL directory, and the 
README file included in the PERLMOD directory.

Optimizing Network Throughput on 
Windows NT

On Windows NT servers, a network setting enables you to optimize the 
performance of networked applications. Hyperion Essbase performance improves 
significantly on Windows NT with this setting enabled.      

➤ To enable the Maximize Throughput for Network Applications setting:

1. Exit Hyperion Essbase.

2. Start the Windows NT Control Panel.

3. Double-click the Network icon.

4. Select the Services tab.

5. In the Network Services list box, double-click Server.

The Server dialog box is displayed.

If you see a message that you Cannot Configure the Software Component, 
then your Windows NT computer is probably a Windows NT Workstation 
configuration, not a Windows NT server configuration, and you cannot 
change the network settings.

Figure 3: Choosing Maximize Throughput for Network Applications

6. Select Maximize Throughput for Network Applications. 
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7. Click OK.

The Services tab of the Network dialog box is displayed.

8. Click Close.

9. Restart Windows NT.
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Starting the Hyperion Essbase Server
Before you can access the Hyperion Essbase server, the proper network protocol 
must be installed and running on your Windows NT or Windows 2000 computer.    

See Chapter 9, “Network Configuration Notes,” for information on network 
protocols. 

➤ To start Hyperion Essbase: 

1. From a command prompt, type ESSBASE and press Enter.

If you encounter any errors during startup:    

● Check your path and environment settings.

● Make sure the appropriate network protocol is installed and running on 
your Windows NT or Windows 2000 computer.

2. Take one of the following steps:

● If this is a first-time installation, enter the following items: 

– Company name. The name you enter is embedded in your server 
license registration.

– Your name. The name you enter will be designated as the Hyperion 
Essbase system supervisor. Use this name for your initial login from 
the Essbase client to the Essbase server.

– System password. This password is required when you start the 
Hyperion Essbase server. It is also required to gain access to the 
server from clients using the system supervisor account. 

You are asked to confirm your choices. Type Y to verify your entries, or 
N to retype them.

See Chapter 4, “Application Manager and Spreadsheet Add-in 
Installation,” for information on Hyperion Essbase Application Manager.

See the MaxL Language Reference in the DOCS\TECHREF\MAXL 
directory for information on MaxL.

● If this is not a first-time installation, enter the system password that you 
specified when you first ran Hyperion Essbase.

The Hyperion Essbase window then displays the following message:

Waiting for Client Requests...
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You can now use the Hyperion Essbase window to perform high-level supervisor 
operations. See “Using Hyperion Essbase Agent Commands” on page 39 for a list 
of available commands. For more information on starting and stopping the server, 
see “Running Hyperion Essbase, Applications, and Databases” in the Hyperion 
Essbase OLAP Server Database Administrator’s Guide.

Automating the Server Startup    
On Windows 95, Windows 98, Windows NT 4.0, and Windows 2000, you can 
place the Hyperion Essbase server program in a startup folder so it will start 
automatically when Windows boots. You can also specify the server password, to 
avoid having to enter it each time the Hyperion Essbase server starts.

➤ To automate the server startup on Windows platforms, take the following actions:

1. Find the Windows Start Menu customization controls. 

● On Windows NT, Windows 95, or Windows 98, select Start > Settings > 
Taskbar > Start Menu Programs tab.

● On Windows 2000, select Start > Settings > Taskbar & Start Menu > 
Advanced tab.

2. Click Add and specify the location of the Hyperion Essbase Agent program 
file, ESSBASE.EXE. If you installed Hyperion Essbase to the default directory, 
this is C:\HYPERION\ESSBASE\BIN\ESSBASE.EXE.

If you want the Hyperion Essbase system password to be automatically 
entered each time Hyperion Essbase starts, type the password after 
ESSBASE.EXE on the command line. For example, type 

C:\HYPERION\ESSBASE\BIN\ESSBASE.EXE password 

where password is your Hyperion Essbase system password.

3. Click Next, and then double-click the StartUp or Startup folder.

4. Enter Hyperion Essbase 6.1, or your server name, and click Finish.
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Automating an Application or Database Startup    

You can also automatically start up an application or database. When the Hyperion 
Essbase server is started, Hyperion Essbase starts any application or database 
that is defined with an automatic startup setting. You define startup settings in 
Hyperion Essbase Application Manager using the Application Settings dialog box 
and the Database Settings dialog box.

Note: See Hyperion Essbase Application Manager online Help for more 
information.

Using Hyperion Essbase Agent Commands
Hyperion Essbase has a server console called the Agent. When you start the main 
Hyperion Essbase program (ESSBASE.EXE), the Agent console is displayed. Use 
this console to perform high-level server operations. Pressing the Enter key in the 
Agent console provides a list of all available commands. 

You can use the following commands in the Agent:        

Table 5: Windows Platform Agent Commands 

Commands Description

START APPNAME Starts the specified application.

STOP APPNAME Stops the specified application.

USERS Displays a list of all users that are connected to the 
server. The total number of connections is displayed, 
as well as the number of ports available.

LOGOUTUSER USER Disconnects a user from the server and frees a port.

This command requires the Hyperion Essbase system 
password.

PASSWORD Changes the system password that is required to start 
the Hyperion Essbase server. 

This command requires you to enter the old Hyperion 
Essbase system password.

VERSION Displays the server software version number.

HELP Lists all valid Agent commands and their respective 
functions.
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To learn more about the Agent, see “Running Hyperion Essbase, Applications, and 
Databases” in the Hyperion Essbase OLAP Server Database Administrator’s 
Guide.

Running Hyperion Essbase Agent as a 
Windows NT or Windows 2000 Service

The Hyperion Essbase Agent (ESSBASE.EXE) can run as a Windows NT or 
Windows 2000 service. Running the Agent as a service lets you start and stop the 
Agent from the Windows NT or Windows 2000 Control Panel. Running the Agent 
as an automatic service starts the Agent as a service when you start Windows NT 
or Windows 2000.  

This section contains the following topics:

● “Installing Hyperion Essbase Agent as an Automatic Service” on page 41

● “Setting the System Environment to Run Hyperion Essbase Agent as an 
Automatic Service” on page 42

PORTS Displays the number of ports that are installed on the 
server and how many are in use. Number of available 
ports = number of licensed ports + 1 system 
administrator port.

DUMP FILENAME Dumps information from the Hyperion Essbase security 
system to a specified file in ASCII format. If you do not 
supply a path with the file name, the file is saved to the 
\ESSBASE\BIN directory (/essbase/bin on UNIX 
systems).

This command requires the Hyperion Essbase system 
password.

QUIT/EXIT Shuts down all open applications and quits Hyperion 
Essbase.

Table 5: Windows Platform Agent Commands (Continued)

Commands Description
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● “Verifying that Hyperion Essbase Agent Is Running as an Automatic Service” 
on page 43

● “Stopping the Running of Hyperion Essbase Agent as a Service” on page 43

● “Restarting the Running of Hyperion Essbase Agent as a Service” on page 44 

● “Resetting Hyperion Essbase Agent as an Automatic Service” on page 45

● “Removing Hyperion Essbase Agent as a Service” on page 46

Note: The Windows NT or Windows 2000 Task Manager does not let you 
terminate any process started as a service. If the Hyperion Essbase 
Agent is started as a service, and if it or the server hangs, you must 
shut down the server computer to stop the Hyperion Essbase Service.

Installing Hyperion Essbase Agent as an Automatic 
Service

To install the Hyperion Essbase Agent as a service that starts automatically when 
you start Windows NT or Windows 2000, type the following from the command 
line: 

ESSBASE.EXE -SERVICE INSTALL 

You should get a message that Hyperion Essbase has been installed as a service. 
The Hyperion Essbase Agent is now listed as ESSBASE SERVICE in the Services 
dialog box of the Windows NT Control Panel (on Windows 2000, the service is 
listed in Control Panel > Administrative Tools > Services). The Hyperion Essbase 
Agent is also set to start automatically when you start Windows NT or Windows 
2000.
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Setting the System Environment to Run Hyperion 
Essbase Agent as an Automatic Service

To run the Hyperion Essbase Agent as a Windows NT or Windows 2000 service, 
the operating system needs to know where Hyperion Essbase is located and needs 
to add the ARBORPATH \BIN directory to the system-wide PATH variable. On 
Windows NT 4.0 or Windows 2000, take the following actions: 

1. Select Start > Settings > Control Panel > System.

2. Find the Windows environment variable controls.

● On Windows NT, choose the Environment tab.

● On Windows 2000, choose the Advanced tab, and click the 
Environment Variables button.

3. Set the following system variables:

● ARBORPATH=C:\HYPERION\ESSBASE, or wherever Hyperion Essbase is 
installed.

● Add %ARBORPATH%/BIN to the Path variable.

4. Reboot your computer to allow these changes to take effect.

The Hyperion Essbase Agent now runs as a Windows NT or Windows 2000 
service. It also starts automatically when you start Windows NT or Windows 
2000.
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Verifying that Hyperion Essbase Agent Is Running as 
an Automatic Service

➤ To verify that the Hyperion Essbase Agent is running as an automatic Windows 
NT or Windows 2000 service after you reboot, perform the following actions:

1. Select Start > Settings > Control Panel.

2. Open the Services dialog box. 

● On Windows NT, double-click Services.

● On Windows 2000, double-click Administrative Tools, then 
double-click Services.

You should see the Hyperion Essbase Agent listed as ESSBASE SERVICE in 
the list of services. The Startup (or Startup Type) field for Essbase Service 
should say AUTOMATIC, and the Status field should say STARTED.

Note: If the Startup field is blank, or if it says Disabled or Manual, see 
“Resetting Hyperion Essbase Agent as an Automatic Service” on 
page 45.

Stopping the Running of 
Hyperion Essbase Agent as a Service

➤ To stop the Hyperion Essbase Agent from the Control Panel, complete the 
following steps:

1. Select Start > Settings > Control Panel.

2. Open the Services dialog box.

● On Windows NT, double-click Services.

● On Windows 2000, double-click Administrative Tools, then 
double-click Services.

Find ESSBASE SERVICE in the list of services.

3. Highlight, but do not double-click, ESSBASE SERVICE.
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4. Stop the service. 

● On Windows NT, click Stop.

● On Windows 2000, select Action > Stop.

The Service Control message box is displayed. After a delay it disappears, 
and the Status field for Essbase Service is changed.

Note: Stopping the Essbase Service can take some time, depending on 
how many application servers are running. The time it takes is the 
same amount it would take to stop ESSBASE.EXE if it were 
running from the command line or as a background process.

Restarting the Running of 
Hyperion Essbase Agent as a Service

If you have stopped the Essbase Service, you can start it again from the Services 
dialog box of the Control Panel. Do the following: 

1. Select Start > Settings > Control Panel.

2. Open the Services dialog box.

● On Windows NT, double-click Services.

● On Windows 2000, double-click Administrative Tools, then 
double-click Services.

The Services dialog box is displayed. Hyperion Essbase is listed as ESSBASE 
SERVICE in the list of services.

3. Highlight, but do not double-click, ESSBASE SERVICE.

4. Start the Hyperion Essbase Service.

● On Windows NT, click the Start button.

● On Windows 2000, select Action > Start.

The Service Control message box is displayed. After a delay it disappears, 
and the Status field entry for Essbase Service is changed.
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Resetting Hyperion Essbase Agent 
as an Automatic Service

When you install the Hyperion Essbase Agent as a Windows NT or Windows 2000 
service, it is listed as Essbase Service in the list of services. However, if someone 
disables it or sets it to manual startup, you can reset the Essbase Service to start 
automatically. Complete the following steps: 

1. Select Start > Settings > Control Panel.

2. Open the Services dialog box.

● On Windows NT, double-click Services.

● On Windows 2000, double-click Administrative Tools, then 
double-click Services.

The Services dialog box is displayed. Find ESSBASE SERVICE in the list of 
services. 

3. Double-click ESSBASE SERVICE.

4. Set the Hyperion Essbase service to log on automatically as a system account.

On Windows NT, 

a. Click the Automatic option in the Service dialog box.

b. Under the Log On As section, select System Account.

On Windows 2000, 

a. In the Essbase Service Properties dialog box, select Automatic from the 
Startup type drop-down list box.

b. In the Log On tab, select Local System account.

This sets the Essbase Service for automatic startup, and uses the system account.
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Removing Hyperion Essbase Agent as a Service
To remove the Hyperion Essbase Agent as a Windows NT or Windows 2000 
service, type the following from the command line:   

ESSBASE.EXE -SERVICE REMOVE 

The system displays a message that Hyperion Essbase has been removed as a 
service.

Removing the Essbase Service removes it from the list of Windows NT or 
Windows 2000 registered services. It does not uninstall Hyperion Essbase. 
You can still start the Hyperion Essbase server. See “Restarting the Running of 
Hyperion Essbase Agent as a Service” on page 44.

Anticipating the Next Step
After you have successfully started the Hyperion Essbase server, install Hyperion 
Essbase Application Manager and verify that you can connect to the server from 
there.

To run Personal Essbase, which runs the Hyperion Essbase server and the client 
software on the same computer, you may need to configure your system to bypass 
the network. See “Configuring and Running Personal Essbase” on page 47 for 
information on how to do this. See Chapter 4, “Application Manager 
and Spreadsheet Add-in Installation,” for information on Hyperion Essbase 
Application Manager.

If you installed the sample applications, you need to load data into them. The 
sample applications are provided as examples of basic Hyperion Essbase 
databases. The Hyperion Essbase Spreadsheet Add-in User’s Guide uses the 
Sample Basic database in a step-by-step tutorial on the spreadsheet features.

See Chapter 5, “Sample Applications,” for information on loading data into the 
sample applications and preparing them for use.
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Configuring and Running Personal Essbase
You install Personal Essbase for Windows 95, Windows 98, Windows NT, and 
Windows 2000 the same way you install regular Hyperion Essbase server and 
client software. Read the following section to understand limitations of, and 
guidelines for, Personal Essbase. For step-by-step installation instructions, see 
“Installing Server Software on Windows” on page 29.

About Installing Personal Essbase
To successfully install Personal Essbase, you must install the Hyperion Essbase 
server and client components in the same root Hyperion Essbase directory. By 
default, this directory is C:\HYPERION\ESSBASE.    

If you have previously installed either Hyperion Essbase client software or a 
Hyperion Essbase server on your computer, and the installation was not Personal 
Essbase, you must reinstall both the server and the client software when you install 
Personal Essbase.

When installing on a Personal Essbase computer, you must install  Release 6.1 
client and server software. The combination of a 5.x client and a 6.1 server is not 
recommended.

If you install Personal Essbase on a computer with a dual-boot configuration (for 
example, Windows 95 and Windows NT 4.0), do not mix the installations across 
operating systems. For example, if you install Personal Essbase for Windows 95 
on a computer that has Hyperion Essbase installed on a Windows NT partition, do 
not install Personal Essbase for Windows 95 in the same directory where Hyperion 
Essbase or Personal Essbase is installed for Windows NT. From within each 
operating system, you must independently specify the $ARBORPATH and PATH 
settings for the Hyperion Essbase program files.     

A basic Personal Essbase installation includes the following components:   

● A one-port Hyperion Essbase OLAP Server for Windows NT, Windows 95, 
Windows 98, or Windows 2000 (including MaxL and ESSCMD)

● Hyperion Essbase Application Manager, including MaxL and ESSCMD

● Hyperion Essbase Spreadsheet Add-in for your spreadsheet application: Excel 
97, Excel 2000, or Lotus 1-2-3 Millennium Release 9.1 or 9.5
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Limitations of a Personal Essbase Server
Personal Essbase, although having functionality similar to Hyperion Essbase, is 
restricted in some ways: 

● Only one application and two databases are allowed to run simultaneously. A 
system exceeding this configuration is not recommended and is not supported.

● Disk volumes are not supported. The database must fully reside on the disk 
that contains the Hyperion Essbase server software.

● Hyperion Essbase SQL Interface is not supported.

● Only one port with a local connection (client and server on the same 
computer) is allowed.

● The Personal Essbase license allows only Personal Essbase clients to connect 
to the Personal Essbase server. However, Personal Essbase clients may also 
connect to other Hyperion Essbase servers on the network. See Chapter 1, 
“Product Components and Software Registration,” for more information on 
Hyperion Essbase licenses. 

Connecting to a Personal Essbase Server
After you have installed Personal Essbase server and client software, you are ready 
to use Hyperion Essbase Spreadsheet Add-in,  Hyperion Essbase Application 
Manager, or MaxL to connect to the Hyperion Essbase server. 

➤ To connect to the Hyperion Essbase server using Application Manager, complete 
the following procedure:

1. Restart your computer to enable changes to the environment.

2. Start Hyperion Essbase by running ESSBASE.EXE.
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3. In Hyperion Essbase, select Server > Connect, and enter the name of your 
Personal Essbase server. 

For example, select Local as the server name:

Figure 4: Entering Your Personal Essbase Server Name Local

You have several choices of server names to use when connecting:          

● The default or alias name defined in the Windows HOSTS file. 

● For example, enter localhost or Local as the Hyperion Essbase server 
name.

● The computer name, as defined by the operating system for networking. 
In the following Windows NT 4.0 example, the computer name is ASPEN.

Figure 5: Using the Computer Name ASPEN

If you use Named Pipes, using LOCAL as the Hyperion Essbase server name is 
faster than using the computer name.       

● The default loopback IP address as defined in the HOSTS file. For 
example, enter 127.0.0.1 as the Hyperion Essbase server name. For 
more information, see “Configuring the Windows Hosts File” on page 51. 
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● If you use TCP/IP and the MS Loopback Adapter, you can use the alias 
name that you mapped in the HOSTS file to the IP address for the MS 
Loopback Adapter. See “Configuring the Windows Hosts File” on 
page 51.

● If you have not mapped the IP address in the HOSTS file, and if you have 
a network adapter card, use the IP address assigned to your network 
adapter card.

● If you have not mapped the IP address in the HOSTS file, and if you do not 
have a network adapter card, use the IP address assigned to the MS 
Loopback Adapter.

4. Click OK.

Troubleshooting Personal Essbase Communication
If you have any of the following problems after installing Personal Essbase,

● You cannot start the Personal Essbase server (Essbase.exe). You see an 
empty console window, or the following message is found in Essbase.log:

Network Error [10047]: Unable To Create Host Server Socket

● You can start the Personal Essbase server, but you cannot connect to the server 
using client software, such as Hyperion Essbase Application Manager. You 
see the following message:

Network Error [11002]: Unable To Locate [] In Hosts File

then you need to make sure of the following:

● You have an appropriate HOSTS file in your Windows system directory. See 
“Configuring the Windows Hosts File” on page 51.

● You have installed a supported network protocol (TCP/IP or Named Pipes), 
which is bound to a network adapter. If you are using a stand-alone computer 
that has no network interface card (NIC), you must simulate network 
connectivity by binding your network protocol to the appropriate Microsoft 
adapter. See “Working Without a Network Interface Card (Windows 95 and 
Windows 98)” on page 51, or “Working Without a Network Interface Card 
(Windows NT and Windows 2000)” on page 54.
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Configuring the Windows Hosts File
Make sure you have a HOSTS file in your Windows system directory. If you do not 
have a HOSTS file, complete the following steps:     

1. Copy the sample file HOSTS.SAM from your Windows system directory (for 
example, C:\WINDOWS or C:\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS) and 
save it as HOSTS.

2. If necessary, edit the HOSTS file as follows:

● On Windows 95 or Windows 98, make sure HOSTS contains the following 
line:

127.0.0.1   localhost

This is the default loopback IP address. You can optionally change 
localhost to any desired alias name for the Personal Essbase server.

● On Windows NT or Windows 2000, optionally add a line to HOSTS that 
maps the IP address of the MS Loopback Adapter to a name. For example, 
if the IP address of the MS Loopback Adapter is 149.22.15.1, you can 
map it to LOCALLOOP as follows:

149.22.15.1   LOCALLOOP

Leave at least one space between the IP address and the alias name.

Note: Names in the HOSTS file are case-sensitive.

3. Save the changes to the HOSTS file. 

The HOSTS file should not have a file name extension. If the text editor adds 
an extension to the HOSTS file, remove the extension from the file name using 
Windows Explorer.

Working Without a Network Interface Card 
(Windows 95 and Windows 98)
If you are using a stand-alone Windows 95 or Windows 98 computer that has no 
network interface card (NIC), you can simulate network connectivity by binding 
the network protocol to adapter software. The following steps show you how to 
configure the TCP/IP network protocol to use the Microsoft Dial-Up adapter 
provided with Windows 95 and Windows 98. These instructions assume that:
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● TCP/IP and Dial-Up Networking are installed on your computer.    

TCP/IP and Dial-Up Networking are included with your Windows 95 or 
Windows 98 installation. However, you might have to rerun the installation to 
choose the TCP/IP and Dial-Up Networking options.

● Your computer does not have a network card that is bound to TCP/IP. 

If your computer has a network card installed, complete steps 1–3 in the 
previous section, “Configuring the Windows Host File”, to verify that the 
network card is bound to TCP/IP. 

➤ To set up the Dial-Up Adapter, complete the following steps on your Windows 95 
or Windows 98 computer:

1. Open the Control Panel by selecting Settings > Control Panel from the Start 
menu.

2. Double-click the Network icon.

3. In the Network dialog box, select the Configuration tab, and select TCP/IP 
from the list of installed network components.

If TCP/IP is not listed, click Add, choose Protocol, click Add, and select 
Microsoft from the list box on the left, and TCP/IP from the list box on the 
right.

If your computer has a network card installed, check to see if the network card 
is bound to TCP/IP. For example, check that the Network dialog box has a 
binding entry similar to:

TCP/IP -> AMD PCNET Family Ethernet Adapter (PCI&ISA)
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If your network card is bound to TCP/IP, you do not need to complete the 
remaining steps in this section. Click Add.

The Select Network Component Type dialog box is displayed: 

Figure 6: Selecting Adapter

4. Select Adapter, and click Add.

5. In the Select Network Adapters dialog box, select Microsoft in the 
Manufacturers list box, and select Dial-Up Adapter in the Network 
Adapters list box.

6. Click OK.

7. Check that the Network dialog box has the binding entry 
TCP/IP -> Dial-Up Adapter, as follows:

Figure 7: Checking for the Binding Entry TCP/IP -> Dial-Up Adapter

8. Click OK in the Network dialog box.

Windows prompts you to restart your computer to enable the settings. If it is 
convenient to restart your computer now, click Yes.
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Working Without a Network Interface Card 
(Windows NT and Windows 2000)
If you are using a stand-alone Windows NT or Windows 2000 computer that 
has no network interface card (NIC), you can simulate network connectivity 
by binding the network protocol to adapter software. The following steps show 
you how to configure the TCP/IP or Named Pipes network protocol to use the 
Microsoft Loopback adapter provided with Windows NT and Windows 2000. 

These instructions assume that you have either TCP/IP or Named Pipes (NetBEUI) 
installed as a protocol on your Windows NT Workstation. You can use this method 
whether or not you have a network interface card.

To use this method to bypass the network on Windows NT or Windows 2000, you 
need to do the following:

● Install the Microsoft Loopback Adapter.

● If you use TCP/IP, configure Microsoft Loopback with TCP/IP.

Installing the Microsoft Loopback Adapter

➤ To install the Microsoft Loopback Adapter on Windows NT 4.0:

1. Select Start > Settings > Control Panel > Network > Adapters tab.

2. If the Network Adapter list box does not contain MS Loopback Adapter, 
click Add, and select MS Loopback Adapter from the list of available 
adapters.

3. Click OK. 

If you are prompted for settings such as Frame Type, click OK to accept the 
defaults. These prompts occur if you have IPX/SPX installed. IPX/SPX is not 
required for Personal Essbase.

Windows NT prompts you to insert the “Windows NT Workstation 
CD-ROM” into the CD-ROM drive. 

4. Insert the CD-ROM and click OK. MS Loopback Adapter is added to the 
Network Adapters list box in the Adapters dialog box.
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5. Click Close.

If you use only Named Pipes as a network protocol, Windows installs the 
Microsoft Loopback Adapter and prompts you to reboot your computer so the 
new settings can take effect. 

6. Restart your computer.

If you use TCP/IP, see “Configuring Microsoft Loopback with TCP/IP” on 
page 55.

➤ To install the Microsoft Loopback Adapter on Windows 2000:

1. Select Start > Settings > Control Panel > Add/Remove Hardware.

2. In the Add/Remove Hardware Wizard, click Next, then select 
Add/Troubleshoot a device, and click Next.

Windows 2000 searches for available devices.

3. If Microsoft Loopback Adapter is not already listed as an installed device, 
select Add a new device and click Next.

4. Select No, I want to select the hardware from a list, and click Next.

5. Select Network Adapters from the list of hardware types, and click Next.

6. Select Microsoft from the list of manufacturers, and select Microsoft 
Loopback Adapter from the list of network adapters. 

7. Click Next.

8. After Windows 2000 installs the Microsoft Loopback Adapter, click Finish.

Configuring Microsoft Loopback with TCP/IP

If you use TCP/IP as a network protocol (either alone or with Named Pipes) and 
you need to configure it with the Microsoft Loopback Adapter, complete the 
following steps that are appropriate for your operating system:    

On Windows NT 4.0:

1. In the Microsoft TCP/IP Properties dialog box, click the IP Address tab, if it 
is not already active. 

2. In the IP Address page of the Microsoft TCP/IP Properties dialog box, 
select MS Loopback Adapter from the Adapter list box.
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3. Enter the IP Address and Subnet Mask for the MS Loopback Adapter.

The MS Loopback Adapter has a default IP address. You may give it a 
fictitious IP address, or the IP address of your computer, but its IP address 
must be different than the IP address for the network adapter, if you have one. 
The subnet mask for MS Loopback is the same as for the network adapter, if 
you have one. See your network administrator for the correct addresses.

4. Select the DNS tab, and fill in the Host Name, Domain, and DNS Service 
Search Order for the MS Loopback Adapter. Contact your network 
administrator for the correct information.

5. Click Add, and click OK.

Windows installs the MS Loopback Adapter and prompts you to reboot your 
computer so the new settings can take effect.

6. Restart your computer.

On Windows 2000:

1. Select Start > Settings > Control Panel > Network and Dial-up Connections.

2. Right-click the Local Area Connection icon and select Properties. Verify 
that Microsoft Loopback Adapter is shown in the Connect using: field.

3. Verify that the Internet Protocol (TCP/IP) component is checked. If it is not, 
select it.

4. Select Internet Protocol (TCP/IP) and click Properties.

5. Enter the IP Address and Subnet Mask for the Microsoft Loopback Adapter.

The Microsoft Loopback Adapter has a default IP address. You may give it a 
fictitious IP address, or the IP address of your computer, but its IP address 
must be different than the IP address for the network adapter, if you have one. 
The subnet mask for Microsoft Loopback is the same as for the network 
adapter, if you have one. See your network administrator for the correct 
addresses.

6. Type the DNS server address information. Contact your network administrator 
for the correct information.

7. Click OK twice.
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Chapter

3
UNIX Server Installation

The Hyperion Essbase OLAP Server is available for the following UNIX  
platforms:   

● Solaris from Sun Microsystems

● AIX from IBM

● HP-UX from Hewlett Packard

● Linux from Red Hat 

Note: Linux is not supported for Hyperion Essbase Release 6.1.

Read this chapter for information on system requirements, directories, setting your 
environment, and running the Hyperion Essbase server on UNIX.

This chapter contains the following sections:

● “UNIX Server Requirements” on page 58

● “About Hyperion Essbase on UNIX” on page 62

● “Installing Server Software on UNIX” on page 63

● “Updating the Environment Settings (All UNIX Systems)” on page 69

● “Starting the Hyperion Essbase Server” on page 73
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UNIX Server Requirements
The Hyperion Essbase server for UNIX requires a system that meets minimal 
hardware and software requirements. See the sections to find the system 
requirements for your UNIX platform.  

Solaris Server Requirements
The Hyperion Essbase server for Solaris requires a system with the following 
minimal hardware and software requirements:     

Table 6: Hyperion Essbase Server Solaris System Requirements 

Component Requirement

Server platform Sun SPARC or ULTRASPARC machines

Solaris version 7 or 8

Physical memory 128 MB RAM (256 or more MB recommended) Large 
databases have greater memory requirements.

Swap space At least 2 X amount of physical memory is  
recommended when physical memory is less than 
.5 GB.  Contact your system administrator or hardware 
vendor for optimum swap configuration.

Disk space • 52 MB

• Server software uses 32 MB

• Sample applications use 9 MB as shipped and use 
20 MB after they are fully loaded with default 
settings

• See the Hyperion Essbase OLAP Server Database 
Administrator’s Guide for information about sizing 
your databases.

Network protocol TCP/IP (included with Solaris)

Thread type POSIX Kernel Threads (included with Solaris)

JavaTM platform Java Runtime Environment version 1.2.2 or later, 
Java API for XML Parsing version 1.01 
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AIX Server Requirements
The Hyperion Essbase server for AIX requires a system with the following 
minimal hardware and software requirements:      

Table 7: Hyperion Essbase Server AIX System Requirements

Component Requirement

Server platform RS 6000 PowerPC machines

AIX version 4.3.3 or higher

Physical memory 128 MB RAM (256 or more MB recommended) Large 
databases have greater memory requirements.

Swap space At least 2 X amount of physical memory is  
recommended when physical memory is less than 
.5 GB.  Contact your system administrator or hardware 
vendor for optimum swap configuration.

Disk space • 53 MB

• Server software uses 33 MB

• Sample applications use 9 MB as shipped and use 
20 MB after they are fully loaded with default 
settings. 

• See the Hyperion Essbase OLAP Server Database 
Administrator’s Guide for information about sizing 
your databases.

Network protocol TCP/IP (included with AIX)

Thread type POSIX Kernel Threads  (included with AIX)

Java platform Java Runtime Environment version 1.2.2 (or later), 
Java API for XML Parsing version 1.01 



60 ■

UNIX Server Installation

Hyperion Essbase Installation Guide

HP-UX Server Requirements
The Hyperion Essbase server for HP-UX requires a system with the following 
minimal hardware and software requirements:     

Table 8: Hyperion Essbase Server HP-UX System Requirements

Component Requirement

Server platform PA-RISC machines

HP-UX version 11.0. See Readme.txt for required patches

Physical memory 128 MB RAM (256 or more MB recommended) Large 
databases have greater memory requirements.

Swap space At least 2 X amount of physical memory is  
recommended when physical memory is less than 
.5 GB.  Contact your system administrator or hardware 
vendor for optimum swap configuration.

Disk space • 51 MB

• Server software uses 31 MB

• Sample applications use 9 MB as shipped and use 
20 MB after they are fully loaded with default 
settings. 

• See the Hyperion Essbase OLAP Server Database 
Administrator’s Guide for information about sizing 
your databases.

Network protocol TCP/IP (included with HP-UX)

Thread type POSIX Kernel Threads (included with HP-UX)

Java platform Java Runtime Environment version 1.2.2 (or later), 
Java API for XML Parsing version 1.01 
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Red Hat Linux Server Requirements

Note: Although this guide contains information about Red Hat Linux, 
Hyperion Essbase Release 6.1 does not support Red Hat Linux. 

The Hyperion Essbase server for Red Hat Linux  requires a system with the 
following minimal hardware and software requirements:     

Table 9: Hyperion Essbase Server Red Hat Linux System Requirements 

Component Requirement

Server platform Intel-compatible machines

Red Hat Linux version1

1 Red Hat Linux is not available for Hyperion Essbase Release 6.1

6.1

Physical memory 128 MB RAM (256 or more MB recommended). Large 
databases have greater memory requirements.

Swap space At least 2 X amount of physical memory generally 
recommended when physical memory is less than 
.5 GB.  Contact your system administrator or hardware 
vendor for optimum swap configuration.

Disk space • 26 MB

• Server software uses 11 MB

• Sample applications use 13 MB as shipped and use 
20 MB after they are fully loaded with default 
settings. 

• See the Hyperion Essbase OLAP Server Database 
Administrator’s Guide for information about sizing 
your databases.

Network protocol TCP/IP (included with Linux) 

Thread type Linux POSIX Threads (included with Linux) 
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About Hyperion Essbase on UNIX
The following table describes how Hyperion Essbase operates in a UNIX 
environment.

Multithreading Hyperion Essbase uses a multithreaded architecture to 
ensure high performance in a client-server environment. 
To accomplish this on UNIX platforms, Hyperion Essbase 
uses POSIX Kernel Threads on Solaris, AIX, and HP-UX.      

Symmetric 
Multiprocessing

Hyperion Essbase supports SMP (symmetric 
multiprocessing). An SMP server is beneficial where 
more than one Hyperion Essbase application is defined 
on a single server machine.

File systems and 
direct I/O

By default, Hyperion Essbase uses direct I/O. For those 
file systems that do not support direct I/O (for example, 
HFS on HP-UX), Hyperion Essbase uses buffered I/O.

X-Windows If you have X Windows installed, Hyperion Essbase does 
not use it.

When you run Hyperion Essbase, the Hyperion Essbase 
Agent becomes the active terminal, unless you started 
Hyperion Essbase in the background. When you start a 
Hyperion Essbase application, it runs in the background. 
Messages from the application appear in the Hyperion 
Essbase Agent terminal (if it is running in the foreground) 
and are also entered in the appname.LOG file.   

If you want to view these messages from a telnet session, 
use the Tail command to redirect messages to another 
window at a set interval. We recommend using 
tail -f logfile to view logged messages as they are 
posted to the file. Press Ctrl + C to stop viewing the file. 

You can also run the Hyperion Essbase Agent in the 
background. For more information, see “Starting Hyperion 
Essbase in the Background” on page 74.
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Before You Install on UNIX
Before you install server products on any UNIX platform, complete the following 
tasks: 

● Apply the latest patches for your operating system.

● Create an account that has Read/Write/Execute access to the target directory 
for Hyperion Essbase (/home/hyperion/essbase is the default installation 
directory). This account should belong to the Hyperion Essbase system 
administrator. Give this account the same default directory you are using 
for Hyperion Essbase (for example, /home/hyperion/essbase). Ideally, 
the system administrator account owns the target directory.      

Note: As of Release 6.0, you are no longer required to install and run 
Hyperion Essbase from an account called arbor. Any user can 
install the product, but it should be the same user account that 
starts Hyperion Essbase.

● If you are upgrading from Release 5.x on the current computer, first back up 
your 5.x application and database files to another directory.

Installing Server Software on UNIX
On UNIX, you can install server software from the CD-ROM in either of the 
following ways:   

● From the root directory of the CD-ROM. You do this by running setup.sh 
(or SETUP.SH) and selecting the product to install. You can install only one 
product at a time.   

● From a network copy of the CD-ROM. This option is useful if the system you 
are installing to does not have a CD-ROM drive, or if you do not have access 
to a CD-ROM but the server software has been copied to an accessible 
network drive. You do this by copying the appropriate product directory from 
the network (for   example,/solaris/server), and then running essinst 
(or ESSINST) in the product directory. 

To enable the Java-based features of Hyperion Essbase, you must also manually 
install Java on the computer running the Hyperion Essbase server. For more 
information about installing Java, see “Manually Installing Java” on page 196.
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Installing from the CD-ROM Root Directory

➤ To install Hyperion Essbase server products on UNIX from the root directory of 
the CD-ROM, do the following:  

1. Log in as the Hyperion Essbase system administrator account. For example, 
log in as admin if you created a user account called admin that owns the target 
installation directory /home/hyperion/essbase.

2. Insert the CD-ROM into your CD-ROM drive.

3. Change to the root directory of the CD-ROM (for example, cd /cdrom).

4. Use the ls command to find setup.sh (or SETUP.SH).

Some UNIX CD-ROM drivers list file names in uppercase. Others list them in 
lowercase. See whether setup.sh is in uppercase or lowercase.

5. Type./setup.sh or./SETUP.SH, depending on what you learned in step 4. 
You must run Setup separately for each Hyperion Essbase product you want 
to install. Setup does the following:

● Asks you which product to install: API, Server, or SQL Interface

● Runs the script essinst (or ESSINST) to install that product

6. Follow the prompts and provide the information requested.

To cancel installation at any time, press Ctrl + C.

7. When prompted, enter your license number exactly as it appears on your 
registration letter.

See Chapter 1, “Product Components and Software Registration,” for more 
information on software registration.

8. When prompted, type the directory where you want to install Hyperion 
Essbase.

If this is the first installation of Hyperion Essbase, the installation program 
uses /home/hyperion/essbase/ as the default directory. You can select 
another directory, and if it does not exist, the installation program will attempt 
to create it for you.

The installation program decompresses the server.tz files, and copies files 
to the directory you select (or default to), and to subdirectories it creates under 
that directory. Do not create these subdirectories yourself.

9. Update your environment before you use Hyperion Essbase. See “Updating 
the Environment Settings (All UNIX Systems)” on page 69.
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Installing from the CD-ROM Product Directory
If you do not have access to the CD-ROM, you must copy the appropriate directory 
of the CD-ROM for your platform (for example, cdrom/solaris) from a  
network copy before completing these instructions.

Note: If you have access to the CD-ROM, it is recommended that you install 
from the root directory of the CD-ROM. See “Installing from the 
CD-ROM Root Directory” on page 64.

➤ To install Hyperion Essbase server products on UNIX from the CD-ROM product 
directory, or a copy of it, do the following: 

1. Log in as the Hyperion Essbase system administrator account. For example, 
log in as admin if you created a user account called admin that owns the target 
installation directory /home/hyperion/essbase.

2. Change to the appropriate directory for the product you want to install. For 
example, cd /cdrom/solaris/sqlifc to install Hyperion Essbase SQL 
Interface on Solaris.

3. Use the ls command to find essinst (or ESSINST).   

See whether essinst is in uppercase or lowercase.

4. Type./essinst or./ESSINST, depending on what you learned in step 3. 
essinst (or ESSINST) installs the product from your current directory.

5. Follow the prompts and provide the information requested.

To cancel installation at any time, press Ctrl + C.

6. When prompted, enter your license number exactly as it appears on your 
registration letter.

See Chapter 1, “Product Components and Software Registration,” for more 
information on software registration.
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7. When prompted, type the directory where you want to install Hyperion 
Essbase.

If this is the first installation of Hyperion Essbase, the installation program 
uses/home/hyperion/essbase as the default directory. You can select 
another directory, and if it does not exist, the installation program will attempt 
to create it for you.

The installation program decompresses the server.tz files, and copies files 
to the directory you select (or default to), and to subdirectories it creates under 
that directory. Do not create these subdirectories yourself.

8. Update your environment before you use Hyperion Essbase. See “Updating 
the Environment Settings (All UNIX Systems)” on page 69.

root.sh Shell Script

Note: The text in the following paragraph is more current than the 
information in the printed version.

After you install the Hyperion Essbase server on a Solaris system, run the Bourne 
shell script, root.sh, from the root account. The script, located in 
$ARBORPATH/bin, performs post-installation tasks. Solaris users, if you do not 
run the script, you will not be able to turn on the Cache Memory Locking database 
setting.    

To run root.sh, log in as user root, and enter the following commands:

$ su - 
Password: (enter your password) 
# cd /home/hyperion/essbase/bin 
# sh ./root.sh 
# exit

The script does the following:

● Sets the effective uid bit to root. 

● Changes ownership of ESSSVR, the application server process, so that it will 
run as root. This is necessary to enable use of the optional Cache Memory 
Locking setting.
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● Creates symbolic links in /usr/lib to the following shared libraries in 
$ARBORPATH/bin:

Solaris                  Linux
libesssd.so.1            libesssd.so
libessapi.so.1           libessapi.so
libessnet.so.1           libessnet.so
libessotl.so.1           libessotl.so
libessshr.so.1           libessshr.so
libesssql.so.1           libessutl.so
libessutl.so.1           libesssvrd.so
libesssvrd.so.1          libesssm.so
libesssm.so.1            libessdvrq.so
libessdvrq.so.1          libglobalc.so
libglobalc.so

● On Solaris only, asks you whether you have installed the Hyperion Essbase 
SQL Interface module. If you have not, the program ends and the task is 
complete. If you have installed Hyperion Essbase SQL Interface, root.sh 
prompts you for the  path to the libodbc.so shared library. Enter the full 
path except for the file name; for example, /home/hyperion/essbase/bin.  

See Chapter 8, “SQL Interface Installation,” on installing SQL Interface. 

Directories Created (All UNIX Systems)
The installation program creates the following directory structure:  

essbase
     bin
     app
     docs
        techref
            maxl
     locale
     perlmod

The bin directory contains the Hyperion Essbase server software. This now 
includes MaxL, a linguistic interface you can use via the MaxL Command Shell 
(essmsh) or the Essbase Perl module (Essbase.pm) to automate most Hyperion 
Essbase system-administration tasks.     

The app directory stores Hyperion Essbase applications as they are created. Each 
application is stored in a directory under the app directory. Each database in an 
application is stored in a directory under the application directory.
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For example, suppose you create two applications on the server: Finance and 
Marketng. Then you add two databases to the Finance application: Currency and 
Main, and two databases to the Marketng application: Product and Sales. The 
server directory structure appears as follows:

essbase
      app
          Finance
               Currency
               Main
          Marketng
               Product
               Sales
      bin
      docs
          techref
               maxl
      java
      locale
      perlmod

Note: Hyperion Essbase stores an activity log file for each application in 
each application’s directory. (In the example, there are log files in the 
Finance and Marketng directories.) Log files track all user requests 
made to the application or to databases within the application. 

The docs/techref/maxl directory contains the MaxL Language Reference, 
which you will need in order to use MaxL, the new multi-dimensional access 
language for Hyperion Essbase.

The JAVA directory contains the Java software to support the Java-based features 
of Hyperion Essbase.

The locale directory contains the character-set files necessary for all the 
languages Hyperion Essbase supports, including English. For non-English 
versions, you also need to create the ESSLANG environment variable. For more 
information about ESSLANG, see Chapter 10, “Advanced Installation Topics.” 

The perlmod directory contains the files and documentation you need to add the 
Essbase Perl Module (Essbase.pm) to Perl, enabling you to embed MaxL 
statements in Perl programs. You must install Perl yourself. For more information, 
see the MaxL Language Reference in the docs/techref/maxl directory, and the 
README file included in the perlmod directory.
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Updating the Environment Settings 
(All UNIX Systems)

The installation program does not update the environment files .cshrc or 
.profile. Because the format of these files varies depending on the shell you 
use, you need to update the appropriate file for your system manually.               

Read hyperionenv.doc in your Arborpath directory for the environment setting 
for the Hyperion Essbase server. If you are installing on Solaris, also run root.sh 
from the $ARBORPATH/bin directory, where $ARBORPATH is the directory where 
you installed the Hyperion Essbase server. See “root.sh Shell Script” on page 66. 
The default installation directory is /home/hyperion/essbase. 

If you are installing SQL Interface on any UNIX platform, you must take 
additional steps to set your environment. See Chapter 8, “SQL Interface 
Installation,” for details.

After installation and updating the environment, log out and log in again to enable 
the new settings to take effect. Then begin to use Hyperion Essbase.  

Setting the $ARBORPATH Variable (Mandatory)
The installation program creates a file, hyperionenv.doc, with the shared 
library information you need in your global environment. If you installed 
Hyperion Essbase to/home/hyperion/essbase, you see the following:

ARBORPATH=/home/hyperion/essbase

where “home” is the name of your home directory, and “essbase” is the name of 
your Hyperion Essbase directory.

You need to add this setting to your environment in the appropriate format for your 
system. For example:

In the C shell, add the following to your .cshrc environment file:

setenv ARBORPATH "/home/hyperion/essbase"

In the Bourne or Korn shell, add the following to your .profile environment 
file:

ARBORPATH=/home/hyperion/essbase; export ARBORPATH
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Setting the Library Path Variables (Mandatory)
You need to update the system library path setting to include the 
$ARBORPATH/bin directory. Add this setting to your environment in the 
appropriate format for your shell.

If Hyperion Essbase SQL Interface has been installed, you also need to add 
$ARBORPATH/dlls to the library path setting. For more information about 
Hyperion Essbase SQL Interface environment settings, see Chapter 8, “SQL 
Interface Installation.”

Solaris
On Solaris, you need to update the LD_LIBRARY_PATH setting to include the  
$ARBORPATH/bin directory.

In the C shell, set  LD_LIBRARY_PATH path as follows in the.cshrc file:

setenv LD_LIBRARY_PATH "$LD_LIBRARY_PATH:/usr/lib:$ARBORPATH/bin"

If SQL Interface has been installed, also include $ARBORPATH/dlls, as follows:

setenv LD_LIBRARY_PATH 
"$LD_LIBRARY_PATH:/usr/lib:$ARBORPATH/bin:$ARBORPATH/dlls"

In the Bourne or Korn shell, set  LD_LIBRARY_PATH as follows in the .profile 
file:

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/lib:$ARBORPATH/bin; 
export LD_LIBRARY_PATH

If SQL Interface has been installed, also include $ARBORPATH/dlls, as follows:

LD_LIBRARY_PATH=
$LD_LIBRARY_PATH:/usr/lib:$ARBORPATH/bin:$ARBORPATH/dlls;
export LD_LIBRARY_PATH

Note: The actual path you specify depends on your environment.
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HP-UX
On HP-UX, you need to update the SHLIB_PATH setting to include the 
$ARBORPATH/bin directory.

In the C shell, add the following to the .cshrc file:

setenv SHLIB_PATH "$SHLIB_PATH:/usr/lib:$ARBORPATH/bin"

If SQL Interface has been installed, also include $ARBORPATH/dlls, as follows:

setenv SHLIB_PATH 
"$SHLIB_PATH:/usr/lib:$ARBORPATH/bin:$ARBORPATH/dlls"

In the Bourne or Korn shell, add the following to the .profile file:

SHLIB_PATH=$SHLIB_PATH:/usr/lib:$ARBORPATH/bin; export SHLIB_PATH

If SQL Interface has been installed, also include $ARBORPATH/dlls, as follows:

SHLIB_PATH=$SHLIB_PATH:/usr/lib:$ARBORPATH/bin:$ARBORPATH/dlls
export SHLIB_PATH

Note: The actual path you specify depends on your environment.

AIX
On AIX, you need to update the LIBPATH setting to include the $ARBORPATH/bin 
directory.

In the C shell, add the following to the .cshrc file:

setenv LIBPATH "$LIBPATH:/usr/lib:$ARBORPATH/bin"

If SQL Interface has been installed, also include $ARBORPATH/dlls, as follows:

setenv LIBPATH "$LIBPATH:/usr/lib:$ARBORPATH/bin:$ARBORPATH/dlls"

In the Bourne or Korn shell, add the following to the .profile file:

LIBPATH=$LIBPATH:/usr/lib:$ARBORPATH/bin; export LIBPATH
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If SQL Interface has been installed, also include $ARBORPATH/dlls, as follows:

LIBPATH=$LIBPATH:/usr/lib:$ARBORPATH/bin:$ARBORPATH/dlls; 
export LIBPATH

Note: The actual path you specify depends on your environment.

Red Hat Linux
Although this guide contains information about Red Hat Linux, it is not supported 
on Release 6.1 of Hyperion Essbase.

On Red Hat Linux, you need to update the LD_LIBRARY_PATH setting to include 
the $ARBORPATH/bin directory.

In the C shell, set  LD_LIBRARY_PATH path as follows in the.cshrc file:

setenv LD_LIBRARY_PATH "$LD_LIBRARY_PATH:/usr/lib:$ARBORPATH/bin"

In the Bourne or Korn shell, set  LD_LIBRARY_PATH as follows in the .profile 
file:

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/lib:$ARBORPATH/bin; 
export LD_LIBRARY_PATH

Note: The actual path you specify depends on your environment.

Adding Hyperion Essbase to the Path (Optional)
For convenience, you might want add Hyperion Essbase to the path so you can 
quickly access Hyperion Essbase components. For example:

In the C shell, edit the .cshrc file:

set path=($PATH /usr/bin $ARBORPATH/bin)

In the Bourne or Korn shell, edit the .profile file:

PATH=$PATH:/usr/bin:$ARBORPATH/BIN; export PATH

Now, from the UNIX command prompt, you can get to the Hyperion Essbase 
directory by issuing the following command:

cd $ARBORPATH
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Removing Extraneous Files (All UNIX Systems, Optional)
As an option, you can remove extraneous files from the 
/home/hyperion/essbase directory and the temporary directory.

Note: This section assumes you installed Hyperion Essbase to the default 
directory, /home/hyperion/essbase.

When you install the Hyperion Essbase server, the server.tz files are moved 
to the/home/hyperion/essbase directory and the readme.txt file is moved 
to the/home/hyperion/essbase/bin directory. When server.tz files 
are decompressed, the decompressed files are stored momentarily in the 
/essbase directory, then moved to the appropriate directory. If you select not 
to install an option, such as the sample applications, or if you have not licensed 
an option, such as currency conversion, extra files will be left in the /essbase  
directory after installation. In any case, the server.tz files are left there.

When installation is complete, you can delete any files in the temporary directory. 
You can also delete from/essbase all files that have not been moved into 
subdirectories, including the server.tz files. However, do not delete any 
subdirectories under/essbase or any files in those subdirectories.

Starting the Hyperion Essbase Server
You can start the Hyperion Essbase server in the foreground or in the background.    

Before you can access the Hyperion Essbase server, you must be logged in to the 
UNIX server on an account that has at least Read/Write/Execute access to the 
Hyperion Essbase directories. Ideally, this is the same account that was used to 
install Hyperion Essbase. 

Starting Hyperion Essbase in the Foreground

➤ To start the Hyperion Essbase server in the foreground:

1. From the command prompt, type

$ARBORPATH/bin/ESSBASE

or, if your path includes $ARBORPATH/bin, type

ESSBASE

If you encounter any errors during startup, check your path and environment 
settings.
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2. Do one of the following:

● If this is a first-time installation, enter the following items:  

– Company name. The name you enter is embedded in your server 
license registration.

– Your name. The name you enter is designated as the Hyperion 
Essbase system supervisor. Use this name for your initial login from 
Hyperion Essbase Application Manager.

– System password. This password is required when you start the 
Hyperion Essbase server. It is also required to gain access to the 
server from Hyperion Essbase Application Manager using the system 
supervisor account.

– You are asked to confirm your choices. Type Y to verify your entries, 
or N to retype them.

● If this is not a first-time installation, enter the system password that you 
specified when you first ran Hyperion Essbase.

The Hyperion Essbase Agent then displays the following message:

Waiting for Client Requests...

You can now use the Hyperion Essbase Agent to perform high-level supervisor 
operations. See “Using Hyperion Essbase Agent Commands” on page 75 for a list 
of available commands.

Starting Hyperion Essbase in the Background
To start Hyperion Essbase as a background process:  

From the command prompt, type

$ARBORPATH/bin/ESSBASE password -b &

or, if your path already includes $ARBORPATH/bin, type

ESSBASE password -b &

You can start Hyperion Essbase without using the ampersand (&) at the end of the 
command, but if you do not type the &, the command prompt is not returned after 
the server is started.
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Secure Password Script
To hide the Hyperion Essbase system password from the UNIX process listing 
created by the ps -ef utility on Solaris and HP-UX, you must create a simple shell 
script and use it to launch the Hyperion Essbase Agent. Create a shell script named 
essbase.secure, consisting of the following lines:  

#!/bin/sh 
PASS=$1 
ESSBASE -b -secure << EOF & 
${PASS} 
EOF 

After creating this script, launch the Agent as follows to start it in the background 
with <password> secured from process listing details: 

essbase.secure <password>

Shutting Down Hyperion Essbase
To shut down the server when Hyperion Essbase is running in the foreground,  
type EXIT.

To shut down the server from any terminal connected to it, use the 
SHUTDOWNSERVER command in ESSCMD.

For more information about starting and stopping the Hyperion Essbase server, see 
“Running Hyperion Essbase, Applications, and Databases” in the Hyperion 
Essbase OLAP Server Database Administrator’s Guide.

For information on stopping an application or a process, see “Stopping an 
Application” on page 45-6 in the Hyperion Essbase OLAP Server Database 
Administrator’s Guide.

Using Hyperion Essbase Agent Commands
Hyperion Essbase has a server process called the Agent. When you start the main 
Hyperion Essbase program (ESSBASE), the Agent becomes the active terminal, 
unless you start Hyperion Essbase in the background. The Agent acts as a console 
for high-level server operations. Pressing the Enter key in the Agent terminal 
provides a list of all available commands.

Note: The Agent commands are available only when Hyperion Essbase is 
started in the foreground.



76 ■

UNIX Server Installation

Hyperion Essbase Installation Guide

You can use the following commands in the Agent:                            

To learn about the Agent, see “Running Hyperion Essbase, Applications, and 
Databases” in the Hyperion Essbase OLAP Server Database Administrator’s 
Guide.

Table 10: Hyperion Essbase Server Agent Commands 

Commands Description

START APPNAME Starts the specified application.

STOP APPNAME Stops the specified application.

USERS Displays a list of all users that are connected to the 
server. The total number of connections is displayed, 
as well as the number of ports available.

LOGOUTUSER USER Disconnects a user from the server and frees a port. 
This command requires the Hyperion Essbase system 
password.

PASSWORD Changes the system password that is required to start 
the Hyperion Essbase server. 

This command requires you to enter the old Hyperion 
Essbase system password.

VERSION Displays the server software version number.

HELP Lists all valid Agent commands and their respective 
functions.

PORTS Displays the number of ports that are installed on the 
server and how many are in use.

DUMP FILENAME Dumps information from the Hyperion Essbase security 
system to a specified file in ASCII format. If you do not 
supply a path with the file name, the file is saved to the 
\ESSBASE\BIN directory (/essbase/bin on UNIX 
systems).

This command requires the Hyperion Essbase system 
password.

QUIT/EXIT Shuts down all open applications and quits Hyperion 
Essbase.



UNIX Server Installation

3

■ 77Hyperion Essbase Installation Guide

Anticipating the Next Step
When you have successfully started the Hyperion Essbase server, install Hyperion 
Essbase Application Manager on a client computer to verify you can connect to the 
Hyperion Essbase server from there.

Note: See Chapter 4, “Application Manager and Spreadsheet Add-in 
Installation,” for information on Hyperion Essbase Application 
Manager.

If you installed the sample applications, you need to load data into them. 
The sample applications are provided as examples of basic Hyperion Essbase 
databases. The Hyperion Essbase Spreadsheet Add-in User’s Guide uses the 
Sample Basic database in a step-by-step tutorial on the spreadsheet features.

Note: See Chapter 5, “Sample Applications,” for information on loading 
data into the sample applications and preparing them for use.
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Chapter

4
Application Manager 
and Spreadsheet Add-in 
Installation

This chapter tells you, the client user or system administrator, how to install or 
share Hyperion Essbase client software for Windows, and how to connect to the 
Hyperion Essbase OLAP Server. Client software includes Hyperion Essbase 
Spreadsheet Add-in, Hyperion Essbase Application Manager, and the Runtime 
Client. This chapter describes the following:

● For system administrators, how to install the client software to a network drive 
that is running Windows 95, Windows 98, Windows NT 4.0, or Windows 
2000

● For system administrators and client users, how to install the client software 
to a client hard drive that is running Windows 95, Windows 98, Windows NT 
4.0, or Windows 2000

● For client users, how to start Hyperion Essbase Spreadsheet Add-in and 
Hyperion Essbase Application Manager, and connect to a Hyperion Essbase 
server

This chapter contains the following sections:

● “System Requirements” on page 80

● “Upgrading from Hyperion Essbase 5.x” on page 81

● “Choosing Among Client Software Installation Options” on page 83

● “Installing Client Software from CD-ROM to Your Hard Drive” on page 84

● “Installing Client Software From the Network to Your Hard Drive” on 
page 87

● “Installing Client Software From CD-ROM to a Network Drive” on page 90

● “Setting Up Your Computer to Share Client Software on the Network Drive” 
on page 94
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● “Changing the Network Protocol” on page 95

● “Directories and Files Created” on page 97

● “Starting Hyperion Essbase Application Manager” on page 100

● “Connecting to the Server With Hyperion Essbase Application Manager” on 
page 102

● “Starting Hyperion Essbase Spreadsheet Add-in and Connecting to the 
Server” on page 106

System Requirements
Before you can install Hyperion Essbase Spreadsheet Add-in or Hyperion Essbase  
Application Manager from a network drive, the software must be installed to a 
network drive. 

The Hyperion Essbase client software requires a Windows-based computer with 
the following: 

Table 11: Client Software Windows System Requirements

Component Requirement

Microprocessor Pentium or higher

Windows version Windows 95, Windows 98, Windows NT 4.0, or 
Windows 2000

Excel version Excel 97, Excel 2000

1-2-3 version Lotus 1-2-3 Millennium Releases 9.1 and 9.5

RAM 16 MB

Disk space • 24 MB for Hyperion Essbase Application Manager 

• 17 MB for Hyperion Essbase Spreadsheet Add-in 

Network protocol TCP/IP or Named Pipes (NetBEUI)
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Also, you should identify the following before installing client software:

● The client operating environment: Windows 95, Windows 98, Windows 
NT 4.0, or Windows 2000

● The network protocol that you use

● If installing from a network drive, where the software resides on the network

Upgrading from Hyperion Essbase 5.x
When you install a Release 6 client, the default directory for installation is 
C:\HYPERION\ESSBASE. With Hyperion Essbase 5.x, the default directory was  
C:\ESSBASE.

You can use Release 5.x client software with a Release 6.x server, but the new  
features of Release 6 or 6.1 are not available for Release 5.x Hyperion Essbase  
Spreadsheet Add-in or Release 5.x Hyperion Essbase Application Manager.     

Running Release 5.x of the Hyperion Essbase server with any Release 6.x client 
software does not work and is not supported.

CAUTION: Do not modify Release 6.1 outlines with Hyperion Essbase 
Release 5.x Application Manager. If you save a Release 6.1 
database outline that contains new Release 6.1 features, 
such as attribute dimensions, with the Release 5.x Outline 
Editor, the new features are stripped from the outline.

Unless you choose to update environment variables manually, the client 
installation program updates your $ARBORPATH variable to point to the new 
Hyperion Essbase directory, and your PATH to include the BIN directory 
beneath the new Hyperion Essbase directory.
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To install Release 6.1 clients successfully, do the following: 

● Install all clients in the same directory. This includes Hyperion Essbase 
Application Manager and Hyperion Essbase Spreadsheet Add-in.

● If you install Hyperion Essbase Application Manager and Hyperion Essbase 
Spreadsheet Add-in, make sure both are Release 6.1 if you install them on the 
same computer. Release 6.1 clients share.DLL files that may not work with 
earlier clients.

For backwards compatibility, you can use Release 5.x Hyperion Essbase SQL 
Drill-Through with Hyperion Essbase Release 6.1. If you choose to do so, 
ensure that you:

– Install Hyperion Essbase Spreadsheet Add-in Release 6.x first.

– Use Hyperion Essbase SQL Drill-Through 5.0.2 Patch 9 or later.

– Install Hyperion Essbase SQL Drill-Through to the same directory as the 
Hyperion Essbase Spreadsheet Add-in Release 6.x.

● If you decide to run Release 5.x of Hyperion Essbase Spreadsheet Add-in for 
Excel for Windows with the Release 6.x server, make sure the spreadsheet 
application points to ESSEXCLN.XLL (Excel) or ESS123.12A (Lotus 1-2-3) in 
the correct directory. If necessary, remove the add-in from Excel or 1-2-3, and 
then add it again, pointing it to the correct directory. See “Remove and 
Manually Add the Add-in” on page 111.    

● Move any client application files that you have created to the new location. 
For example, if your old installation is in C:\ESSBASE5, and your new 
installation is in C:\HYPERION\ESSBASE6, copy the C:\ESSBASE5\CLIENT 
directory and its contents to C:\HYPERION\ESSBASE6\CLIENT. Using 
MS-DOS, you can use the following command (all on one line):     

XCOPY C:\ESSBASE5\CLIENT\*.* C:\HYPERION\ESSBASE6\CLIENT\*.* /S

When you have successfully copied all files, you can delete the old CLIENT 
directory.
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Choosing Among Client Software 
Installation Options

Before installing Hyperion Essbase client software, decide which of the following 
you want to do:

Figure 8: Overview of Client Software Installation Options

● Install from the CD-ROM to a client hard drive. This option is for anyone who 
has access to the CD-ROM. See “Installing Client Software from CD-ROM to 
Your Hard Drive” on page 84.

● Install from the CD-ROM to a network drive. This option is for the system 
administrator. Two things are installed to the network: a product installation 
that can be shared on the network, and a SETUP program that can be used to 
install software on client hard drives. See “Installing Client Software From 
CD-ROM to a Network Drive” on page 90. 

● Install from a network to a client hard drive. This option is available for client 
users, if the system administrator previously installed software to a network 
drive. See “Installing Client Software From the Network to Your Hard Drive” 
on page 87.
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● Set up the client computer to use shared executables located on the network 
drive. This option is available for client users, if the system administrator 
previously installed software to a network drive. See “Setting Up Your 
Computer to Share Client Software on the Network Drive” on page 94.

● Change the network protocol. This option is for the system administrator. 
Everyone who uses a shared executable on a network drive must use the same 
network protocol file. See “Changing the Network Protocol” on page 95.

Installing Client Software from CD-ROM to 
Your Hard Drive

This option is for anyone who has access to the Hyperion Essbase CD-ROM. If 
you are a client user running a Windows system, you can install client software on 
your computer’s hard drive from the CD-ROM. If you are a system administrator, 
you can install client software on your client users’ hard drives from the CD-ROM. 
Client software includes:

● Hyperion Essbase Application Manager

● Hyperion Essbase Spreadsheet Add-in for Excel or 1-2-3

● Hyperion Essbase Runtime Client

➤ To install any or all of the above products on your client computer’s hard drive, 
complete the following steps:      

1. Insert the CD-ROM into your CD-ROM drive.

2. Run SETUP from the root directory of the CD-ROM.

3. Follow the prompts, and provide the information requested.

To cancel installation at any time, click the Cancel and Exit Setup buttons.

4. When prompted, you can optionally enter your license number. See Chapter 1, 
“Product Components and Software Registration,” for more information on 
registration.
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5. In the Select Components dialog box, select the Client products check box. 
This will install all the client product choices for your license agreement and 
operating system.

Figure 9: Selecting to Install Client Products

6. Select the Change button to view selected components, or choose a subset of 
client components. Leave all options checked to select all client products, or 
clear those client products you do not want to install.

Figure 10: Selecting Which Client Products to Install

7. When you finish selecting options, click Continue and Next.
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8. In the Client Setup and Destination Directory dialog box, select Local, 
specify the directory where you want to install the client products you 
selected, and select Next.

Note: The default directory is C:\HYPERION\ESSBASE. Select 
Browse to select or type another directory. If you select or type a 
directory that does not exist, the installation program will create 
it for you.

Figure 11: Choosing a Local Client Installation

9. In the Choose Network Protocol dialog box, select your network protocol, 
and select Next.

10. If you are installing Hyperion Essbase Application Manager, the Install 
HTML Documentation dialog box is displayed. Review the size 
requirements for the available online documents, select the HTML 
documentation to install, and select Next.

Note: It is recommended that the system administrator install or copy 
the HTML documentation to a network drive, so all client users 
can access it from there. The installation program creates an 
\ESSBASE\DOCS directory with numerous subdirectories. To 
view the documentation, open the INDEX.HTM file in the DOCS 
directory. You can also access the HTML documentation in the 
DOCS directory of the CD-ROM itself. To learn more about 
HTML documentation, see “Hyperion Essbase HTML 
Documents” on page xvi in the Introduction.



Application Manager and Spreadsheet Add-in Installation

4

■ 87Hyperion Essbase Installation Guide

11. In the Update Environment dialog box, choose which environment updates 
you want the installation program to perform, and select Next. You can control 
whether or not the installation program does the following:    

● Creates an ARBORPATH environment variable, and adds a statement to the 
PATH environment variable. If you choose not to let the installation 
program update the environment, then you must do it yourself. The update 
is needed to enable the system to find Hyperion Essbase files.

● Adds a program group to the Windows Start menu.

12. In the Check Setup Information dialog box, review the summary of your 
installation choices. Select Back to revise your choices, Cancel to exit the 
installation program, or Next to let the installation program begin copying 
files.

13. In the Setup Complete dialog box, leave the check box selected and select 
Finish to view the Readme file.

14. If you selected to let the installation program update the PATH and ARBORPATH 
environment variables, do one of the following:

● On Windows NT or Windows 2000, log out and log in again, or reboot 
your computer, to allow the environment changes to take effect.

● On Windows 95 or Windows 98, reboot your computer to let the 
environment changes take effect.

Installing Client Software From the 
Network to Your Hard Drive

Before you can install client software from a network drive, it must be installed to 
a network drive. 

If you are a Hyperion Essbase system administrator, see “Installing Client 
Software From CD-ROM to a Network Drive” on page 90 for instructions on how 
to install the client software to a network drive from the CD-ROM.
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You should know the following before installing client software from a network 
drive:

● Your client operating environment: Windows 95, Windows 98, Windows NT 
4.0, or Windows 2000.

● The network protocol you use: TCP/IP or Named Pipes.

● Where the client software resides on the network.

➤ To install client software from the network to your client computer’s hard drive, 
complete the following steps:    

1. Using Windows Explorer, browse to the appropriate location for SETUP, 
where N:\HYPERION\ESSBASE is the name of the network drive and 
directory where your system administrator installed the client software:      

● For Hyperion Essbase Application Manager:

N:\HYPERION\ESSBASE\APPMAN32\SETUP

● For Hyperion Essbase Spreadsheet Add-in for Excel:

N:\HYPERION\ESSBASE\ESSEXC32\SETUP

● For Hyperion Essbase Spreadsheet Add-in for 1-2-3:

N:\HYPERION\ESSBASE\ESSLOT32\SETUP

2. Double-click SETUP to start the installation program.

Note: If you are installing a Hyperion Essbase Spreadsheet Add-in, the 
installation program detects whether you have the correct version 
of Excel or 1-2-3 for the add-in you are installing.

3. Follow the directions on your screen.

4. When prompted to Choose Installation Type, choose Install to client, and 
select Next. 

Figure 12: Choosing to Install Client Software 
on Your Client Computer’s Hard Drive
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5. If you are installing Hyperion Essbase Application Manager, the Install 
HTML Documentation dialog box is displayed. Review the size 
requirements for the available online documents, select the HTML 
documentation to install, and select Next.

Note: It is recommended that the system administrator install or copy 
the HTML documentation to a network drive, so all client users 
can access it from there. The installation program creates an 
\ESSBASE\DOCS directory with numerous subdirectories. To 
view the documentation, open the INDEX.HTM file in the DOCS 
directory. You can also access the HTML documentation in the 
DOCS directory of the CD-ROM itself. To learn more about 
HTML documentation, see “Hyperion Essbase HTML 
Documents” on page xvi in the Introduction.

6. When prompted to Choose Destination Location, specify the directory in 
which to install the client software.

The default is C:\HYPERION\ESSBASE, but it might be different if you have 
previously installed Release 6.x. Select Browse to specify a different location.

Note: Install all client software in the same directory. See “Upgrading 
from Hyperion Essbase 5.x” on page 81 for more information.

7. When prompted to Choose Network Protocol, choose a network protocol, 
and select Next. See your system administrator if you are not sure which 
option to choose.   

Figure 13: Choosing the TCP/IP Network Protocol

8. In the Update Environment dialog box, choose which environment updates 
you want the installation program to perform, and select Next. You can control 
whether or not the installation program does the following:       

● Creates the ARBORPATH environment variable, and adds a statement to the 
PATH environment variable. If you choose not to let the installation 
program to update the environment, then you must do it yourself. This 
update is needed to enable the system to find Hyperion Essbase files.

● Adds a program group to the Windows Start menu.
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9. When prompted to Check Setup Information, review the summary of your 
installation choices. Select Next to allow the installation program to begin 
copying files. Select Back to revise your choices, or select Cancel to exit the 
installation program.

10. If you selected to let the installation program update the PATH and ARBORPATH 
environment variables, do one of the following:

● On Windows NT or Windows 2000, log out and log in again, or reboot 
your computer, to allow the environment changes to take effect.

● On Windows 95 or Windows 98, reboot your computer to let the 
environment changes take effect.

Note: You might not need to reboot if you previously installed 
Hyperion Essbase software to the same directory where you are 
currently installing software.

Installing Client Software From CD-ROM 
to a Network Drive

If your client users are running Windows systems, you can install Hyperion 
Essbase Application Manager or Hyperion Essbase Spreadsheet Add-in from the 
CD-ROM to a network drive, so that client users can install it from there. Use this 
option if you have many client users, or if it is difficult for your client users to share 
the CD-ROM.     

➤ To install Hyperion Essbase Application Manager or Hyperion Essbase 
Spreadsheet Add-in from the CD-ROM to a network drive, do the following:

1. Insert the CD-ROM into your CD-ROM drive. The installation program 
should automatically start. If it does not, run SETUP from the root directory of 
the CD-ROM.

2. Follow the prompts, and provide the information requested.

Note: To cancel installation at any time, select Cancel and Exit Setup.

3. When prompted, optionally enter your license number. See Chapter 1, 
“Product Components and Software Registration,” for more information on 
registration.
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4. In the Select Components dialog box, select the Client products check box. 
This will install all the client product choices for your license agreement and 
operating system.    

Figure 14: Selecting to Install Client Products

5. Select the Change button to view selected components, or choose a subset of 
client components. Leave all options checked to select all client products, or 
clear those client products you do not want to install. 

Figure 15: Selecting Which Client Products to Install
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6. When you finish selecting your options, click Continue and Next.

7. In the Client Setup and Destination Directory dialog box, select Network, 
specify the directory where you want to install the client products you 
selected, and select Next.      

Note: The default directory is C:\HYPERION\ESSBASE. Click Browse 
to specify the network directory, or type it in. If you specify a 
directory that does not exist, the installation program will create 
it for you.

Figure 16: Choosing to Install Client Products to a Network Drive

8. In the Choose Network Protocol dialog box, select your network protocol, 
and select Next. 

9. If you are installing Hyperion Essbase Application Manager, the Install 
HTML Documentation dialog box is displayed. Review the size 
requirements for the available online documents, select the HTML 
documentation to install, and select Next. 

Note: It is recommended that you install the online HTML 
documentation to a network drive, so all client users can access 
it from there. You can also make it available by copying the DOCS 
directory from the root directory of the CD-ROM to a network 
drive. To view the HTML documentation, open the INDEX.HTM 
file in the DOCS directory. To learn more about HTML 
documentation, see “Hyperion Essbase HTML Documents” on 
page xvi in the Introduction.     
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10. In the Update Environment dialog box, choose which environment updates 
you want the installation program to perform, and select Next. You can select 
whether or not the installation program does the following:    

● Creates an ARBORPATH environment variable, and adds a statement to the 
PATH environment variable. This enables the system running Hyperion 
Essbase to find Hyperion Essbase files.

– If you will run this network installation of Hyperion Essbase on your 
own client computer, this update is required. If you choose not to let 
the installation program update your environment variables, you must 
update them yourself.

– If you are installing Hyperion Essbase client software to the network 
drive so that client users can share it, this update is not required. 
Client users will update their own environments when they install or 
share products from the network drive.

● Adds a program group to the Windows Start menu.

11. In the Check Setup Information dialog box, review the summary of your 
installation choices. Select Back to revise your choices, Cancel to exit the 
installation program, or Next to let the installation program begin copying 
files. 

12. In the Setup Complete dialog box, leave the check box selected and select 
Finish to view the Readme file.       

13. If you selected to let the installation program update the PATH and ARBORPATH 
environment variables, do one of the following:      

● On Windows NT or Windows 2000, log out and log in again, or reboot 
your computer, to allow the environment changes to take effect.

● On Windows 95 or Windows 98, reboot your computer to let the 
environment changes take effect.



94 ■

Application Manager and Spreadsheet Add-in Installation

Hyperion Essbase Installation Guide

Setting Up Your Computer to Share Client 
Software on the Network Drive

➤ To set up your computer to run Hyperion Essbase Application Manager or 
Hyperion Essbase Spreadsheet Add-in on the network drive, complete the 
following steps:       

1. Using Windows Explorer, browse to the appropriate location for SETUP, 
where N:\HYPERION\ESSBASE is the name of the network drive and 
directory where your system administrator installed the client software:

● For Hyperion Essbase Application Manager:

N:\HYPERION\ESSBASE\APPMAN32\SETUP

● For Hyperion Essbase Spreadsheet Add-in for Excel:

N:\HYPERION\ESSBASE\ESSEXC32\SETUP

● For Hyperion Essbase Spreadsheet Add-in for 1-2-3:

N:\HYPERION\ESSBASE\ESSLOT32\SETUP

2. Double-click SETUP to start the installation program:    

Note: If you are installing Hyperion Essbase Spreadsheet Add-in, the 
installation program detects whether you have the correct version 
of Excel or 1-2-3 for the add-in you are installing.

3. Follow the directions on your screen.

4. When prompted to Choose Installation Type, select Set up client to use 
shared executables, and select Next. 

Figure 17: Choosing to Set Up Your Computer 
to Run the Client Software on the Network Drive
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5. The program detects where the network installation of the client software 
resides. If it cannot find it, you are prompted for the directory. Click Browse 
to specify the location.

Note: The Hyperion Essbase shared executable files are in 
the N:\HYPERION\ESSBASE\BIN directory, where 
N:\HYPERION\ESSBASE is the network drive and 
directory where your system administrator installed 
the client software.

6. In the Check Setup Information dialog box, review the summary of your 
installation choices. Select Back to revise your choices, Cancel to exit the 
installation program, or Next to let the installation program begin updating 
your environment. 

This type of installation automatically creates or updates the ARBORPATH 
environment variable, and adds a statement to the PATH environment variable. 
This update is needed to enable the system to find shared Hyperion Essbase 
files.

7. In the Setup Complete dialog box, leave the check box selected and select 
Finish to view the Readme file.      

8. Do one of the following to allow the environment changes to take effect:

● On Windows NT or Windows 2000, log out and log in again, or reboot 
your computer.

● On Windows 95 or Windows 98, reboot your computer.

Changing the Network Protocol
If you are a client user, changing the network protocol is something you rarely do. 
If you installed client products on your client computer’s hard drive, speak to your 
system administrator before changing your network protocol.

If you set up your client computer to run client products on the network drive, 
do not change the network protocol. Everyone who uses a shared executable on 
a network drive must use the same network protocol file. Only the system 
administrator should change the protocol of a shared network installation.
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Network Protocol Files
The network protocol file implements the TCP/IP or Named Pipes protocol you 
selected on installing the client software on your client computer’s hard drive, or 
that the system administrator selected on installing the client software to a network 
drive. The network protocol file, ESSNET.DLL, resides in the BIN directory with 
the client software. This can be on your client computer’s hard drive or on a 
network drive, depending on which installation option you selected.      

Note: For more information on network protocols, see Chapter 9, “Network 
Configuration Notes.”

➤ To install a different network protocol file, complete the following steps:  

1. Run SETUP from the CD-ROM (follow steps 1 to 4 of  “Installing Client 
Software from CD-ROM to Your Hard Drive” on page 84).

2. In the Select Components dialog box, select the Update Protocols check 
box, and click Next.

3. When prompted to Choose Network Protocol, choose a network protocol and 
click Next. See your system administrator if you are not sure which option to 
choose.

Figure 18:  Choosing the TCP/IP Network Protocol

4. The program detects where the installation of the client software resides. If it 
cannot find it, you are prompted for the directory. Click Browse to specify the 
location.

5. In the Check Setup Information dialog box, review the summary of your 
installation choices. Select Back to revise your choices, Cancel to exit the 
installation program, or Next to let the installation program begin copying 
files.   

6. In the Setup Complete dialog box, select Finish.



Application Manager and Spreadsheet Add-in Installation

4

■ 97Hyperion Essbase Installation Guide

Directories and Files Created
When you install Hyperion Essbase client products to a client computer’s hard 
drive or to a network drive, some or all of the directories described in the following 
table are created under\HYPERION\ESSBASE (this is the default installation 
directory; if you select another location, the directories are created there). Which 
directories are created depends on which client products you install and which 
installation type you select. 

When you set up your computer to run client software on the network drive, 
the installation program, SETUP, does not create any directories on your client 
computer’s hard drive. It installs only Windows system files on your client 
computer’s hard drive. You run the program files that are on the network drive. 
They are in the directories described in the following table:  

Table 12: Directories Created Under \HYPERION\ESSBASE 

Directory: Created with: Details:

BIN All Hyperion Essbase 
product installations

Contains Hyperion Essbase program files for running 
local and shared network installations, including: 

• ESSADMIN.EXE, the executable file for Hyperion 
Essbase Application Manager. 

• ESSEXCLN.XLL, the Hyperion Essbase 
Spreadsheet Add-in file the installation program 
adds to Excel to point Excel to the correct BIN 
directory.

• ESS123.12A, the Hyperion Essbase Spreadsheet 
Add-in file the installation program adds to 1-2-3 
to point 1-2-3 to the correct BIN directory.

CLIENT All Hyperion Essbase 
product installations

The Hyperion Essbase sample spreadsheets reside in 
CLIENT\SAMPLE. If you create applications and 
databases, and store them on your computer’s hard 
drive, they reside in the CLIENT directory as follows:      

CLIENT
    APPNAME 
         DBNAME 

where APPNAME is the name of the application and 
DBNAME is the name of the database.
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DOCS Local and network 
installations of some 
Hyperion Essbase 
products

If you install the online HTML documentation with 
the Hyperion Essbase API or Application Manager, 
several subdirectories are created under DOCS. To 
view the HTML documentation, open the 
INDEX.HTM file. See “Hyperion Essbase HTML 
Documents” on page xvi in the Introduction. 

The DOCS\TECHREF\MAXL directory contains the 
MaxL Language Reference, which you will need in 
order to use MaxL, the new multi-dimensional access 
language for Hyperion Essbase. This is installed 
automatically with Hyperion Essbase OLAP Server 
and Hyperion Essbase Application Manager.

If you install the corresponding products, the 
following documents are provided in DOCS\CLIENT 
in.PDF format for online viewing and printing 
in Adobe Acrobat Reader (Version 3.0.1 or later):

• The Hyperion Essbase Spreadsheet Add-in User’s 
Guide. The file is named ESSEXCEL.PDF or 
ESS123W.PDF, depending on which add-in you 
are using.

• The Hyperion Essbase SQL Interface Guide. 
The file is named ESSQLINT.PDF.

• The Hyperion Essbase Quick Path Card (QPC). 
The file is named ESSQPC.PDF.

• The MaxL User’s Guide. The file is named 
ESSMAXL.PDF.

Adobe Acrobat Reader is provided on the Hyperion 
Essbase CD-ROM, or you can download it from 
http://www.adobe.com. On the CD-ROM, the 
Acrobat Reader executable file is located in the 
ADOBE directory under the appropriate platform 
and language-version subdirectories.

Table 12: Directories Created Under \HYPERION\ESSBASE (Continued)

Directory: Created with: Details:

http://www.adobe.com
http://www.adobe.com
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LOCALE Local and network 
installations of some 
Hyperion Essbase 
products

Contains the character-set files necessary for all the 
languages Hyperion Essbase supports, including 
English. For non-English versions, you also need to 
create the ESSLANG environment variable. For more 
information about ESSLANG, see Chapter 10, 
“Advanced Installation Topics.”

PERLMOD All installations of 
Hyperion Essbase 
Application Manager 
and the Hyperion 
Essbase server.

Contains the files and documentation you need to add 
the Essbase Perl Module (Essbase.pm) to Perl, 
enabling you to embed MaxL statements in Perl 
programs. You must install Perl yourself. For more 
information, see the MaxL Language Reference in the 
DOCS\TECHREF\MAXL directory, and the README 
file included in the PERLMOD directory.

APPMAN32 Network installations of 
Hyperion Essbase 
Application Manager   

Installation directory for installing Hyperion Essbase 
Application Manager on a client computer’s hard 
drive. Contains SETUP.EXE.

ESSEXC32 Network installations 
of Hyperion Essbase 
Spreadsheet Add-in for 
Excel   

Installation directory for installing Hyperion Essbase 
Spreadsheet Add-in for Excel on a client computer’s 
hard drive. Contains SETUP.EXE.

ESSLOT32 Network installations 
of Hyperion Essbase 
Spreadsheet Add-in 
for 1-2-3

Installation directory for installing Hyperion Essbase 
Spreadsheet Add-in for 1-2-3 on a client computer’s 
hard drive. Contains SETUP.EXE.

RUNTIME Network installations 
of Hyperion Essbase 
Runtime Client

Installation directory for installing Hyperion Essbase 
Runtime Client on a client computer’s hard drive. 
Contains SETUP.EXE.

Table 12: Directories Created Under \HYPERION\ESSBASE (Continued)

Directory: Created with: Details:
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In addition to a Readme file and the subdirectories listed above, the ESSBASE 
directory contains an *.ISU file for each installed server or client component, 
and a file named Essunins.dll, which facilitates uninstalling the software.

CAUTION: Do not move, rename, or delete the *.ISU files in the 
ESSBASE directory. Do not rename the ESSBASE directory 
or any subdirectories or files beneath it. Alteration of the 
installed Hyperion Essbase files and directories prevents 
their successful uninstallation. In the event that you want to 
move Hyperion Essbase to another directory or revert to an 
eariler release, you will need to completely uninstall it first. 
For more information about uninstalling, see Chapter 10, 
“Advanced Installation Topics.”

Starting Hyperion Essbase 
Application Manager

After you install Hyperion Essbase Application Manager on your hard drive or set 
up your operating environment to run Hyperion Essbase Application Manager on 
the network drive, reboot and start Windows. If you selected during the installation 
to add icons to the Start menu program group, the following are available when 
you select Start > Programs > Hyperion Solutions > Hyperion Essbase 6.0:     

Table 13: Program Icons

Icon Program Where To Get Information

Hyperion Essbase 
Application Manager

Hyperion Essbase Database Administrator’s 
Guide

Hyperion Essbase 
Application Manager 
Help

Click the Help button in any dialog box.

ESSCMD Hyperion Essbase Database Administrator’s 
Guide
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To run Hyperion Essbase Application Manager, select Start > Programs > 
Hyperion Solutions > Hyperion Essbase 6.0 > Essbase Application Manager. 

The Hyperion Essbase Application Manager desktop is displayed as shown in 
Figure 19. 

Figure 19:  Application Manager Desktop

If your $ARBORPATH environment variable is not correct or if the ESSBASE.MDB 
file is missing, you see the error message shown in Figure 20 when you start 
Hyperion Essbase Application Manager:     

Figure 20: Cannot Initialize Essbase Error Message

n/a MaxL Command 
Shell

The MaxL Language Reference in the 
Docs\Techref\Maxl directory, and the 
MaxL User’s Guide in the Docs\Client 
directory.

Table 13: Program Icons

Icon Program Where To Get Information



102 ■

Application Manager and Spreadsheet Add-in Installation

Hyperion Essbase Installation Guide

Connecting to the Server With Hyperion 
Essbase Application Manager

After you start Hyperion Essbase Application Manager, try connecting to the 
Hyperion Essbase server to verify that you can establish a connection. To connect 
to the server:  Italica   

1. Select Server > Connect to open the Essbase System Login dialog box.   

Figure 21: Logging in Using the Server Name

2. From the Server list box, select the server name to connect to, or enter it in 
the Server text box. The server name is defined by the server operating system 
and by the network protocol. In Figure 21, for example, the server name is 
Aspen. 

An alternate way to enter the server name, if you use TCP/IP, is to enter its IP 
address. See “Specifying an IP Address as a Server Name” on page 103 for 
more information. See your network administrator for your server’s IP 
address.

Figure 22: Logging in Using the Server IP Address

3. Enter your user name and password in the text boxes. If you do not know 
your user name and password, or if you are unable to connect to the server, 
contact your Hyperion Essbase system administrator. If you or the system 
administrator just installed the Hyperion Essbase server software, the only 
user that exists on the server is the user name of the Hyperion Essbase system 
supervisor, and you should use the Hyperion Essbase system password. See 
the installation chapter for your server for more information.    
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4. Click OK. The Application Desktop window is displayed on the Application 
Manager desktop. For example, if the server name is Aspen, the desktop looks 
like the example shown in Figure 23.

Figure 23: Application Desktop Window for the Aspen Server 

Note: If you cannot connect to the server, see “Troubleshooting 
Application Manager Connections to the Server” on page 104.

Specifying an IP Address as a Server Name
When connecting to a Hyperion Essbase server from any Hyperion Essbase client, 
you normally use the server machine’s computer name, as defined by the operating 
system. You can also use the IP address of the server machine, if it is a 
TCP/IP-enabled machine. 

From ESSCMD, or from any client login dialog box, you can enter the IP address 
in place of the server name. Enter the IP address in dotted notation as follows:

A.B.C.D

where A, B, C, and D are integers in decimal, hexadecimal, or octal format.

To specify an IP address using decimals, simply enter the IP address, beginning 
with any digit except 0 (zero). For example,

149.22.15.154
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To specify an IP address using octals, enter the IP address with a leading 0 (zero). 
For example, 

0225.26.17.232

To specify an IP address using hexadecimals, enter the IP address with a leading 
0x or 0X. For example,

0x95.16.F.9A

Troubleshooting Application Manager 
Connections to the Server

This section helps you determine why you cannot connect to the server and how 
to correct the problem.  

● Hyperion Essbase Application Manager can find the server machine but 
cannot connect to the Hyperion Essbase server. This error message can be 
displayed if Hyperion Essbase is not running on the server, or if the network 
protocols for the server and the client are different or are not correctly installed 
and running.    

In this case, the  error message shown in Figure 24 is displayed. 

Figure 24: Cannot Locate Hyperion Essbase on the Server Machine

If you see this message, 

a. Reboot your computer and try again.

b. Verify that Hyperion Essbase is running on the server machine.

c. Ensure that your network protocol is correctly installed. See “Checking 
the Network Protocol” on page 105.
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● Hyperion Essbase Application Manager cannot find the server name you 
entered. This error message can be displayed if you enter an invalid server 
name, or if the network protocols for the server and the client are different, or 
are not correctly installed and running. In this case, the error message shown 
in Figure 25 is displayed.       

Figure 25: Cannot Locate the Server Machine

If you see this message,

a. Reboot your computer and try again.

b. Verify that the server name you entered is correct.

c. Ensure that your network protocol is correctly installed. See “Checking 
the Network Protocol” on page 105.

● A similar error, Network Error: Unable to Connect to Server-name, is 
displayed if the network protocols for the server and the client are different or 
are not correctly installed and running.     

If you see this message,

a. Reboot your computer and try again.

b. Ensure that your network protocol is correctly installed. See “Checking 
the Network Protocol” on page 105.

Checking the Network Protocol
If you suspect that the network protocol for Hyperion Essbase Application 
Manager is not correctly installed, do the following: 

1. See “Changing the Network Protocol” on page 95.

2. See Chapter 9, “Network Configuration Notes.” for more information on 
network protocols.
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3. See your network protocol vendor documentation for more detailed 
information.

Note: Client users, do not change the network protocol if you set up 
your computer’s operating environment to run Hyperion Essbase 
Application Manager on the network drive. All users running—and 
sharing—client software on a network drive must use the same 
network protocol file. Only the Hyperion Essbase system 
administrator should change the protocol of a shared network 
installation.

Starting Hyperion Essbase Spreadsheet 
Add-in and Connecting to the Server

After installing Hyperion Essbase Spreadsheet Add-in on your computer’s hard 
drive, or setting up your computer to run Hyperion Essbase Spreadsheet Add-in on 
the network drive, do the following:      

1. Reboot Windows to let the changes to your environment take effect.

2. Run Excel or 1-2-3. The Hyperion Essbase startup screen is displayed.

If the startup screen is not displayed, and Essbase is not on the Excel or 1-2-3 
menu, see “Troubleshooting the Spreadsheet Add-in” on page 109 to correct 
the problem.
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3. Select Essbase > Connect to connect to the Hyperion Essbase server. 

The Essbase System Login dialog box shown in Figure 26 is displayed.    

Figure 26: Entering the Server Name in the 
Essbase System Login Dialog Box

4. Enter your server name, user name, and password, and then click OK.

An alternate way to enter the server name, if you use TCP/IP, is to enter its IP 
address. See your network administrator for your server’s IP address.

Figure 27: Entering the IP Address in the 
Essbase System Login Dialog Box
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5. After you connect to the server, select the application and database to connect 
to, and then click OK.

See the Hyperion Essbase Spreadsheet Add-in User’s Guide for more information 
about connecting to Hyperion Essbase servers and databases. 

Installing the Hyperion Essbase Toolbar 
(Optional—Excel Only)

The Hyperion Essbase Spreadsheet Add-in for Excel provides a convenient 
toolbar that displays buttons for accessing most of the common Hyperion 
Essbase commands without having to open the Hyperion Essbase menu. To 
use the Hyperion Essbase toolbar, you must first install it by opening an Excel 
file that is provided as part of the default Hyperion Essbase installation. For more 
information on using the toolbar, see “Using the Hyperion Essbase Toolbar” in the 
Hyperion Essbase Spreadsheet Add-in User’s Guide.   

➤ To install the Hyperion Essbase toolbar:   

1. Start Excel.

2. Select File > Open. 

3. Open the ESSTOOLB.XLS file from the \ESSBASE\CLIENT\SAMPLE 
directory.

Depending on how software is installed on your computer, this file may not be 
available or may be located in a different directory. Contact your Hyperion 
Essbase system administrator for more information.
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A blank spreadsheet is displayed similar to the one shown in Figure 28.

Figure 28: ESSTOOLB.XLS File

Note: If two Excel dialog boxes are displayed in sequence when you 
open the ESSTOOLB.XLS file, click Enable Macros on the first 
dialog box, and click OK on the second.

4. Select File > Close to close the ESSTOOLB.XLS file. You do not need to 
modify or save the file. 

You should not have to perform the toolbar installation procedure again unless you 
delete the Hyperion Essbase toolbar from the Toolbars dialog box in Excel. If you 
delete the toolbar, perform the installation procedure again. 

Note: If you have toolbars turned off in Excel, you will not see the Hyperion 
Essbase toolbar immediately. You must enable toolbars first. For 
more information, see “Using the Hyperion Essbase Toolbar” in the 
Hyperion Essbase Spreadsheet Add-in User’s Guide for Excel. 

Troubleshooting the Spreadsheet Add-in
The installation program automatically adds Hyperion Essbase Spreadsheet 
Add-in to Excel or 1-2-3. This adds Essbase to the spreadsheet program’s menu 
bar, and points the spreadsheet program to the appropriate Hyperion Essbase 
Spreadsheet Add-in file, located in the BIN directory.
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As a troubleshooting measure, you should know how to use the Excel or 1-2-3 
add-in facility to add the appropriate add-in file to Excel or 1-2-3. The Spreadsheet 
Add-in file is in the BIN directory on your computer’s hard drive if you selected 
to install the Spreadsheet Add-in locally, or in the BIN directory on the network 
drive if you selected to set up your computer to run the Spreadsheet Add-in there.     

● ESS123.12A is the add-in file for Lotus 1-2-3 Millennium Releases 9.1 and 
9.5.

● ESSEXCLN.XLL is the add-in file for Excel 97 and Excel 2000. 

Note: ESSXLEQD.XLA is an additional add-in file for Hyperion 
Essbase Query Designer for Excel. This add-in, which loads 
automatically when Hyperion Essbase Query Designer is started,  
enables Excel and EQD to synchronize workbook and worksheet 
operations, including creating, deleting, and moving the 
workbooks.

If Hyperion Essbase Spreadsheet Add-in is not properly installed or configured 
after the installation program completes, use the following steps to isolate the 
problem. 

● Reboot your computer.

● Check your environment.

● Remove and manually add Hyperion Essbase Spreadsheet Add-in.

● Install Hyperion Essbase Spreadsheet Add-in again.

Reboot Your Computer
On Windows 95 and Windows 98, reboot your computer. On Windows NT 4.0 or 
Windows 2000, log out and log in again, or reboot your computer. This ensures 
that changes to your environment settings take effect. 
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Check Your Environment
If the message shown in Figure 29 is displayed, you may have a problem with your 
PATH and ARBORPATH environment variables.   

Figure 29: File Not Found Error Message

Type PATH at the MS-DOS command prompt. Make sure that\ESSBASE\BIN, 
or the BIN directory of the directory you specified during setup, is in the PATH 
statement.

Type SET and check your ARBORPATH setting. It should indicate the drive and 
directory you specified during setup; for example,

ARBORPATH=C:\HYPERION\ESSBASE

Remove and Manually Add the Add-in
If problems persist, or the Hyperion Essbase startup screen is not displayed when 
you start the spreadsheet program, remove Hyperion Essbase Spreadsheet Add-in 
from the spreadsheet program, exit and restart the spreadsheet program, and 
manually add the add-in as described in the following steps.

➤ To manually add Hyperion Essbase Spreadsheet Add-in to Excel:

1. In Excel, choose Tools > Add-Ins. 

The Add-Ins dialog box is displayed.

2. Click Browse. 

A file selection dialog box is displayed.
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3. To complete this step, you must know whether you are running Hyperion 
Essbase Spreadsheet Add-in from your computer’s hard drive or from a 
network drive.

Choose the file ESSEXCLN.XLL in the BIN directory where you installed 
Hyperion Essbase Spreadsheet Add-in on your computer’s hard drive, or 
where your system administrator installed Hyperion Essbase Spreadsheet 
Add-in on a network drive.

4. Click OK twice to close the dialog boxes and start Hyperion Essbase 
Spreadsheet Add-in. The Hyperion Essbase startup screen is displayed, 
and Essbase is added to the Excel menu.

➤  To manually add Hyperion Essbase Spreadsheet Add-in to Lotus 1-2-3:  

1. In 1-2-3, choose File > Add-Ins > Manage Add-Ins.

The Manage Add-ins dialog box is displayed.   

2. Click Register.

3. Choose the file ESS123.12A  in the BIN directory where you installed 
Hyperion Essbase Spreadsheet Add-in on your computer’s hard drive (if you 
installed it there), or in the BIN directory where your system administrator 
installed Hyperion Essbase Spreadsheet Add-in on a network drive (if you 
selected to set up your computer’s operating environment to run the add-in 
there).

4. Click Open.

5. Select the ESS123.12A add-in file, and click Done to close the Manage 
Add-Ins dialog box and start Hyperion Essbase Spreadsheet Add-in. Make 
sure there is a check mark next to the ESS123.12A add-in file.

The Hyperion Essbase startup screen is displayed, and Essbase is added to the 
1-2-3 menu.

Install the Add-in Again
If the problem persists, uninstall Hyperion Essbase Spreadsheet Add-in and run 
the installation program again. Accept the default settings. Be sure to specify the 
correct network protocol.
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Chapter

5
Sample Applications

The Hyperion Essbase OLAP Server installation includes four sample 
applications.  

● The main application used in the documentation is called Sample. It contains 
three databases: Basic, Interntl, and Xchgrate. The latter two contain specific 
features corresponding to the Hyperion Essbase Currency Conversion option.      

● The second application, called Demo, contains one database, Basic, referred 
to in the online Technical Reference in the DOCS directory and in some of the 
documentation for Hyperion Essbase Report Writer.  

● The third application, called Samppart, is the first of two applications 
designed to show the features of Hyperion Essbase Partitioning. Samppart 
contains a Company database that is the target of a partitioned database.   

● The fourth application, called Sampeast, is the second of two applications 
designed for Partitioning. Sampeast contains an East database that is the 
source of data for a partitioned database.  

Note: In some licensing instances, installation of the sample applications 
may be restricted to the main application (Sample) and its three 
databases (Basic, Interntl, and Xchgrate). Please refer to your license 
agreement for details.

If you selected to install the sample applications during your server installation, 
you must perform additional steps to prepare them for use in your organization. 
This chapter contains the following sections:

● “Accessing the Sample Applications” on page 114

● “Preparing the Sample Basic Database” on page 116

● “Preparing the Sample Interntl Database” on page 120

● “Preparing the Sample Xchgrate Database” on page 122
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● “Preparing the Demo Basic Database” on page 124

● “Providing User Access to the Sample Applications” on page 126

● “Setting the Environment for the Partitioning Sample Applications” on 
page 127

● “Preparing the Samppart Company Database” on page 138

● “Preparing the Sampeast East Database” on page 140

Accessing the Sample Applications
If you are upgrading your server installation from a release of Hyperion Essbase 
prior to Release 5, you might not see the Release 6.0 sample applications in the 
Application Desktop window the first time you restart the Hyperion Essbase server 
and Hyperion Essbase Application Manager, even if you installed the sample 
applications.      

Even though they exist in the \ESSBASE\APP directory on the server, the 
Hyperion Essbase Agent has not yet been informed that these applications exist. 
This occurs because the installation program does not modify your security file 
(ESSBASE.SEC). The security file maintains the current list of applications 
and databases on your server and all user and security definitions. 

➤ To obtain access to the Hyperion Essbase sample applications in Release 6.0, 
complete the following steps:

1. Open Hyperion Essbase Application Manager.

2. Connect to the server in which the sample applications are installed. See 
Chapter 4, “Application Manager and Spreadsheet Add-in Installation” if you 
are unsure how to do this.
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3. In the Application Desktop window, view the list of available applications in 
the Applications list box.     

Figure 30: Viewing Available Applications in the Application Desktop Window

The list of applications in the Applications list box should match the 
subdirectories in the\ESSBASE\APP directory on the server. Make a note of 
the missing applications.

This example assumes that the Samppart and Sampeast applications are 
missing from the list of applications.

4. Select File > New > Application. The Create New Application dialog box is 
displayed.

5. In the Application name text box, enter the name of the missing application; 
for example, Samppart.

Figure 31: Entering Samppart in the Create New Application Dialog Box
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6. Click OK. Hyperion Essbase recognizes the application and adds it to the list 
box.

If you attempt to create an application that is already viewable in the list box 
in Hyperion Essbase Application Manager, you see the error shown in 
Figure 32.

Figure 32: Error Message When Trying to Create an Existing Application

7. Select File > New > Application. The Create New Application dialog box is 
displayed.

8. In the Application name text box, enter the name of the application; for 
example, Sampeast.

9. Click OK. Hyperion Essbase recognizes the application and adds it to the list 
box.

If necessary, repeat steps 4–6 for each application you need to access, substituting 
the appropriate application name where appropriate, such as Sample or Demo.

When you have access to the sample applications, you are ready to prepare them 
for use by other users.

Preparing the Sample Basic Database
The first database in the Sample application is called Basic. To prepare it for use, 
you need to load data into it.       

➤ To load data into the Sample Basic database:

1. Open Hyperion Essbase Application Manager.

2. Connect to the server in which the Sample application is installed. This 
example uses a server called Aspen. See Chapter 4, “Application Manager 
and Spreadsheet Add-in Installation” if you are unsure how to do this.

3. Select the application called Sample from the Applications list box. 
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4. Select the database called Basic from the Databases list box as shown in 
Figure 33. 

Figure 33: Selecting the Basic Database 

5. Select Database > Load Data. 

The Data Load dialog box is displayed as shown in Figure 34. 

Figure 34: Data Load Dialog Box Before Selecting a Data File

The Data Load dialog box is described in detail in the Hyperion Essbase 
Application Manager online help, and in the Hyperion Essbase OLAP Server 
Database Administrator’s Guide.
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6. Click the Find button above the Data files list box to locate a data file to load. 
The Open Server Data File Objects dialog box is displayed.

7. Ensure that List Objects of Type is Text files.

8. Select the text file named CALCDAT from the Objects list box as shown in 
Figure 35.

Figure 35: Selecting the CALCDAT Text File



Sample Applications

5

■ 119Hyperion Essbase Installation Guide

9. Click OK to close the dialog box. 

Hyperion Essbase updates the Data Load dialog box to display the data file 
you selected as shown in Figure 36.

Figure 36: Data Load Dialog Box with CALCDAT Data File Selected
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10. Click OK to load the selected file. 

The data file is a large, fully calculated data set. It should take several minutes 
to load, and then the Data Load Completed dialog box is displayed as shown 
in Figure 37.

Figure 37: Message that Hyperion Essbase Has Finished 
Loading CALCDAT Data File

11.  Click Close.

Preparing the Sample Interntl Database
The second database in the Sample application is called Interntl. To prepare it for 
use, you need to load data into it.

➤ To load data into the Sample Interntl database:

1. Open Hyperion Essbase Application Manager.

2. Connect to the server in which the Sample application is installed. This 
example uses the server Aspen. See “Application Manager and Spreadsheet 
Add-in Installation” on page 4-79, if you are unsure how to do this.

3. Select the application called Sample from the Applications list box.

4. Select the database called Interntl from the Databases list box.
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5. Select Database > Load Data. The Data Load dialog box is displayed.

The Data Load dialog box is described in detail in the Hyperion Essbase 
Application Manager online help, and in the Hyperion Essbase OLAP Server 
Database Administrator’s Guide.

6. Click the Find button above the Data files list box to locate a data file to load. 
The Open Server Data File Objects dialog box is displayed.

7. Ensure that List Objects of Type is Text files. 

8. Select the text file named CURRCALC from the Objects list box.

9. Click OK to close the dialog box. 

Hyperion Essbase updates the Data Load dialog box to display the data file 
you selected as shown in Figure 38.

Figure 38: Data Load Dialog Box with CURRCALC Data File Selected

10. Click OK to load the selected file. The data file is a large fully calculated data 
set. It takes several minutes to load, and then the Data Load Completed 
dialog box is displayed. 

11. Click Close.
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Preparing the Sample Xchgrate Database
The third database in the Sample application is called Xchgrate. To prepare it for 
use, you need to load data into it.

➤ To load data into the Sample Xchgrate database:

1. Open Hyperion Essbase Application Manager. 

2. Connect to the server in which the Sample application is installed. This 
example uses the server Aspen. See Chapter 4, “Application Manager 
and Spreadsheet Add-in Installation” if you are unsure how to do this.

3. Select the application called Sample from the Applications list box.

4. Select the database called Xchgrate from the Databases list box.

5. Select Database > Load Data. The Data Load dialog box is displayed.

The Data Load dialog box is described in detail in the Hyperion Essbase 
Application Manager online help, and in the Hyperion Essbase OLAP Server 
Database Administrator’s Guide.

6. Click the Find button above the Data files list box to locate a data file to load. 
The Open Server Data File Objects dialog box is displayed.

7. Ensure that List Objects of Type is Text files. 

8. Select the text file named RATES from the Objects list box.
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9. Click OK to close the dialog box. 

Hyperion Essbase updates the Data Load dialog box to display the data file 
you selected.

Figure 39: Data Load Dialog Box with RATES Data File Selected 

10. Click OK to load the selected file. The data file contains currency exchange 
rates, and should take less than one minute to load. The Data Load 
Completed dialog box is displayed. 

11. Click Close.
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Preparing the Demo Basic Database
Note: In some licensing instances, installation of the sample applications 

may be restricted to the main application (Sample) and its three 
databases (Basic, Interntl, and Xchgrate). In this case, you will not see 
the Demo Basic database. Please refer to your license agreement for 
details.

The Demo application contains one database called Basic. To prepare it for use, 
you need to load data into it.

➤ To load data into the Demo Basic database:      

1. Open Hyperion Essbase Application Manager.

2. Connect to the server in which the Sample application is installed. This 
example uses the server Aspen. See Chapter 4, “Application Manager 
and Spreadsheet Add-in Installation” if you are unsure how to do this.

3. Select the application called Demo from the Applications list box.

4. Select the database called Basic from the Databases list box.

5. Select Database > Load Data. The Data Load dialog box is displayed.

The Data Load dialog box is described in detail in the Hyperion Essbase 
OLAP Server Database Administrator’s Guide.

6. Click the Find button above the Data files list box to locate a data file to load. 
The Open Server Data File Objects dialog box is displayed.

7. Ensure that List Objects of Type is Text files. 

8. Select the text file named DATA from the Objects list box.
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9. Click OK to close the dialog box. 

Hyperion Essbase updates the Data Load dialog box to display the data file 
you selected.

Figure 40: Data Load Dialog Box with DATA Data File Selected

10. Click OK to load the selected file. 

The data file takes a minute or two to load, and then the Data Load 
Completed dialog box is displayed. 

11. Click Close.
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Providing User Access to the 
Sample Applications

Hyperion Essbase provides a comprehensive security system for a secure 
multi-user environment. By default, the sample applications are created with a 
security access level of None, which means that no user can connect to the 
database, unless the user is defined as a supervisor.  

The system supervisor, defined when the Hyperion Essbase server was installed, 
automatically has supervisor privilege. Therefore, the system supervisor can make 
the sample applications available to other users.

➤ To provide all users with write access to the database:   

1. Log in using the system supervisor account.

2. Open Hyperion Essbase Application Manager.

3. Connect to the server in which the Sample application is installed. See 
Chapter 4, “Application Manager and Spreadsheet Add-in Installation” if you 
are unsure how to do this.

4. Select the application called Sample from the Applications list box.

5. Select Application > Settings. The Application Settings dialog box is 
displayed as shown in Figure 41.   

Figure 41: Choosing Write Access for the Sample Application
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6. Click the Write option from the Minimum Database Access group, and click 
OK to save the setting.

Hyperion Essbase closes the dialog box and returns you to the Application 
Desktop window.

7. Select the application called Demo from the Applications list box.

8. Select Application > Settings. The Application Settings dialog box is 
displayed.

9. Click the Write option from the Minimum Database Access group, and click 
OK to save the setting.

The Sample and Demo applications are now ready for use. If you want to use 
the Partitioning applications, continue on to “Setting the Environment for the 
Partitioning Sample Applications” on page 5-127. Otherwise, your next step might 
be to create the appropriate user names to be able to log in to Hyperion Essbase. 
See the Hyperion Essbase OLAP Server Database Administrator’s Guide for 
information on creating users.

Setting the Environment for the Partitioning 
Sample Applications

Note: In some licensing instances, installation of the sample applications 
may be restricted to the main application (Sample) and its three 
databases (Basic, Interntl, and Xchgrate). Please refer to your license 
agreement for details.

Hyperion Essbase includes two sample applications and databases that show the 
features of Hyperion Essbase Partitioning:   

● Samppart, Company

● Sampeast, East

These applications and databases include partition definitions stored in.DDB 
files. The.DDB files define the map between member combinations in the target 
database, Company, and the source database, East. The Hyperion Essbase OLAP 
Server Database Administrator’s Guide describes Partitioning, member 
combinations, and the differences between target and source databases.  
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For these applications to work in your environment, you need to match or change 
the information contained in the.DDB files. To use the applications, you must do 
the following:  

● Create a user named partitionuser. This is necessary because the sample 
partitioning databases were created with that user name. 

● Change the server name that is embedded in the applications.

Note: Do not go into the.DDB files to change this information. Instead, 
complete the steps in the following sections. “Creating the Partition 
User” on page 5-128 describes how to create the required user name, 
so that your users can use these applications. “Changing the Server 
Name in the Sample Partition Definitions” on page 5-132 describes 
how to change the embedded server name to your server name.   

Creating the Partition User
Because the Samppart and Sampeast applications were designed by a user called 
partitionuser, you must create a user called partitionuser to work with these 
applications. Partitionuser must have Application Designer access to these 
applications on the server in which they are installed. If you are unsure how to 
do this, complete the following steps:    

1. Open Hyperion Essbase Application Manager.

2. Using a user name that is a supervisor or that has Create/Delete Users, Groups 
privilege, connect to the server on which the Samppart and Sampeast 
applications are installed.
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3. Select Security > Users/Groups. 

The User/Group Security dialog box is displayed as shown in Figure 42.

Figure 42: User/Group Security Dialog Box 

4. Click the New User button. 

Hyperion Essbase displays the New User dialog box as shown in Figure 43.

Figure 43: New User Dialog Box
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5. In the text box, type partitionuser. Be sure to use all lowercase letters.  

6. In the text box, enter a password. 

For example, type any word such as password. Hyperion Essbase displays 
asterisks in the place of the characters you type.

7. In the Confirm Password text box, type your password again. 

Hyperion Essbase displays asterisks in the place of the characters you type.

Figure 44: Entering New User Name and Password 

8. Click the App Access button. 

Hyperion Essbase displays the dialog box shown in Figure 45.

Figure 45: User/Group Application Access Dialog Box 
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9. Select the Sampeast application, then click App Designer in the group.

10. Select the Samppart application, then click App Designer in the Access 
group.

Figure 46: Selecting Samppart Application and App Designer Privilege

11. Click OK to return to the New User dialog box.

12. Click OK to return to the User/Group Security dialog box.

13. Click Close.

Logging in as partitionuser
After creating the “partitionuser” user name, log out of the server and log in again 
as partitionuser. 

➤ To log out and log in again as partitionuser:  

1. If you are still logged in, select Server > Disconnect. The Logout dialog box 
is displayed.      

2. Click OK to log out.

3. Select Server > Connect. 

Hyperion Essbase displays the Essbase System Login dialog box.

4. In the Username text box, type partitionuser.
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5. In the Password text box, enter the password.

Figure 47: Logging In as partitionuser

6. Click OK. 

The Application Desktop window is displayed, and you are ready to continue 
setting up the Samppart and Sampeast applications.

Changing the Server Name in the 
Sample Partition Definitions

The following steps change the embedded server name in the partition definition 
files (.DDB) to your server name. The.DDB files shipped with Samppart and 
Sampeast are based on the server name “localhost.”        

The following steps change the server name in the Samppart Company.DDB file.

1. In the Application Desktop window, select the Samppart application and 
Company database.

Figure 48: Selecting Samppart Application and Company Database
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2. Select Database > Partition Manager. 

After a brief pause, Hyperion Essbase displays the Partition Manager dialog 
box. 

Note: If the Partition Manager dialog box does not appear or if it 
contains no definition entries, contact your Hyperion Essbase 
system administrator. Your server must be registered with a 
license number supporting Partitioning.

3. Select the first definition entry, labeled Localhost: SampEast: East under the 
Source Cube heading as shown in Figure 49.

Figure 49: Selecting Localhost: SampEast: East
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4. Click the Edit button.

The Dangling Remote Reference dialog box is displayed. Because you are 
not connected to a server named Localhost, Hyperion Essbase warns you 
before it allows you to edit the definition.

Figure 50: Dangling Remote Reference Dialog Box for 
Localhost: Sampeast: East

5. Click Advanced. 

The Fix Dangling Partition Reference dialog box is displayed.

6. Click Correct the invalid partition reference in the Action group.

7. In the Server text box in the Reconnect group, replace Localhost with your 
server name, such as Aspen, as shown in Figure 51.

Figure 51: Replacing Server Name Localhost with Server Name Aspen

8. Click Apply. 

Hyperion Essbase displays the Partition Manager dialog box. See  Figure 49.

9. Select the second definition entry, Localhost: Sampeast: East in the Source 
Cube list.
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10. Repeat steps 4–8 for this definition.

11. Select the first definition entry, Localhost: Sampeast: East in the Target 
Cube list.

12. Repeat steps 4–8 for this definition.

13. Select Partition > Close to return to the Application Desktop window.

Now you have changed the server name in the Samppart Company.DDB file. 

Continue with the following steps to change the server name in the Sampeast 
East.DDB file.

1. In the Application Desktop window, select the Sampeast application and East 
database.

Figure 52: Selecting Sampeast Application and East Database 

2. Select Database > Partition Manager. After a brief pause, the Partition 
Manager dialog box is displayed.
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3. Select the first definition entry, Localhost: Samppart: Company in the 
Source Cube list.

Figure 53: Selecting Localhost: Samppart: Company

4. Click Edit.

The Dangling Remote Reference dialog box is displayed. Because you are 
not connected to a server named Localhost, Hyperion Essbase warns you 
before it allows you to edit the definition.

Figure 54: Dangling Remote Reference Dialog Box for Localhost: Samppart: 
Company

5. Click Advanced. The Fix Dangling Partition Reference dialog box 
is displayed.
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6. Click Correct the invalid partition reference in the Action group.

Figure 55: Replacing Server Name Localhost

7. In the Server text box in the Reconnect group, replace Localhost with your 
server name.

8. Click Apply. The Partition Manager dialog box is displayed.

9. Select the first definition entry, Localhost: Samppart: Company in the 
Target Cube list.

10. Repeat steps 4–8 for this definition.

11. Select the second definition entry, Localhost: Samppart: Company in the 
Target Cube list.

12. Repeat steps 4–8 for this definition.

13. Select Partition > Close to return to the Application Desktop window.

Now you have changed the server name in the Sampeast East.DDB file.
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Preparing the Samppart Company Database
Note: In some licensing instances, installation of the sample applications 

may be restricted to the main application (Sample) and its three 
databases (Basic, Interntl, and Xchgrate). In this case, you will not see 
the Samppart Company database. Please refer to your license 
agreement for details.

After setting up the environment for the Samppart and Sampeast databases, you 
need to load data into each database. This section shows you how to load the 
Samppart Company database.

➤ To load data into the Samppart Company database:  

1. Open Hyperion Essbase Application Manager.

2. Connect to the server in which Samppart is installed.

Note: You can log in as “partitionuser” or as a user with supervisor 
privilege.

3. Select Samppart from the Applications list box.

4. Select Company from the Databases list box.

5. Select Database > Load Data. 

The Data Load dialog box is displayed. 

6. Click the Find button above the Data files list box to locate a data file to load. 

The Open Server Data File Objects dialog box is displayed.

7. Ensure that List Objects of Type is Text files. 

8. Select the text file named CALCCOMP from the Objects list box.
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9. Click OK to close the dialog box. 

Hyperion Essbase updates the Data Load dialog box to display the data file 
you selected. See the example shown in Figure 56.

Figure 56: Data Load Dialog Box with CALCCOMP Data File Selected

10. Click OK to load the selected file. 

The data file is a large fully calculated data set. It should take about a minute 
to load, and then the Data Load Completed dialog box is displayed. 

11. Click Close.
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Preparing the Sampeast East Database
Note: In some licensing instances, installation of the sample applications 

may be restricted to the main application (Sample) and its three 
databases (Basic, Interntl, and Xchgrate). In this case, you will not see 
the Sampeast East database. Please refer to your license agreement 
for details.

After setting up the environment for the Samppart and Sampeast databases, you 
need to load data into each database. This section shows you how to load the 
Sampeast East database.

➤ To load data into the Sampeast East database:  

1. Open Hyperion Essbase Application Manager. 

2. Connect to the server in which the Sampeast application is installed.

You can log in as “partitionuser” or as a user with supervisor privilege.

3. Select Sampeast from the list box.

4. Select East from the list box.

5. Select Database > Load Data. The dialog box is displayed. 

6. Click the Find button above the list box to locate a data file to load. The dialog 
box is displayed.

7. Ensure that is Text files. 

8. Select the text file named CALCEAST from the list box.
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9. Click OK to close the dialog box. 

Hyperion Essbase updates the dialog box to display the data file you selected.

Figure 57: Data Load Dialog Box with CALCEAST Data File Selected

10. Click OK to load the selected file. 

The data file is a small fully calculated data set. It should take about a minute 
to load, and then the dialog box is displayed. 

11. Click Close.
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Chapter

6
Runtime Client Installation

This chapter tells you, the client user, how to install the Hyperion Essbase Runtime 
Client from a network drive. If you do not need a full client installation, for 
example, of the Hyperion Essbase Spreadsheet Add-in, the Runtime Client 
installation is provided so that you can install only the Hyperion Essbase files that 
are required to run applications made using the Hyperion Essbase Application 
Programming Interface. For example, a third-party Hyperion Essbase partner may 
write a specialized application that relies on the Hyperion Essbase API libraries; 
when you install the Runtime Client, all Hyperion Essbase library files are 
provided. Then you need to install the application files from the third-party 
vendor. 

● Install the Runtime Client to the Windows 95, Windows 98, Windows NT 4.0, 
or Windows 2000 client operating environments

● Manually update your client environment settings if you do not want the 
installation program to change your environment automatically

This chapter contains the following sections:

● “Before You Install” on page 144

● “About Installing the Runtime Client from a Network Drive” on page 145

● “Installing the Runtime Client from the Network to Your Client Hard Drive” 
on page 147

● “Setting up Your Computer to Use the Runtime Client on the Network Drive” 
on page 149

● “Manually Updating the Environment” on page 151
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Before You Install
Before you can install the Runtime Client from a network drive, a system 
administrator must install it to a network drive.  

The Runtime Client requires a Windows-based computer with the following:  

Also, you should know the following before installing the Runtime Client from 
a network drive:

● Your client operating environment: Windows 95, Windows 98, 
Windows NT 4.0, or Windows 2000

● The network protocol you use

● Where the Runtime Client software resides on the network

Table 14: Runtime Client Windows System Requirements

Component Requirement

Microprocessor Pentium or higher

Windows Version Windows 95, Windows 98, Windows NT 4.0, 
or Windows 2000

RAM 32 MB

Disk Space 9 MB

Network Protocol TCP/IP or Named Pipes
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About Installing the Runtime Client 
from a Network Drive 

When installing from a network drive, the Runtime Client installation program 
provides the following options:   

Figure 58: Runtime Client Installation Options 

● Install to client installs the Runtime Client software on your hard drive. See 
“Installing the Runtime Client from the Network to Your Client Hard Drive” 
on page 147.

● Set up client to use shared executables sets up your computer’s operating 
environment to use the Runtime Client previously installed on a network drive 
by the system administrator. You install only Windows system files on your  
hard drive. See “Setting up Your Computer to Use the Runtime Client on the 
Network Drive” on page 149.   

Network Protocol Files for the Runtime Client
The network protocol file implements the TCP/IP or Named Pipes protocol you 
selected on installing the Runtime Client (or other client software) on your 
computer’s hard drive, or that the system administrator selected on installing the 
Runtime Client (or other client software) to a network drive. The network protocol 
file is called ESSNET.DLL, and it resides in the BIN directory with the Runtime 
Client software. This can be on your computer’s hard drive or on a network drive, 
depending on which installation option you chose.     

Note: For more information on network protocols, see Chapter 9, “Network 
Configuration Notes.”
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Directories and Files on the Network Drive
When the Hyperion Essbase system administrator installs the Runtime Client to a 
network drive, the installation program, SETUP.EXE, installs the following on the 
network drive:  

● An installation folder for installing the Runtime Client on your client 
computer’s hard drive. This contains the Hyperion Essbase installation 
program (SETUP.EXE) and Windows system files for setting up your 
computer’s environment.

● Program files for using the Runtime Client from the network drive.

If the system administrator installs the Runtime Client to the network drive N, and 
accepts the default directory \HYPERION\ESSBASE, the installation program 
creates the following directories:   

N:\HYPERION\ESSBASE
      BIN
      LOCALE
      RUNTIME

The installation program, SETUP.EXE, is in the RUNTIME directory.

The program files for the Runtime Client are in the BIN directory. 

The LOCALE directory contains the character-set files necessary for all the 
languages Hyperion Essbase supports, including English. 
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Installing the Runtime Client from the 
Network to Your Client Hard Drive

➤ To install the Runtime Client from the network to your client computer’s hard 
drive, complete the following steps:   

1. Using Windows Explorer, browse to the appropriate location for SETUP, 
where N:\HYPERION\ESSBASE is the name of the network drive and 
directory where the Hyperion Essbase system administrator installed the 
Runtime Client. For example,

N:\ESSBASE\RUNTIME\SETUP.EXE

2. Double-click SETUP to start the installation program.

3. Follow the directions on your screen.

4. When the program prompts you to Choose installation type, select Install to 
client and click Next.

5. When the program prompts you to Choose Destination Location, specify the 
directory where you want to install the Runtime Client.

The default is C:\HYPERION\ESSBASE. Click Browse to specify a different 
location.

Install all client software in the same directory. See “About Installing the 
Runtime Client from a Network Drive” on page 145 for more information.

6. When prompted, choose a network protocol. See your Hyperion Essbase 
System Administrator if you are not sure which option to choose.    

Figure 59: Choosing a TCP/IP Network 
Protocol for the Runtime Client
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7. In the Update Environment dialog box, choose whether you want the 
installation program to update the environment by creating an ARBORPATH 
environment variable, and adding ARBORPATH\Bin to the PATH environment 
variable.This enables the system to find Hyperion Essbase files.

8. When prompted to Check Setup Information, review the summary of your 
installation choices. Select Next to allow the installation program to begin 
copying files. Select Back to revise your choices, or select Cancel to exit the 
installation program.

9. In the Setup Complete dialog box, leave the check box selected and select 
Finish to view the Readme file.

10. If you chose to let the installation program update the PATH and ARBORPATH 
environment variables, do one of the following:

● On Windows NT or Windows 2000, log out and log in again, or reboot 
your computer, to allow the environment changes to take effect.

● On Windows 95 or Windows 98, reboot your computer to allow the 
environment changes take effect.

Directories Created When You Install the Runtime 
Client on a Client Hard Drive

When you install the Runtime Client on your client hard drive, the installation 
program, SETUP.EXE, creates the following directories:

HYPERION\ESSBASE
      BIN
      LOCALE

The Runtime Client program files are in the BIN directory. 

The LOCALE directory contains the character-set files necessary for all the 
languages Hyperion Essbase supports, including English. 
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Setting up Your Computer to Use the 
Runtime Client on the Network Drive

➤ To set up your computer to use the Runtime Client from the network drive, 
complete the following steps.     

1. Using Windows Explorer, browse to the appropriate location for SETUP, 
where N:\HYPERION\ESSBASE is the name of the network drive and 
directory where the Hyperion Essbase system administrator installed the 
Runtime Client. For example,

N:\ESSBASE\RUNTIME\SETUP.EXE   

2. Double-click SETUP to start the installation program.

3. Follow the directions on your screen.

4. When the program prompts you to Choose installation type, select Set up 
client to use shared executables and click Next.

Figure 60: Choosing to Set Up Your Computer to 
Use the Runtime Client from the Network Drive

The program detects where the network installation of the Runtime Client 
resides. If it cannot find it, you are prompted for the directory. Click Browse 
to display and specify the location.

Note: The Hyperion Essbase shared runtime files are in the BIN 
directory.

In the Check Setup Information dialog box, review the summary of your 
installation choices. 

Click Back to revise your choices, Cancel to exit the installation program, or 
Next to let the installation program begin updating your environment. 

This type of installation automatically creates or updates the ARBORPATH 
environment variable, and adds a statement to the PATH environment variable. 
This update is needed to enable the system to find shared Hyperion Essbase 
files.
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5. Choose one of the following steps to allow the environment changes to take 
effect:

● On Windows NT or Windows 2000, log out and log in again, or reboot 
your computer.

● On Windows 95 or Windows 98, reboot your computer.

You might not need to reboot if you previously installed client software to the 
same directory where you are installing the Runtime Client.

Directories Used When You Set Up Your Computer to 
Use the Runtime Client on the Network Drive

When you set up your computer to use the Runtime Client on the network drive, 
the installation program, SETUP.EXE, does not create any directories on your 
client computer’s hard drive. It installs only Windows system files on your client 
computer’s hard drive. You use the program files that are on the network drive.     

The network drive has the following directories:

ESSBASE
       BIN
       LOCALE

The Runtime Client program files are in the BIN directory.

The LOCALE directory contains the character-set files necessary for all the 
languages Hyperion Essbase supports, including English. 
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Manually Updating the Environment 
If you do not want the installation program to update your computer’s 
environment, you may need to set up the environment manually.  

Keep these points in mind as you apply the following steps to manually update 
your environment settings: 

● The following instructions assume that you installed the Runtime Client to 
C:\HYPERION\ESSBASE. If you installed the Runtime Client to a different 
drive and directory, substitute the letter of that drive and name of that 
directory.

● If you set up your computer to use the Runtime Client from a network drive, 
substitute C:\HYPERION\ESSBASE with the letter of the drive and name of 
the directory where the Runtime Client is installed on the network. 

Manually Updating the Environment on 
Windows 95 and Windows 98

➤ To update your environment settings on Windows 95 and Windows 98:     

1. Add the following environment variable to your AUTOEXEC.BAT file:

ARBORPATH=C:\HYPERION\ESSBASE

Do not put a space before or after the equal sign (=) in the $ARBORPATH 
environment setting.

2. Add C:\HYPERION\ESSBASE\BIN to your PATH statement.

3. Remove references to installations of Hyperion Essbase in other directories.

Tip: You can type SET from a DOS command prompt to view your 
current environment settings. 

4. Reboot your computer.
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Manually Updating the Environment on 
Windows NT and Windows 2000

To manually update the environment settings on Windows NT 4.0 or 
Windows 2000, complete the following steps:

1. Select Start > Settings > Control Panel > System.

2. Find the Windows environment variable controls.

● On Windows NT, choose the Environment tab.

● On Windows 2000, choose the Advanced tab, and click the 
Environment Variables button.

3. Set the following system variables:

● ARBORPATH=C:\HYPERION\ESSBASE, or wherever Hyperion Essbase 
is installed.

● Add %ARBORPATH%/BIN to the Path variable, or 
C:\HYPERION\ESSBASE\BIN, depending on where Hyperion Essbase is 
installed.

Note: You are changing System settings, which affect all users who 
access your machine.

4. Remove outdated ARBORPATH system variables or ESSBASE\BIN 
Path settings.

5. Reboot your computer, or log out and log in, to allow the changes to 
take effect.
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Chapter

7
API Installation

The Hyperion Essbase Application Programming Interface (API) is available for 
the following platforms: 

● Windows NT, Windows 95, Windows 98, and Windows 2000

● AIX

● HP-UX

● Solaris

● Linux

Note: Linux is not supported on Release 6.1 of Hyperion Essbase.

This chapter contains the following sections:

● “API System Requirements” on page 154

● “Installing the API” on page 156

● “Directories Created” on page 160

● “Updating Your Environment Variables” on page 161

Note: You must enter your license number during installation. See 
Chapter 1, “Product Components and Software Registration” on 
software registration.
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API System Requirements
The API requires a system that meets minimal hardware and software 
requirements. See the following section that is appropriate for your platform.

Windows API Requirements
The Hyperion Essbase API requires a system with at least the following:     

AIX API Requirements
The API for AIX requires a system with at least the following:     

Table 15: Windows API System Requirements

Component Requirement

Microprocessor Pentium or higher

Windows platform Windows NT 4.0, Windows 2000, Windows 95, and 
Windows 98

RAM 64 MB RAM (128 or more MB recommended).

Disk space 15 MB

Table 16: AIX API System Requirements

Component Requirement

System PowerPC, including RS 6000

AIX AIX 4.3 or higher

RAM Physical memory: 64 MB (256 MB recommended)

Swap space: 2x physical memory, when physical 
memory is less than .5GB. Contact system administrator 
or hardware vendor for optimum swap configuration.

Disk space 7 MB

Thread type POSIX Kernel Threads (included with AIX)
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HP-UX API Requirements
The API for HP-UX requires a system with at least the following:     

Solaris API Requirements
The API for Solaris requires a system with at least the following:       

Table 17: HP-UX API System Requirements 

Component Requirement

System PA-RISC machines

HP-UX HP-UX 11.0

RAM Physical memory: 64 MB (256 MB recommended)

Swap space: 2x physical memory, when physical 
memory is less than .5GB. Contact system administrator 
or hardware vendor for optimum swap configuration.

Disk space 9 MB

Thread type POSIX Kernel Threads (included with HP-UX)

Table 18: Solaris API System Requirements

Component Requirement

System Sun SPARC or ULTRASPARC machines

Solaris Solaris 7 or 8

RAM Physical memory: 64 MB (256 MB recommended)

Swap space: 2x physical memory, when physical 
memory is less than .5GB. Contact system administrator 
or hardware vendor for optimum swap configuration.

Disk space 8 MB

Thread type POSIX Kernel Threads (included with Solaris)
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Red Hat Linux API Requirements
The API for Red Hat Linux requires a system with at least the following:      

Installing the API
On each supported platform, install the API from the CD-ROM. See the following 
section that is appropriate for your platform.

Installing the API on Windows Platforms

➤ To install the API on Windows 95, Windows 98, Windows NT 4.0, or Windows 
2000, complete the following steps:

1. Insert the CD-ROM into your CD-ROM drive.

The installation program should start automatically. If it does not, run SETUP 
from the root directory of the CD-ROM.       

2. Follow the prompts, and provide the information requested.

To cancel installation at any time, click the Cancel and Exit Setup buttons.

3. In the Select Components dialog box, select the API products check box. 
This will install the API for 32-bit Windows platforms.

4. When you finish, select Continue and Next.

Table 19: Red Hat Linux API System Requirements

Component Requirement

System Intel compatible machines

Linux Red Hat Linux 6.1 

RAM Physical memory: 64 MB (256 MB recommended)

Swap space: 2x physical memory, when physical 
memory is less than .5 GB. Contact system 
administrator or hardware vendor for optimum 
swap configuration.

Disk space 7 MB

Thread type Linux POSIX Threads (included with Linux)
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5. When prompted for the destination directory name, specify where you want to 
install the API. The default is C:\HYPERION\ESSBASE. You can install to a 
network drive and then share the library files with other programmers.

6. In the Choose Network Protocol dialog box, select your network protocol, 
and select Next. 

Hyperion Essbase creates an ESSNET file that corresponds to your network 
protocol. 

7. In the Install HTML Documentation dialog box, review the size 
requirements for the available online documents, select which ones to install, 
and select Next.   

Note: Instead of installing the HTML documentation locally, you can 
copy the DOCS directory from the root directory of the CD-ROM 
to a network drive, so that all programmers can access the online 
HTML documentation from there. Or, you can access the HTML 
documentation in the DOCS directory of the CD-ROM itself. To 
view the HTML documentation, open the INDEX.HTM file in the 
DOCS directory. To learn more about HTML documentation, see 
“Hyperion Essbase HTML Documents” on page xvi in the 
Introduction.

8. In the Check Setup Information dialog box, review the summary of your 
installation choices. Select Back to revise your choices, Cancel to exit the 
installation program, or Next to let the installation program begin copying 
files.

9. In the Setup Complete dialog box, leave the check box selected and select 
Finish to view the Readme file.

Installing the API on UNIX
You must complete certain tasks before you can install the API on UNIX. These 
tasks are described in “Before You Install the API on UNIX” on page 158.  

You can install either from the root directory or from a product directory of the 
CD-ROM. See “Installing the API on UNIX from the CD-ROM” on page 158.
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Before You Install the API on UNIX
Before you install the API on any UNIX platform, do the following: 

1. Create an account which has Read/Write/Execute access to the target 
directory for the Hyperion Essbase installation. This account should belong 
to the Hyperion Essbase system administrator. Give this account the same 
default directory you are using for Hyperion Essbase (for example, 
/home/hyperion/essbase). Ideally, the system administrator account 
will own this target directory.

Note: With Release 6.0, you are no longer required to install and run 
Hyperion Essbase from an account called arbor. Any user can 
install, but this should be the same user account that will start 
Hyperion Essbase.

2. Create a target directory for the Hyperion Essbase files; for example,   

/home/hyperion/essbase

If you do not create a target directory, the installation program prompts 
you for permission to create it. If you want to use, or fall back to, a previous 
version of Hyperion Essbase, install Release 6.0 to a different directory 
than the previous version. Do not create directories under/essbase. The 
installation program creates the appropriate subdirectories.

3. Apply the latest patches for your operating system.

Installing the API on UNIX from the CD-ROM

➤ To install the API on UNIX from either the root directory or a product directory 
of the CD-ROM, do the following:     

1. Log in to the UNIX server as the Hyperion Essbase system 
administrator account. For example, log in as admin if you created a 
user account called admin that owns the target installation directory 
/home/hyperion/essbase.

2. Insert the CD-ROM into your CD-ROM drive. 
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3. Depending on the directory from which you want to install, do one of the 
following:

If you want to install from the root directory (recommended), do the 
following:

a. Change to the root directory of the CD-ROM (for example, 
cd /cdrom/essbase_6).

b. Use the ls command to find setup.sh (or SETUP.SH). 

Some UNIX CD-ROM drivers list file names in uppercase. Others list 
them in lowercase. See whether the file name is in uppercase or 
lowercase.  

c. Type./setup.sh or./SETUP.SH, depending on what you learned 
in step b.

d. When prompted, choose to install the API.

If you want to install from the product directory, do the following:

a. Change to the CD-ROM directory for the product you want to install 
(for example, cd /solaris/api).

b. Use the ls command to find essinst (or ESSINST). 

Some UNIX CD-ROM drivers list file names in uppercase. Others list 
them in lowercase. See whether the file name is in uppercase or 
lowercase.

c. Type./essinst or./ESSINST, depending on what you learned in 
step b.

4. Follow the prompts and provide the information requested.

Note: To cancel installation at any time, press Ctrl + C.  

5. When prompted, enter your license number exactly as it appears on your 
registration card.

See Chapter 1, “Product Components and Software Registration” for more 
information on software registration.
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6. When prompted, type the directory where you want to install the API.

The installation program uses/home/hyperion/essbase/ as the default 
directory. You can choose another directory, and if it does not exist, the 
installation program attempts to create it for you.

7. Answer whether you want to install the online HTML documentation.

Note: The installation program decompresses the api.tz file, and 
the docs.tz file if you choose to install the online HTML 
documentation, and copies files to the directory you choose (or 
to the default directory), and to subdirectories it creates under 
that directory. Do not create these subdirectories yourself.  

8. Update your environment before you use the API. See “Updating Your 
Environment Variables” on page 161.

Directories Created
The API installation program creates the following directory structure:  

This assumes you accepted the default directory, C:\HYPERION\ESSBASE or 
/home/hyperion/essbase, during installation.

Note: When you install the online HTML documentation, the installation 
program creates a DOCS directory (/docs directory on UNIX 
platforms). It contains numerous subdirectories, as well as the 
INDEX.HTM (or index.htm) file you open to view the HTML 
documentation. To learn more about HTML documentation, see 
“Hyperion Essbase HTML Documents” on page xvi in the 
Introduction.

Windows and Windows NT UNIX

C:\HYPERION\ESSBASE
     API
            INCLUDE
            LIB
            REDIST
                    LOCALE
     DOCS

/home/hyperion/essbase
      api
               include
               lib
               redist
               locale
      docs
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For a listing of files supplied with or required by the Hyperion Essbase API in 
order to compile programs, see the online API Reference in the DOCS directory. 
On Solaris and Linux, you can create soft links to supplied library files.

The LOCALE directory (locale on UNIX) contains the character-set files 
necessary for all the languages that Hyperion Essbase supports, including English. 
For non-English versions, you also need to create the ESSLANG environment 
variable. For more information about ESSLANG, see Chapter 10, “Advanced 
Installation Topics,” 

Updating Your Environment Variables
You may need to update your environment variables to use the API. Read the 
following section that is appropriate for your platform. 

Setting Your Environment on Windows Platforms
Add the LIB and INCLUDE directories to your PATH statement. For example, if you 
installed Hyperion Essbase to the default directory, add the following to your 
PATH statement:   

C:\HYPERION\ESSBASE\API\LIB    
C:\HYPERION\ESSBASE\API\INCLUDE

Setting Your Environment on AIX and Solaris
To link and run your program, add the following to the LIBPATH variable: 

$ARBORPATH/api/lib   

For example, if you are using the C shell, the.cshrc file might look like this:

setenv ARBORPATH /essbase
setenv                                                                                                                                                                                                                                                                                                                                                                                                                                                                                      
    /opt/SUNWspro/lib:/usr/openwin/lib:/usr/lib:$ARBORPATH/api/lib

On Solaris, you can create soft links to supplied library files. For example, you can  
create .so files as soft links to the supplied .so.1 files, as follows: 

ln -s libessnet.so.1 libessnet.so

See the online API Reference in the DOCS directory for more information on the 
files you need to compile, link, and distribute your programs. 
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Setting Your Environment on HP-UX
Hyperion Essbase on HP-UX uses the environment variables LPATH (for linking) 
and SHLIB_PATH (at run time).   

If you are using static libraries, you do not need to use environment variables. If 
you are using dynamic libraries, you need to add the following path to your LPATH 
search path environment variable to link your program: 

/home/hyperion/essbase/api/lib

where /home is the name of your home directory and /hyperion/essbase is the 
directory where you chose to install the API.

All shared library (.sl) files should be located in a directory specified in the 
LPATH search path. For example, the LPATH variable can be set to:

.:/lib:/usr/lib:$ARBORPATH/api/lib

You must do one of the following to run your program:

● Store the shared library files in the same directory from which you linked.

● Link your program with the +s flag. The +s flag allows you to put the.sl files 
at any location and use the SHLIB_PATH environment variable to search for it 
at run time.

See the online API Reference in the DOCS directory for information on the files you 
need to compile, link, and distribute your programs.

Setting Your Environment on Red Hat Linux
To link and run your program, add the following to the LD_LIBRARY_PATH 
variable:

$ARBORPATH/api/lib   

For example, if you are using the C shell, the.cshrc file might look like this:

setenv ARBORPATH "/home/hyperion/essbase"
setenv LD_LIBRARY_PATH 
"$LD_LIBRARY_PATH:/usr/lib:$ARBORPATH/api/lib"

See the online API Reference in the DOCS directory for more information on the 
files you need to compile, link, and distribute your programs.
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Chapter

8
SQL Interface Installation

This chapter tells you, the Hyperion Essbase system administrator, how to install 
Hyperion Essbase SQL Interface from CD-ROM. It tells you what to do before you 
install SQL Interface and how to set environment variables after you install it. 

For installations on UNIX, this chapter also tells you what to do after you install 
and before you link your drivers to SQL Interface.

After you install SQL Interface, and set your environment variables, you must 
configure your data source. You may need to configure your ODBC driver. 
For this information, see the Hyperion Essbase SQL Interface Guide. This guide, 
Essqlint.pdf, is provided in the\ESSBASE\DOCS\CLIENT directory in.PDF 
format for online viewing and printing in Adobe Acrobat Reader (Version 3.0.1 
or later). 

Note: Adobe Acrobat Reader is provided on the Hyperion Essbase 
CD-ROM in the ADOBE directory under the appropriate platform and 
language-version subdirectories. You can also download Acrobat 
Reader from http://www.adobe.com. To install Acrobat Reader, 
launch the executable file, follow the prompts, and provide the 
information requested.

This chapter contains the following sections:

● “Before You Install SQL Interface” on page 164

● “Installing SQL Interface on Windows NT and Windows 2000” on page 164

● “Installing SQL Interface on UNIX” on page 166

http://www.adobe.com
http://www.adobe.com
http://www.adobe.com
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Before You Install SQL Interface
Before you install SQL Interface, consider the following information: 

● On Windows NT and Windows 2000, you can install SQL Interface when you 
install the Hyperion Essbase server or you can install it separately. On UNIX, 
you must install SQL Interface after you install the Hyperion Essbase server. 
On every installation, you are asked for your license number. For more 
information on software registration, see Chapter 1, “Product Components 
and Software Registration.”

● On all platforms, it is recommended that you install your server, update your 
environment, and verify that it is working before you install SQL Interface.

● If you are using Hyperion Essbase 6.1, you must install Release 6.1 of SQL 
Interface. Earlier releases of SQL Interface are not tested and verified to work 
with Release 6 of the Hyperion Essbase server. 

● On Windows NT and Windows 2000, each MERANT ODBC driver has its 
own help file. You can access it using the ODBC Administrator. See the 
Hyperion Essbase SQL Interface Guide.

● The MERANT ODBC drivers come with a document called MERANT 
DataDirect Connect ODBC Reference. This reference is in PDF format for 
online viewing and printing in Adobe Acrobat Reader (Version 3.0.1 or later).

Installing SQL Interface on Windows NT 
and Windows 2000

You can install Hyperion Essbase SQL Interface on Windows NT and Windows 
2000 from the Hyperion Essbase CD-ROM, either at the same time you install the 
Hyperion Essbase OLAP Server, or after you have installed the Hyperion Essbase  
OLAP Server.  

The following workflow is an overview of tasks required to effectively install 
Hyperion Essbase SQL Interface on Windows NT and Windows 2000.
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Workflow for Installing SQL Interface on 
Windows NT or Windows 2000

1. Make sure the RDBMS (relational database management system) 
environment is set up correctly before installing Hyperion Essbase SQL 
Interface. You must be able to connect to the RDBMS from the Hyperion 
Essbase server machine before SQL Interface can work. Make sure of the 
following:

a. The RDBMS server is installed and running. You must set the 
environment variables required to run the RDBMS. For more 
information, see your RDBMS documentation.

b. The RDBMS database client software is installed on the machine where 
Hyperion Essbase is (or will be) installed; for example, the correct version 
of Client Application Enabler (CAE) for DB2 is installed, or the correct 
version of Open Client for Sybase is installed.

c. You can connect to the RDBMS.

d. You can issue a query to the RDBMS using an RDBMS client utility.

2. See the Hyperion Essbase Start Here booklet for information on tested and 
supported SQL Interface platforms and ODBC drivers.

3. Install the Hyperion Essbase OLAP Server first, or install it together with SQL 
Interface. Do not attempt to install SQL Interface before installing the 
Hyperion Essbase OLAP Server. For detailed instructions on installing the 
server software (including SQL Interface) from CD-ROM, see Chapter 2, 
“Windows Server Installation.”

4. Install Hyperion Essbase SQL Interface from the CD-ROM, if you did not 
install it with the Hyperion Essbase OLAP Server. For step-by-step 
instructions on installing SQL Interface from the CD-ROM, see Chapter 2, 
“Windows Server Installation.”  

5. Configure the ODBC data source. Before you can access relational data using 
Hyperion Essbase SQL Interface, you must use the ODBC Administrator 
(ODBCAD32.EXE) to tell Hyperion Essbase what data sources are available 
and which drivers it should use. For detailed instructions, see the Hyperion 
Essbase SQL Interface Guide (ESSQLINT.PDF), which is installed in the 
ESSBASE\DOCS\CLIENT directory when you install SQL Interface.
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Directories and Files on Windows NT and Windows 2000
If you accept the default during installation, the installation program places 
all SQL Interface program files in the C:\HYPERION\ESSBASE\BIN directory on 
your Windows NT or Windows 2000 server. This includes ESSSQL.DLL, the 
ODBC driver files and their corresponding help (.HLP) files, and .BND and .LIC 
files. If you choose to install SQL Interface in a different directory from the 
default, the installation program stores the files in the BIN directory in the 
appropriate path.      

The SQL Interface installation program also installs the Hyperion Essbase SQL 
Interface Guide in .PDF format in the DOCS\CLIENT directory, and installs ODBC 
driver files and their corresponding help and .PDF files in the ODBCDocs directory.   

Installing SQL Interface on UNIX
Install Hyperion Essbase SQL Interface on UNIX (AIX, HP-UX, and Solaris) 
from the Hyperion Essbase CD-ROM after you have installed the Hyperion 
Essbase OLAP Server. Before installing SQL Interface, ensure that your RDBMS  
environment is set correctly. After installing SQL Interface, set up the 
environment and the ODBC drivers.

Note: The following workflow is an overview of tasks required to 
effectively install Hyperion Essbase SQL Interface on UNIX..

Workflow for Installing SQL Interface on UNIX
1. Make sure the RDBMS (relational database management system) 

environment is set up correctly before installing Hyperion Essbase SQL 
Interface. See “Setting Up RDBMS Before Installing SQL Interface 
on UNIX” on page 167. 

2. Install the Hyperion Essbase OLAP Server. See Chapter 3, “UNIX Server 
Installation.”

3. Install SQL Interface from the CD ROM. See “Installing SQL Interface on 
UNIX from the CD-ROM” on page 169.

4. Set up the ODBC driver you plan to use. Steps vary depending on 
platform/driver configurations. For examples, see “Setting Up ODBC Drivers 
Before Linking Them to SQL Interface” on page 172.

5. Run inst-sql.sh to link SQL Interface to your ODBC driver.
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6. Complete post-installation tasks, including setting the library path and 
configuring the .odbc.ini file. See “After You Link SQL Interface to 
Your ODBC Driver on UNIX” on page 176.

7. Consult the Hyperion Essbase SQL Interface Guide in your DOCS/CLIENT 
directory to learn more about SQL Interface, and how to configure your 
ODBC data source. See “Configuring the Data Source and ODBC Driver” on 
page 181.

Setting Up RDBMS Before Installing SQL Interface 
on UNIX

You must be able to connect to the RDBMS from the Hyperion Essbase server 
machine before SQL Interface can work. Make sure of the following:

1. The RDBMS server is installed and running. You must set the environment 
variables required to connect to the RDBMS.

Examples of Setting RDBMS Environment Variables (Solaris):

for Oracle: 

● Set ORACLE_HOME and ORACLE_SID. 

● Make sure that LD_LIBRARY_PATH contains the Oracle library path 
($ORACLE_HOME/lib). 

● Make sure that the path contains the Oracle bin; for example, 
($ORACLE_HOME/bin).

for Informix: 

● Set INFORMIXDIR and INFORMIXSERVER.

● Make sure that LD_LIBRARY_PATH contains the Informix library path 
($INFORMIXDIR/lib).

● Make sure that the path contains the Informix bin.
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for Sybase: 

● Set SYBASE and DSQUERY.

● Make sure that LD_LIBRARY_PATH contains the Sybase library path 
($SYBASE/lib).

● Make sure that the path contains the Sybase bin ($SYBASE/bin).

for DB2: 

● Set DB2INSTANCE and INSTHOME.

● Make sure that LD_LIBRARY_PATH contains the DB2 library path 
($INSTHOME/sqllib/lib).

● Make sure that the path contains the DB2 bin 
($INSTHOME/sqllib/bin).

Note: Library path variable names vary across UNIX platforms. 
For more information, see your RDBMS documentation.

2. The RDBMS client software is installed on the machine where the Hyperion 
Essbase OLAP Server is (or will be) running.

3. You can connect to the RDBMS.

4. You can issue a query to the RDBMS using an RDBMS client utility.

See the Hyperion Essbase Start Here booklet for information on tested and 
supported SQL Interface platforms and ODBC drivers.

Also, set the environment variables required to run your RDBMS.



SQL Interface Installation

8

■ 169Hyperion Essbase Installation Guide

Installing SQL Interface on UNIX from the CD-ROM
You have already:

● Installed RDBMS server and client software, and verified that they are 
working.

● Installed Hyperion Essbase OLAP Server from the CD-ROM.

You are now ready to install SQL Interface from the CD-ROM.

➤ To install Hyperion Essbase SQL Interface from either the top directory or a 
product directory of the CD-ROM, do the following:

1. Log in as the Hyperion Essbase system administrator account. For example, 
log in as admin if you created a user account called admin that owns the target 
installation directory/home/hyperion/essbase.

2. Insert the CD-ROM into your CD-ROM drive.

3. Change to the root directory of the CD-ROM (for example, cd /cdrom).

4. Use the ls command to find setup.sh (or SETUP.SH).

Some UNIX CD-ROM drivers list file names in uppercase. Others list them in 
lowercase. See whether setup.sh is in uppercase or lowercase.

5. Enter./setup.sh or./SETUP.SH, depending on what you learned in step 4. 

6. When prompted for which product to install, choose SQL Interface. Follow 
the prompts and provide the information requested.

Note: To cancel installation at any time, press Ctrl + C.

7. When prompted, enter your license number exactly as it appears on your 
registration card.

See Chapter 1, “Product Components and Software Registration” for more 
information on software registration.
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8. If prompted, type the directory where you want to install SQL Interface. 
Install it in the same directory where you installed Hyperion Essbase.

9. Read the next section to learn about directories and files created by setup. 
Then, you will be ready to set up your environment. This includes setting up 
the ODBC driver, running inst-sql.sh to link SQL Interface to the ODBC 
driver, setting the library path for Hyperion Essbase, and editing the 
.odbc.ini file.

Directories and Files Created
The SQL Interface installation program installs files into the $ARBORPATH/bin 
and $ARBORPATH/dlls directories.

If you accept the default during installation, the SQL Interface installation 
program: 

● Copies the.odbc.ini file into the $ARBORPATH/bin directory on your 
UNIX server machine. This lets Hyperion Essbase know which drivers are 
installed. 

If you accepted the default directory during installation, $ARBORPATH is 
/home/hyperion/essbase.

● Installs  MERANT ODBC drivers files to an  $ARBORPATH/dlls directory 
on your UNIX server machine.    

● Installs Hyperion Essbase SQL Interface files  to the $ARBORPATH/bin 
directory. These include:

– libesssql.insolv.a on AIX

– libesssql.insolv.sl on HP-UX

– libesssql.so.1 on Solaris
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When the installation program installs the Hyperion Essbase server on UNIX, it 
installs:

● The SQL Interface library file:

– libesssql.a on AIX

– libesssql.sl on HP-UX

– libesssql.so on Solaris

● A stub ODBC drivers file:

– libesssql.arbor.a on AIX

– libesssql.arbor.sl on HP-UX

– libesssql.arbor.so.1 on Solaris

After you install the Hyperion Essbase server, the SQL Interface library file 
symbolically links to the stub ODBC drivers file. After you install SQL Interface 
and run the shell script, inst-sql.sh, the script links the library file to the 
MERANT ODBC drivers file. See “Linking SQL Interface to the ODBC Driver on 
UNIX” on page 174.

About Setting Your Environment on UNIX 
On UNIX, you run essinst, or setup.sh (which runs essinst), to install SQL 
Interface. Then, you run inst-sql.sh to symbolically link the SQL Interface 
library file to your MERANT ODBC drivers file. Before and after you run 
inst-sql.sh, you must set the proper environment for your ODBC driver.  

The following sections address setting your environment on UNIX:

● “Setting Up ODBC Drivers Before Linking Them to SQL Interface” on 
page 172

● “Linking SQL Interface to the ODBC Driver on UNIX” on page 174

● “After You Link SQL Interface to Your ODBC Driver on UNIX” on page 176
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Setting Up ODBC Drivers Before Linking Them to 
SQL Interface

After you install SQL Interface on AIX, HP-UX, or Solaris, you must set up your 
ODBC driver before you link SQL Interface to your ODBC driver by running 
inst-sql.sh. 

To set your environment so you can link SQL Interface to the driver you chose, 
complete the steps after you run setup.sh, but before you run inst-sql.sh. 
The steps you take depend on the driver and platform you use. Examples for the 
following configurations are provided in this section:       

● “Setting Up the MERANT DB2 Driver on AIX or Solaris” on page 172

● “Setting Up the IBM DB2 Driver on AIX” on page 173

For information about setting up MERANT Oracle or Informix drivers, see the 
MERANT DataDirect Connect ODBC Reference. Also see Oracle or Informix 
documentation.

Setting Up the MERANT DB2 Driver on AIX 
or Solaris
To set the environment so you can link SQL Interface to the MERANT DB2 
driver, complete the following steps after you run setup.sh, but before you run 
inst-sql.sh:             

1. Log in as the instance owner, and make sure you have Read or Read/Write 
access to $ARBORPATH.

2. Set the DB2 environment variable, for example, INSTHOME, to point to the 
home directory of your DB2 instance. An instance corresponds to one or more 
databases. For every database you want to connect to, you must ensure that an 
instance corresponding to that database exists.
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3. Set the environment variable DB2INSTANCE to point to the instance name, and 
set LIBPATH.  

Here is a Bourne shell example: 

DB2INSTANCE=inst1
LIBPATH=/lib:/usr/lib:/home/essbase/bin:$INSTHOME/sqllib/lib:
export INSTHOME DB2INSTANCE LIBPATH

where INSTHOME is the environment variable that you defined in step 2, and 
“inst1” is the instance name.

For more information about setting environment variables for the MERANT DB2 
driver, see the MERANT DataDirect Connect ODBC Reference. Also see DB2 
documentation.

Setting Up the IBM DB2 Driver on AIX
To set your environment so you can link SQL Interface to the IBM DB2 driver, 
complete the following steps after you run setup.sh, but before you run 
inst-sql.sh:   

1. Make sure you have the relational client software for DB2 installed on the 
same AIX machine that you are using for SQL Interface.

2. Create a configuration file, esssql.cfg, as described in the Hyperion 
Essbase SQL Interface Guide.

Here is an example of an esssql.cfg file: 

[ 
Description "IBM DB2 Call Level Interface" 
DriverName db2.o 
Database 1 
Password 1 
UserId 1 
SingleConnection 0 
UpperCaseConnection 0 
IsQEDriver 0 
] 

3. Set the environment variable INSTHOME to point to the home directory of your 
DB2 instance.
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4. Define DB2 instance names for SQL Interface. An instance corresponds to 
one or more databases. For every database you want to connect to:    

a. You must ensure that an instance corresponding to that database exists.

b. You must have Read or Read/Write access to the driver manager library, 
libodbc.a in INSTHOME/sqllib/odbclib/lib.

c. You must include the instance in the LIBPATH as shown in step 6.

5. Log in as the Hyperion Essbase system administrator account. This is the 
account used to install and run Hyperion Essbase. You should have Read 
or Read/Write access to the driver manager library, libodbc.a, in 
INSTHOME/sqllib/odbclib/lib.

6. Set the environment variables DB2INSTANCE and LIBPATH as in the 
following Bourne shell example:       

DB2INSTANCE=inst1
LIBPATH=/lib:/usr/lib:/home/essbase/bin:$INSTHOME/sqllib/lib:
export INSTHOME DB2INSTANCE LIBPATH 

where INSTHOME is the environment variable that you defined in step 3, 
and “inst1” is the instance name.

For more information about setting environment variables for the IBM DB2 
driver, see IBM documentation.

Linking SQL Interface to the ODBC Driver on UNIX
You have done the following:

● Installed and configured your RDBMS. See “Setting Up RDBMS Before 
Installing SQL Interface on UNIX” on page 167.

● Installed SQL Interface. See “Installing SQL Interface on UNIX from the 
CD-ROM” on page 169.

● Set up the ODBC driver you selected during installation. See “Setting Up 
ODBC Drivers Before Linking Them to SQL Interface” on page 172.
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You are ready to link SQL Interface to your ODBC driver by running 
inst-sql.sh.  

essinst, or setup.sh (which runs essinst), places inst-sql.sh in the 
$ARBORPATH directory. The default is/home/hyperion/essbase. Running 
inst-sql.sh ensures that server processes can access the software necessary 
for SQL Interface.    

inst-sql.sh uses the odbc.ini, odbcinst.ini, and template (extension 
.tmpl) files in the $ARBORPATH/setup directory to create a set of files that 
point Hyperion Essbase to the correct driver product.

The script handles the following for you:

● Ensures root privileges are not accidentally granted to a user-level script.

● Checks for the availability of the Hyperion Essbase server.

● Checks for the availability to the Hyperion Essbase server of supported 
database systems.

● Provides default environment extensions as shell files in the 
$ARBORPATH/bin directory.

● Provides initialization files in the $ARBORPATH/bin directory for access by 
the driver software.

● Creates and dynamically compiles an extra library if needed.

● Generates the shell scripts odbc.csh for the C shell, and odbc.sh for the 
Bourne or Korn shell. These files contain commands that update the library 
path to specify the correct environment variables for Hyperion Essbase. After 
you run inst-sql.sh to link SQL Interface to the ODBC driver, you can 
optionally use these scripts to update your library path, or you can do it 
manually. See “Setting the Library Path on UNIX” on page 177.
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➤ To run inst-sql.sh, do the following:

1. Using the Hyperion Essbase system administrator account (this is the account 
used to install and run Hyperion Essbase), enter the following command:

sh inst-sql.sh

2. Supply information when the script prompts you for it.

When the script finishes, the command prompt appears.

3. Enter the following command:

exit

After You Link SQL Interface to Your ODBC 
Driver on UNIX

You have linked SQL Interface to your ODBC driver by running inst-sql.sh. 
See “Linking SQL Interface to the ODBC Driver on UNIX” on page 174. 

You are ready to complete the following post-installation tasks:

● Set the library path, either manually or by using the odbc.sh or odbc.csh 
shell scripts. See “Setting the Library Path on UNIX” on page 177.

● If you are using the MERANT DB2 driver, bind files in the /ESSBASE/bin 
directory. See “Binding Files for the MERANT DB2 driver on AIX or Solaris” 
on page 179,

● Complete the configuration of your ODBC drivers by editing the .odbc.ini 
file. Some examples are provided. See “Editing .odbc.ini Driver Files” on 
page 180.

● Configure the ODBC data source and (if applicable) configure your 
non-MERANT ODBC driver. See the Hyperion Essbase SQL Interface 
Guide, located in the DOCS/CLIENT directory.
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Setting the Library Path on UNIX
On UNIX, you must add the $ARBORPATH/dlls directory to the library path 
before you can use SQL Interface. If your installation of SQL Interface is an 
upgrade to a pre-existing installation, you may not have to re-set the library path.

Alternatively, you can use shell scripts created by inst-sql.sh to update your 
library path. See “Using Shell Scripts to Set the Library Path (Optional)” on 
page 178.

● On Solaris, add the $ARBORPATH/dlls directory to the LD_LIBRARY_PATH 
variable:

For example, if you are using the C shell, the.cshrc file might look like this:

setenv ARBORPATH /hyperion/essbase
setenv LD_LIBRARY_PATH /usr/lib:$ARBORPATH/dlls

● On AIX, add the $ARBORPATH/dlls directory to the LIBPATH variable:

For example, if you are using the C shell, the.cshrc file might look like this:

setenv ARBORPATH /hyperion/essbase
setenv LIBPATH /usr/lib:$ARBORPATH/dlls

● On HP-UX, add the $ARBORPATH/dlls directory to the SHLIB_PATH 
variable:

For example, if you are using the C shell, the.cshrc  file might look like this:

setenv ARBORPATH /hyperion/essbase
setenv SHLIB_PATH /usr/lib:$ARBORPATH/dlls

The.profile file, if you are using the Bourne or Korn shell, might look 
like this:

ARBORPATH=/home/hyperion/essbase
export ARBORPATH
SHLIB_PATH=$SHLIB_PATH:$ARBORPATH/dlls
export SHLIB_PATH
PATH=/usr/bin:/etc:/usr/sbin:/usr/ucb:$ARBORPATH/dlls:
     /usr/bin/X11:/sbin:.export PATH

Note: HP-UX uses SHLIB_PATH to search for shared library files 
at runtime, and LPATH to link to shared library files while 
compiling.

● For more information, see your UNIX documentation.
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Using Shell Scripts to Set the Library Path (Optional)

The script that links SQL Interface to your ODBC driver (inst-sql.sh) also 
creates shell scripts which you can use to automatically update the library path for 
Hyperion Essbase.  inst-sql.sh generates the following files and places them 
in the $ARBORPATH/setup directory: 

● odbc.csh for the C shell

● odbc.sh for the Bourne and Korn shell.

These files contain commands that specify the correct environment variables for 
Hyperion Essbase. $ARBORPATH/dlls is added to the library path, and ODBCINI 
is set to $ARBORPATH/bin/.odbc.ini.

To use these scripts so that Hyperion Essbase environment variables are available 
to your shell environment every time you log in, do one of the following after you 
run inst-sql.sh:     

● In the C shell, use the source command against odbc.csh in the .login 
or.cshrc file. For example, edit the.login or.cshrc file to include this 
line:

% source $ARBORPATH/setup/odbc.csh

● In the Bourne or Korn shell, use the . (dot) command against odbc.sh. in the 
.profile file. For example, edit the.profile file to include this line:

% . $ARBORPATH/setup/odbc.sh
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Binding Files for the MERANT DB2 driver 
on AIX or Solaris

➤ To bind files so the DB2 driver can understand the MERANT commands on AIX 
or Solaris, after you run inst-sql.sh, complete the following:     

1. Change to the $ARBORPATH/bin directory.

For example:

cd /home/hyperion/essbase/bin

2. Start the DB2 command-line interface.

For example:

db2

3. Connect to the DB2 database.

For example:

CONNECT TO DATABASENAME

4. Bind all files, or at least the .bnd files, in your $ARBORPATH/bin directory.

For example:

BIND iscsso.bnd

File names may change for new driver versions. For the files you need to bind, 
list all files with the bnd extension in the $ARBORPATH/bin directory.  

It is recommended that you bind all the files in the bin directory.

5. Grant user privileges for accessing data.

For more information about binding and granting privileges, see the MERANT 
DataDirect Connect ODBC Reference. 
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Editing .odbc.ini Driver Files 
To complete your ODBC driver setup after installing Hyperion Essbase SQL 
Interface, you need to modify.odbc.ini to include the correct driver and data 
source names. Examples are provided for the IBM DB2 driver on AIX, and for the 
MERANT DB2 driver on Solaris. 

Editing .odbc.ini for the IBM DB2 Driver on AIX

To set up your.odbc.ini file for DB2 Version 5 on AIX, after you run 
inst-sql.sh, do the following:       

Note: On AIX, inst-sql.sh prompts you to choose between the 
MERANT DB2 driver and the IBM Call-Level Interface (CLI) for 
DB2 driver. inst-sql.sh links SQL Interface to different libraries 
depending on which DB2 driver you choose. If you want to switch 
DB2 drivers sets after you run inst-sql.sh, re-install SQL 
Interface.     

In $ARBORPATH (the directory where Hyperion Essbase is installed), modify 
.odbc.ini to include the correct driver and data source name. 

Here is an example of an .odbc.ini file:

[ODBC Data Sources]
DB25SAMP=IBM DB2 ODBC DRIVER

[DB25SAMP]
Driver=/home/db2inst/sqllib/lib/db2.o
Database=dbname

[ODBC]
Trace=0
TraceFile=odbctrace.out
InstallDir=/home/db2inst/sqllib/odbclib

In these examples, /home/db2inst is the $INSTHOME directory. You cannot use 
environment variables in.ini files.

For more information on instances and other IBM-specific details, see the 
IBM manual, DATABASE 2—Installing and Using AIX Clients. See your 
IBM representative for the latest ordering information.
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Editing .odbc.ini for the MERANT Oracle Driver on Solaris

To set up your .odbc.ini file for Oracle 8 on Solaris, do the following after you 
run inst-sql.sh:    

In $ARBORPATH (the directory where Hyperion Essbase is installed), modify 
.odbc.ini to include the correct driver and data source name. 

For example:

[ODBC Data Sources]
Oracle8=MERANT 3.60 Oracle 8 Driver

[Oracle8]
Driver=/home/hyperion/essbase/dlls/ARor815.so
Description=Oracle8
ServerName=<name>

where <name> is the appropriate Oracle server name.

Configuring the Data Source and ODBC Driver
You have already:

● Installed SQL Interface

● Set up the ODBC driver for your platform/driver configuration

● Linked SQL Interface to the ODBC driver using inst-sql.sh 

● Set the library path for Hyperion Essbase

● Completed ODBC driver setup by editing the odbc.ini file

● Bound files in ESSBASE/bin, if you are using the DB2 driver

You are now ready to configure the data source. You may also need to configure 
your ODBC driver. To do these things, see the Hyperion Essbase SQL Interface 
Guide. This guide, Essqlint.pdf, is provided in the\ESSBASE\DOCS\CLIENT 
directory in.PDF format for online viewing and printing in Adobe Acrobat Reader 
(Version 3.0.1 or later).
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Chapter

9
Network Configuration Notes

This chapter provides information on the supported TCP/IP and Named Pipes 
network configurations. It serves as a checklist to help you ensure that the basic 
elements are installed and running on the client and server machines.     

Refer to your network and operating system documentation for detailed 
information on installing the software and services required to run Hyperion 
Essbase. Your software provider assumes no liability and does not guarantee 
the accuracy of this information.

This chapter contains the following sections:

● “TCP/IP Support” on page 184

● “Named Pipes Support” on page 186

● “Novell Using Named Pipes Support” on page 187

● “LAN Manager Using Named Pipes Support” on page 190
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TCP/IP Support
The following protocol stacks have been tested and are supported with Hyperion 
Essbase: 

Client Support: 

● Microsoft Windows 95 or Windows 98 Native TCP/IP

Server Support: 

● Windows NT or Windows 2000 Native TCP/IP from Microsoft

● Microsoft Windows 95 or Windows 98 Native TCP/IP (Personal Essbase 
only)

● HP-UX Native TCP/IP from Hewlett Packard

● AIX Native TCP/IP from IBM

● Solaris Native TCP/IP from Sun Microsystems

● Linux Native TCP/IP from Red Hat

Note: Check the conventional memory requirements of these drivers to 
ensure that you have sufficient memory available.

TCP/IP Protocol Stacks Tested and 
Supported with Hyperion Essbase

Client

Server

Windows NT 
Native TCP/IP

Windows 95/98 
Native TCP/IP

(Personal Essbase)

Windows 95/98 Native TCP/IP  
✔ 

✔ Connectivity is tested and supported with Hyperion Essbase.
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General TCP/IP Installation Procedures
This section provides general steps for installing TCP/IP. 

Server
TCP/IP is included with Windows and UNIX platforms. As part of defining the 
Windows or UNIX computer with the TCP/IP protocol, the computer name and IP 
address are defined during the operating system’s installation. 

Client

➤ To install TCP/IP on a client machine, follow these steps:

1. Install one of the supported protocol stacks.

2. For each server on the network, update the client HOSTS file to contain an 
entry for the server. For example, the following entry would be made for the 
server MAPLE at IP address 198.137.238.10:

198.137.238.10   MAPLE

The HOSTS file specifies the IP address of the server so the client can communicate 
with the server. A host is any device attached to the network that uses TCP/IP. To 
receive and deliver packets successfully between hosts, TCP/IP relies on 
information in the HOSTS file.   

Different TCP/IP vendors store HOSTS files in different locations, and some 
vendors allow you to change the location. The following describes the individual 
requirements for the protocol stacks supported by Hyperion Essbase:     

FTP: In the installation directory, FTP stores the file PCTCP.INI in which 
you specify the location of the HOSTS file. To set the location (in this case, to 
C:\PCTCP\HOSTS), add the following line to the[pctcp kernel]section of 
the.INI file:

host-table=C:\PCTCP\HOSTS

If you specified HOSTS during installation, this line is added automatically.
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Troubleshooting Common Connection Problems
Before attempting an Hyperion Essbase client-server connection, you should test 
the protocol installation to ensure the connection is installed properly.      

Use the PING command on the server to check that it is running and visible to your 
PC client. If the PING command is successful but the TELNET command is not, 
then there may be a problem with the inet daemon. If the PING command is 
unsuccessful on the server, you might have a routing or hardware problem.

Named Pipes Support
The following protocol stacks are tested and supported with Hyperion Essbase: 

Client Support: 

● Microsoft LAN Manager (NetBEUI)

● Microsoft Windows 95/98 Native NetBEUI

Server Support: 

● Windows NT/2000 Native Named Pipes (NetBEUI)

● Microsoft LAN Manager (NetBEUI)

Named Pipes Protocol Stacks Tested and 
Supported with Hyperion Essbase

Client
Windows NT/2000 Server 

NetBEUI

Windows 95/98 Native NetBEUI
✔ 

✔ Connectivity is tested and supported with Hyperion Essbase.
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Novell Using Named Pipes Support
Hyperion Essbase supports the Named Pipes protocol stack on Novell Netware 
LANs (local-area networks). Novell currently supports Named Pipes services for 
PC clients connecting to Windows NT servers, but does not offer support for 
UNIX servers.      

Windows Clients
This section contains information on connecting the Windows 95 or Windows 98  
client computer to Windows NT or Windows 2000 servers using Named Pipes.    

Connecting from Windows 95 or Windows 98 to 
Windows NT
To connect from Windows 95 or Windows 98 to Windows NT or Windows 2000 
using Named Pipes, you might need to connect to the Windows NT or Windows 
2000 server independently of Hyperion Essbase before attempting to connect to 
the Hyperion Essbase server. To connect to the Windows NT or Windows 2000 
server:   

1. Open Network Neighborhood from your Windows 95 or Windows 98 
desktop.

2. Locate the server name in the list. Double-click the server name.

3. If prompted, enter the password for the server, then click OK.

Figure 61: Entering the Server Password

When you are connected to the server, the server window appears showing 
one or more directories to which you have access.

4. Close the server window and Network Neighborhood. 

Now you are ready to connect to Hyperion Essbase.
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Increasing Connections on Windows 95 or 
Windows 98
When connecting from Windows 95 or Windows 98 to Windows NT or Windows 
2000 using Named Pipes, if you see the error message, Network error: Cannot 
receive data, try increasing the maximum number of connections on your 
Windows 95 or Windows 98 machine:      

1. Select Start > Settings > Control Panel.

2. Double-click the Network icon.

The Network dialog box appears.

3. In the list box entitled The following network components are installed, 
locate and double-click the option for NetBEUI. 

If you have more than one NetBEUI option, choose one of them.

The NetBEUI Properties dialog box appears. 

4. Click the Advanced tab.

5. Select Maximum Sessions in the Property list box. 



Network Configuration Notes

9

■ 189Hyperion Essbase Installation Guide

6. Increase the Value of the maximum sessions setting. 

You may need to experiment with this setting. In the example below, the 
setting was increased from 10 to 20.

Figure 62: Increasing the Maximum Sessions Value to 20

7.  When done, click OK.

8. Click OK to close the Network dialog box.

9. Close Control Panel. 

If prompted, reboot your machine.

Windows Servers
Novell supports Named Pipes service in its IPX protocol environment.    

Note: The Novell Named Pipes environment does not require the Windows 
NT server to log in to the file server.

After installing Windows NT or Windows 2000, install the NWLINK IPX/SPX 
driver on the Windows NT or Windows 2000 server. Select the Network options 
during installation or configuration of Windows NT or Windows 2000, and select 
NWLINK IPX/SPX.
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UNIX Server
Novell does not currently provide Named Pipes requestors for UNIX.  

LAN Manager Using Named Pipes Support
Hyperion Essbase supports the Named Pipes protocol stack on Microsoft LAN 
Manager LANs. Microsoft currently provides Named Pipes services for PC clients 
connecting to Windows NT servers, but does not offer support for UNIX servers.  

Windows Clients 
LAN Manager workstations must meet the following requirements:    

● Workstations must use LAN Manager 2.0 Enhanced (or above) drivers and 
have Named Pipes permission.

● Users executing “Net Logon” must attach to the appropriate server machine in 
the correct domain.

Windows Servers
LAN Manager support for Named Pipes service under Windows NT or Windows 
2000 is built-in, using NetBEUI.    

UNIX Server 
LAN Manager does not support Named Pipes service to UNIX.  
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Chapter

10
Advanced Installation Topics

This chapter describes how to update the Hyperion Essbase environment 
manually, how to configure Hyperion Essbase to use a non-English language, how 
to install Java components for Hyperion Essbase manually, and how to uninstall 
Hyperion Essbase software. It contains the following sections:

● “The Hyperion Essbase Environment” on page 191

● “Configuring Client and Server for Non-English Hyperion Essbase” on 
page 195

● “Manually Installing Java” on page 196

● “Advanced Configuration Options for Java” on page 204

The Hyperion Essbase Environment
This section explains the changes that are made to your system when you install 
Hyperion Essbase products, locally or to the network, using Windows NT 4.0, 
Windows 2000, Windows 95, or Windows 98.

When you install Hyperion Essbase products on UNIX platforms, you must update 
the environment manually. To learn how to update the UNIX environment for the 
Hyperion Essbase OLAP server, see Chapter 3, “UNIX Server Installation.” To 
learn how to update the UNIX environment for SQL Interface, see Chapter 8, 
“SQL Interface Installation.” To learn how to update the UNIX or Windows 
environment for Hyperion Essbase Application Programming Interface, see 
Chapter 7, “API Installation.”
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Environment Updates on Windows Platforms
When you install Hyperion Essbase products on Windows platforms, the 
installation program updates the following aspects of your computer’s operating 
environment automatically:

● Registry keys are added to enable the system to detect the location of 
Hyperion Essbase components.

● If you install Hyperion Essbase Spreadsheet Add-in, it is automatically added 
to the latest version of Microsoft Excel or Lotus 1-2-3 installed on your 
computer. The installation program adds Essbase to the Excel or 1-2-3 menu 
bar, and points Excel or 1-2-3 to the appropriate add-in file in the Hyperion 
Essbase BIN directory.      

Note: ESSEXCLN.XLL is the Add-in file for Excel. ESS123.12A is the 
add-in file for Lotus 1-2-3. ESSXLEQD.XLA is an additional 
add-in file for Hyperion Essbase Query Designer for Excel.

When you install Hyperion Essbase products (except for the API) on Windows 
platforms, the installation program optionally updates the following aspects of 
your client computer’s operating environment. You can select to perform these 
environment updates during installation, or you can perform these tasks manually.

● The $ARBORPATH system environment variable is created (or updated) 
to specify the root installation directory for Hyperion Essbase, and  
$ARBORPATH\Bin is added to the beginning of the path statement. These 
updates are required for running Hyperion Essbase. If you are re-installing 
Hyperion Essbase to the last pre-existing location, you may not need to update 
$ARBORPATH and Path.

● Program and help icons are added to the Hyperion Essbase 6.1 program group 
in the Windows Start Menu.
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Manually Updating the Environment on 
Windows Platforms

To run Hyperion Essbase, the operating system needs to know where Hyperion 
Essbase is located. If you chose not to let the installation program create or update 
the $ARBORPATH environment variable and add the $ARBORPATH\BIN directory 
to the system-wide PATH variable, you can do it manually. This section explains 
the following:

● “Manually Updating the Environment on Windows NT and Windows 2000” 
on page 193

● “Manually Updating the Environment on Windows 95 and Windows 98” on 
page 194

Manually Updating the Environment on 
Windows NT and Windows 2000

➤ To update the environment settings manually on Windows NT 4.0 or Windows 
2000, complete the following steps:      

1. Select Start > Settings > Control Panel > System.

2. Find the Windows environment variable controls.

● On Windows NT, choose the Environment tab.

● On Windows 2000, choose the Advanced tab, and click the 
Environment Variables button.

3. Set the following system variables:

● ARBORPATH=C:\HYPERION\ESSBASE, or wherever Hyperion Essbase 
is installed.

● Add %ARBORPATH%/BIN to the Path variable, or 
C:\HYPERION\ESSBASE\BIN, depending on where Hyperion 
Essbase is installed.

Note: You are changing System settings, which affect all users who 
access your machine.
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4. Remove other, outdated ARBORPATH system variables or ESSBASE\BIN 
Path settings.

5. Reboot your computer, or log out and log in, to allow the changes to 
take effect.

Manually Updating the Environment on 
Windows 95 and Windows 98

➤ To update the environment settings manually on Windows 95 and Windows 98, 
complete the following steps:      

1. Add the following environment variable to your AUTOEXEC.BAT file: 

ARBORPATH=C:\HYPERION\ESSBASE

where C:\HYPERION\ESSBASE is the local or network directory where 
Hyperion Essbase is installed.

Do not put a space before or after the equals sign (=) in the $ARBORPATH 
environment setting.

2. Add C:\HYPERION\ESSBASE\BIN to your PATH statement.

where C:\HYPERION\ESSBASE is the directory where Hyperion Essbase is 
installed. 

3. Remove references to installations of Hyperion Essbase in other directories.

Tip: You can type SET from an MS-DOS command prompt to view your 
current environment settings.   

4. Reboot your computer.
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Configuring Client and  Server for 
Non-English Hyperion Essbase

To use non-English versions of Hyperion Essbase successfully, you must set the 
ESSLANG variable to be the same on both the client computers and the server 
computer. 

Create the ESSLANG environment variable to point Hyperion Essbase clients and 
servers to the correct Uniscape code page (installed in the ESSBASE\LOCALE 
directory). If no ESSLANG value is set, the default is United States English. 

You can create the ESSLANG variable as a user variable or a system variable. If 
$ARBORPATH is defined as a system variable, create ESSLANG as a system variable 
also. If $ARBORPATH is defined as a user variable, create ESSLANG as a user 
variable.

ESSLANG settings should follow this format: ESSLANG=<locale> where <locale> 
is a supported Uniscape GlobalC locale of the format:

<Language>_<Territory>.<code page name>@<sort sequence> 

Examples of ESSLANG Settings:

ESSLANG=German_Germany.Latin1@Default
ESSLANG=French_France.Latin1@Default
ESSLANG=Spanish_Spain.Latin1@Spanish
ESSLANG=Italian_Italy.Latin1@Default
ESSLANG=Portuguese_Portugal.Latin1@Default
ESSLANG=Norwegian_Norway.Latin1@Danish
ESSLANG=Swedish_Sweden.Latin1@Swedish
ESSLANG=Danish_Denmark.Latin1@Danish
ESSLANG=Finnish_Finland.Latin1@Finnish
ESSLANG=Japanese_Japan.MS932@binary
ESSLANG=CanadianFrench_French-Canada.Latin1@Default
ESSLANG=TraditionalChinese_Taiwan.MS950@Binary
ESSLANG=SimplifiedChinese_China.MS936@Binary
ESSLANG=Albanian_Albania.ISO-8859-2@Default
ESSLANG=Arabic_SaudiArabia.ISO-8859-6@Default
ESSLANG=Bulgarian_Bulgaria.ISO-8859-5@Default
ESSLANG=Byelorussian_Belarus.ISO-8859-5@Default
ESSLANG=Catalan_Catalonia.Latin1@Default
ESSLANG=Croatian_Croatia.ISO-8859-2@Croatian
ESSLANG=Czech_CzechRepublic.ISO-8859-2@Czech
ESSLANG=Dutch_Netherlands.Latin1@Default
ESSLANG=Estonian_Estonia.ISO-8859-4@Estonian
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ESSLANG=Farsi_Iran.ISO-8859-6@Default
ESSLANG=Greek_Greece.ISO-8859-7@Default
ESSLANG=Hebrew_Israel.ISO-8859-8@Default
ESSLANG=Hungarian_Hungary.ISO-8859-2@Hungarian
ESSLANG=Korean_Korea.MS949@Binary
ESSLANG=Latvian_Latvia.ISO-8859-4@Latvian
ESSLANG=Lithuanian_Lithuania.ISO-8859-4@Lithuanian
ESSLANG=Macedonian_Macedonia.ISO-8859-5@Default
ESSLANG=Romanian_Romania.ISO-8859-2@Romanian
ESSLANG=Russian_Russia.ISO-8859-5@Default
ESSLANG=Serbian_Yugoslavia.ISO-8859-2@Default
ESSLANG=CyrillicSerbian_Yugoslavia.ISO-8859-5@Default
ESSLANG=Slovak_Slovakia.ISO-8859-2@Slovak
ESSLANG=Slovenian_Slovenia.ISO-8859-2@Slovenian
ESSLANG=Thai_Thailand.MS874@Thai
ESSLANG=Turkish_Turkey.ISO-8859-9@Turkish
ESSLANG=Ukrainian_Ukraine.ISO-8859-5@Ukrainian
ESSLANG=Vietnamese_VietNam.MS1258@Vietnamese

Manually Installing Java
Hyperion Essbase requires that you install both the JavaTM Runtime Environment 
(JRE) and the Java API for XML Parsing (JAXP) on computers running the 
Hyperion Essbase server to support the Java-based features in the product. The 
Java Virtual Machine (JVM) is a component of the JRE. 

To install Java to work with Hyperion Essbase, you must perform the following 
steps:

● Install the Java Runtime Environment (JRE).

● Install the Java API for XML Parsing (JAXP).

● Set the JVMMODULELOCATION parameter in the essbase.cfg file.

● On UNIX systems, set environment variables.

Note: You may need to install operating system patches to support the JRE. 
For more information, see “Installing the JRE on UNIX Systems” on 
page 198.

If you have already installed a supported version of the Java Runtime 
Environment, you do not have to reinstall the JRE. However, you must verify that 
the JAXP component is installed, set the JVMMODULELOCATION parameter, 
and, on UNIX systems, set additional environment variables.
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For more information about supported versions of the JRE, see “Windows Server 
Requirements” on page 26 or “UNIX Server Requirements” on page 58. 

Installing the Java Runtime Environment
The Java Runtime Environment is required by Hyperion Essbase to enable 
Java-based features, such as custom-defined macros and custom-defined 
functions. The JRE must be installed on the computer running Hyperion Essbase 
server. 

Note: After installing the JRE, you must install the JAXP package and set 
the JVMMODULELOCATION parameter to enable the Java-based 
functions of Hyperion Essbase. For installation on UNIX systems, 
you must also set environment variables.

Installing the JRE on Windows Systems
The Java Runtime Environment installation packages for Windows systems are 
self-installing executables that walk you through the installation of the JRE. 

➤ To install the Java Runtime Environment on Windows systems:

1. Insert the Hyperion Essbase CD-ROM into your CD-ROM drive.

2. Change to the root directory of the CD-ROM (for example, cd /cdrom).

3. Change to the directory containing the Java Runtime Environment (JRE) 
installer for the Windows system:

● For Windows 95 and Windows 98, change to the directory, 
\win32\server\win9x\jre\

● For Windows NT and Windows 2000, change to the directory, 
\win32\server\nt\jre\

4. Run the setup.exe file in the directory.

5. Follow the on-screen installation instructions to complete the installation of 
the JRE.

After the JRE installation is complete, install the JAXP package. For more 
information, see “Installing the Java API for XML Parsing” on page 199.
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Installing the JRE on UNIX Systems
The Java Runtime Environment installation packages and installation procedures 
for each of the supported platforms are substantially different. Readme files and 
installation instructions from the JRE providers are included in .txt or .htm files 
with each package. Review these instructions carefully. You may need to refer to 
the web site of the JRE provider for additional information about installing the 
JRE.

➤ To install the Java Runtime Environment on UNIX systems:

1. Log in as the Hyperion Essbase system administrator account. For example, 
log in as admin if you created a user account called admin that owns the target 
installation directory, /home/hyperion/essbase.

2. Insert the CD-ROM into your CD-ROM drive.

3. Change to the root directory of the CD-ROM (for example, cd /cdrom).

4. Change to the directory containing the Java Runtime Environment (JRE) 
install package for the operating system:

● For Solaris, change to the directory, /solaris/server/jre/

● For AIX, change to the directory, /aix/server/jre/

● For HP-UX, change to the directory, /hpux/server/jre/

5. Decompress the .tar file into a temporary directory using the UNIX tar utility.

6. Review the readme file in the directory for system requirements and 
installation instructions to complete the installation of the JRE. 

Note: Use of the JRE requires operating system patches on some 
platforms. Review the readme file for patch requirements and 
verify that you have installed the correct patch level to support 
the JRE you are installing.

7. Set any environment variables specified by the readme or installation 
instructions for the JRE you have installed. 

After the JRE installation is complete, install the JAXP package. For more 
information, see “Installing the Java API for XML Parsing” on page 199.
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Installing the Java API for XML Parsing
The JAXP is required by Hyperion Essbase to enable Java-based features such as 
custom-defined macros and custom-defined functions. You must install the JAXP  
on the computer running Hyperion Essbase server. Installation of the JAXP is 
required for all supported operating systems.

➤ To install Java API for XML Parsing: 

1. Log on to the computer that runs Hyperion Essbase.

● On Windows systems, log on with an account you use to run Hyperion 
Essbase.

● On UNIX systems, log on with the Hyperion Essbase system 
administrator account. For example, log in as admin if you created a user 
account called admin that owns the target installation directory, 
/home/hyperion/essbase.

2. Insert the CD-ROM into your CD-ROM drive.

3. Change to the root directory of the CD-ROM (for example, cd /cdrom).

4. Change to the directory containing the JAXP installation package for the 
operating system:

● For Windows 95 and Windows 98, change to the directory, 
\win32\server\win9x\jaxp\

● For Windows NT and Windows 2000, change to the directory, 
\win32\server\nt\jaxp\

● For Solaris, change to the directory, /solaris/server/jaxp/

● For AIX, change to the directory, /aix/server/jaxp/

● For HP-UX, change to the directory, /hpux/server/jaxp/
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5. In the \jaxp directory, perform one of the following steps:

● For Windows systems, run the setup.exe file and install the software 
into theJREHOME\lib\ext directory.

● For UNIX systems, locate the .zip file and use an unzip utility, such as 
WinZipTM or Info-ZIP, to decompress the .zip file into the 
JREHOME\lib\ext directory.

JREHOME represents the installation directory for the Java Runtime 
Environment.

● On Windows Systems, the default JREHOME location is C:\Program 
Files\JavaSoft\JRE\1.3\

● On Solaris, the default JREHOME location is /usr/j2se/jre/

● On AIX, the default JREHOME location is /usr/java130/jre/

● On HP-UX, the default JREHOME location is /opt/java1.2/jre/

In addition to these changes, you must set the JVMMODULELOCATION to 
enable Hyperion Essbase to find and load Java. For more information, see “Setting 
JVMMODULELOCATION” on page 200. 

Setting JVMMODULELOCATION
JVMMODULELOCATION is a setting in the essbase.cfg file that enables you 
to designate a specific installation of the Java Runtime Environment for use with 
Hyperion Essbase. This setting is particularly useful if you have multiple versions 
of Java installed on the computer running Hyperion Essbase server.



Advanced Installation Topics

10
■ 201Hyperion Essbase Installation Guide

To set the JVMMODULELOCATION parameters, you must specify the full path 
and filename of the Java Virtual Machine (JVM) library. The location and name 
of this library varies, depending on the JRE version and the operating system you 
are using. The default locations for the JVM are shown in the following table.

CAUTION: On Solaris, do not set the JVMMODULELOCATION to  
point directly to the libjvm.so file, or the JVM will crash 
when Hyperion Essbase attempts to load it. Set 
JVMMODULELOCATION to the symbolic link for this 
file. The default location for the symbolic link is 
/usr/j2se/jre/lib/sparc/libjvm.so.

➤ To set JVMMODULELOCATION: 

1. On the computer that runs Hyperion Essbase server, change to the 
ARBORPATH\bin directory.

2. Locate the essbase.cfg file in this directory and open the file in a text 
editor. If the file does not exist, create and open a new text file named 
essbase.cfg.

Table 20:  Default Locations and Names of JVM Library Files

Operating System 
(JRE version) Default Location and Name of JVM Library File

Windows systems 
(JRE 1.3)

C:\Program Files\JavaSoft\JRE\1.3\bin\hotspot\jvm.dll

Solaris (JRE 1.3) /usr/j2se/jre/lib/sparc/client/libjvm.so1

1  Do not set JVMMODULELOCATION to this location. See the following caution note for 
details.

AIX (JRE 1.2) /usr/java120/jre/bin/classic/libjvm.a

HP-UX (JRE 1.2) /opt/java1.2/jre/bin/PA_RISC/classic/libjvm.sl2

2 The directory, PA_RISC, may be PA_RISC2.0, depending on the processor used by the 
computer running HP-UX.
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3. In the essbase.cfg file, add a new line to the end of the file and type the 
following text:

JVMMODULELOCATION FullpathAndFilenameOfJvmLibraryFile

Do not include spaces in the path and filename. Do not enclose the parameter 
in quotation marks. A semicolon is not required at the end of the line. 

On Windows systems, be sure to specify the path and filename without spaces, 
as in the following example: 

JVMMODULELOCATION c:\progra~1\javasoft\jre\1.3\bin\hotspot\jvm.dll

4. Save the changed text file as essbase.cfg.

5. Close the file and exit the text editor.

On UNIX systems,you must update additional environment variables to enable the 
JVM to work with Hyperion Essbase in addition to these changes. For more 
information, see “Updating the Environment for Java on UNIX Systems” on 
page 202. 

Updating the Environment for Java on UNIX Systems
On AIX and HP-UX, you must update environment variables to enable Hyperion 
Essbase to use the Java Runtime Environment.

Updating Environment Variables for Java on 
Solaris
On Solaris, if you are using version 1.3 of the Java Runtime Environment, you 
must set an ESS_JVM_OPTION.

In the C shell, add the following text to the.cshrc file:

setenv ESS_JVM_OPTION1 "-XX:+AllowUserSignalHandlers"

In the Bourne or Korn shell, add the following text to the .profile file:

ESS_JVM_OPTION1=-XX:+AllowUserSignalHandlers; 
export ESS_JVM_OPTION1;
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Updating Environment Variables for Java on AIX
On AIX, you must update the LIBPATH setting to include the JREHOME/bin/ and 
the JREHOME/bin/classic/ directories. The default directory location for 
JREHOME is shown in the following examples.

Note: These LIBPATH directory entries must be added to the beginning of 
the LIBPATH environment variable.

In the C shell, add the following text to the .cshrc file:

setenv LIBPATH "/usr/java120/jre/bin: 
/usr/java120/jre/bin/classic:$LIBPATH"

In the Bourne or Korn shell, add the following text to the .profile file:

LIBPATH=/usr/java120/jre/bin:/usr/java120/jre/bin/classic: 
$LIBPATH; export LIBPATH;

Updating Environment Variables for Java on 
HP-UX
On HP-UX, you must update the SHLIB_PATH setting to include the 
JREHOME/lib/PA_RISC/ and the JREHOME/lib/PA_RISC/classic/ 
directories. The default directory location for JREHOME is shown in the 
following examples. 

Note: The directory, PA_RISC, may be PA_RISC2.0, depending on the 
processor used by the computer running HP-UX.

In addition, due to a problem with the Just In Time compiler in release 1.2.2 of the 
JRE for HP-UX, you must also set an ESS_JVM_OPTION.

In the C shell, add the following text to the .cshrc file:

setenv SHLIB_PATH "$SHLIB_PATH:/opt/java1.2/jre/bin/PA_RISC: 
/opt/java1.2/jre/bin/PA_RISC/classic"

setenv ESS_JVM_OPTION1 "-Djava.compiler=NONE"

In the Bourne or Korn shell, add the following text to the .profile file:

SHLIB_PATH=$SHLIB_PATH:/opt/java1.2/jre/bin/PA_RISC: 
/opt/java1.2/jre/bin/PA_RISC/classic; export SHLIB_PATH;

ESS_JVM_OPTION1=-Djava.compiler=NONE; export ESS_JVM_OPTION1;
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Advanced Configuration Options for Java
If you are having difficulties getting Hyperion Essbase to work with Java, it may 
be necessary to set start-up options for the Java Virtual Machine (JVM). You can 
make Hyperion Essbase use specific JVM start-up options when it loads the JVM 
by setting the environment variables ESS_JVM_OPTION1 through 
ESS_JVM_OPTION9. For Solaris and HP-UX, you must set one of these options 
so that Hyperion Essbase can work with the JVM.

For examples of setting ESS_JVM_OPTION environment variables, see 
“Updating Environment Variables for Java on Solaris” on page 202 and “Updating 
Environment Variables for Java on HP-UX” on page 203.

Note: Use and support of ESS_JVM_OPTION settings is likely to change 
in future releases of Hyperion Essbase.

Uninstalling Hyperion Essbase
You can uninstall Hyperion Essbase from Windows 95, Windows 98, Windows 
NT 4.0, and Windows 2000 platforms. This section helps you determine 
conditions for uninstalling Hyperion Essbase, and shows you how to uninstall 
Hyperion Essbase server and client software from your computer or from a 
network drive.

This section contains the following sub-sections:

● “Guidelines for Uninstalling” on page 204

● “What You Can Uninstall” on page 205

● “Instructions for Uninstalling” on page 206

Guidelines for Uninstalling
Before uninstalling Hyperion Essbase software, read the following guidelines:

● Do not manually delete, move, rename or alter Hyperion Essbase files and 
directories. This causes problems with uninstalling.

● Use the Windows Add/Remove Programs icon in the Control Panel to 
uninstall software, as described in “Instructions for Uninstalling” on 
page 206.

● If you want to reinstall Hyperion Essbase, uninstall the existing version first. 
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● You must uninstall Hyperion Essbase software components separately. 
They should be uninstalled in the following order (assuming you installed 
all components): API, Runtime Client, Spreadsheet Add-in for Excel, 
Spreadsheet Add-in for 1-2-3, Application Manager, SQL Interface, Hyperion 
Essbase OLAP server. This is the reverse of the recommended installation 
order.

● If you previously set up your client computer to share Hyperion Essbase client 
software on a network drive, and you want to install Hyperion Essbase to your 
local hard drive, uninstall the shared configuration first.

● If you perform two or more Hyperion Essbase installations on or from the 
same computer, note that the uninstaller removes only the last installation. 
Therefore, for ease of removal, it is recommended that system administrators 
who install software locally use a different computer to install software to a 
network drive for shared use.

● The uninstall program works only for Hyperion Essbase Release 6.0 and 
Release 6.1;  you cannot uninstall earlier releases using the Windows 
Add/Remove Programs method.

What You Can Uninstall
You can uninstall all types of Hyperion Essbase Release 6.0 and Release 6.1 
installations. This includes the following:

● Local installations of Hyperion Essbase OLAP server, Hyperion Essbase API, 
and Hyperion Essbase SQL Interface software on Windows NT 4.0 and 
Windows 2000.

● Local installations of Hyperion Essbase client software on Windows 95, 
Windows 98, Windows NT, and Windows 2000. Client software includes 
Hyperion Essbase Application Manager, Hyperion Essbase Spreadsheet 
Add-in, and the Hyperion Essbase Runtime Client.

● Network installations of Hyperion Essbase client software on Windows 95, 
Windows 98, Windows NT, and Windows 2000.

● Shared-use configurations, in which a local client computer is set up to run  
shared executables on the network. This type of uninstallation does not 
remove the software from the network drive; rather, it removes from the client 
hard drive the environment and registry settings which enable shared use.

● Local installations of Personal Essbase client and server software on 
Windows 95, Windows 98, Windows NT, and Windows 2000.
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Instructions for Uninstalling
To uninstall Hyperion Essbase, use the Windows Add/Remove Programs icon in 
the Control Panel.

➤ To uninstall Hyperion Essbase from Windows NT 4.0, Windows 95, Windows 98,  
and Windows 2000,

1. Select Start > Settings > Control Panel > Add/Remove Programs.

2. Complete the following step that is appropriate for your operating system:

● On Windows 95, Windows 98, and Windows NT 4.0:

On the Install/Uninstall tab, select the Hyperion Essbase program you 
wish to remove, and click Add/Remove.

● On Windows 2000:

Select Change/Remove Programs, select the Hyperion Essbase program 
you wish to remove, and click Change/Remove.

3. Click Yes to confirm that you want to remove the program.

4. If a Remove Shared File? prompt appears, click Yes To All.

Note: The prompt appears because Hyperion Essbase products are 
uninstalled individually, and many Hyperion Essbase files are 
shared with other Hyperion Essbase products. For example, 
ESSAPIN.DLL is installed with the Hyperion Essbase OLAP 
Server, as well as with client software and the Application 
Programming Interface. Clicking Yes To All makes uninstalling 
faster, and does not disrupt other programs installed on your 
computer.

Windows removes the program and associated files. If some elements of the 
program could not be removed, a Details button is present. 

5. Click Details for more information.

6. Click OK.
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Symbols
+s flag (UNIX), 162

A
access privileges, assigning, 126
accessing

add-on products, 20
online HTML documentation, xvi, 92
sample applications, 114, 126

activity log files
UNIX servers, 62, 68
Windows servers, 34

adding
Essbase Excel toolbar, 108
IP addresses, 50
server licenses, 21
Spreadsheet Add-in to Excel or 1-2-3, 110

add-on products, 20
Agent

console commands
UNIX, 76
Windows, 38

AIX servers, 57
API

installing, 158
library path, 161
system requirements, 154

LIBPATH setting, 72
multithreading, 62
system requirements, 59

AllowUserSignalHandlers option for Java, 202
API. See Application Programming Interface
api.tz, 160

APP directory
UNIX servers, 67
Windows servers, 33

Application Desktop window, 103
available applications in, 115
changing server names, 132

application files
default location on UNIX servers, 67
default location on Windows servers, 33
migrating from Release 5.x, 82
stored on client hard drive, 97

Application Manager
creating partition user, 128
default directories on network drive, 99
desktop, 101
installing

as shared on network drive, 94
to hard disk, 84
to network drive, 90

online help icon, 100
program files, 97
running, 100
sample applications, 114
shared network installation, 94
Spreadsheet Add-in and, 81
Start Menu icon, 100
system requirements, 80
troubleshooting connections, 104
upgrading, 81

Application Programming Interface (API)
API directory, 160
as an add-on product option, 20, 23
default directories, 160
files required to compile programs, 161
installation media, 156
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library files, 143
setting up environments, 161, 162
supported platforms, 153
system requirements, 154
UNIX servers, 157, 158

canceling installation, 159
prerequisites, 158

Windows servers, 156
Application Settings dialog box, 126
applications

displaying available, 115
migrating, 27
quitting, 38, 76
running with X Windows, 62
sample. See sample applications
starting automatically on Windows, 38
starting from Agent

UNIX servers, 76
Windows servers, 38

Applications list box, 115, 116
APPMAN32 directory, 99
ARBORPATH setting

manually updating, 192
for Windows Service, 41
in Windows 95/98 AUTOEXEC.BAT, 194
on Windows NT/2000, 193

problems with, 101
Runtime Client, 151
specifying, 46
UNIX servers, 69

assigning access privileges, 126
automatically entering passwords, 37
auto-starting

applications and databases on Windows, 38
Hyperion Essbase as a Windows service, 40
Hyperion Essbase when Windows starts, 37

available ports
displaying, 38, 76
licensing, 21

B
background process, starting Essbase on UNIX, 74
backup files, 28
backward compatibility, 81
base system components (Hyperion Essbase), 19

Basic Demo database
connecting to, 124
introduced, 113

Basic Sample database
connecting to, 116
introduced, 113

BIN directory, 97, 166
client software program files, 97
Runtime client program files, 146
UNIX server program files, 67
Windows server program files, 33

bind command, 179
bnd (.bnd) files, 166, 179
Bourne shell

environment settings
ARBORPATH, 69
library path (AIX), 71
library path (HP-UX), 71
library path (Linux), 72
library path (Solaris), 70
set path, 72
setting up drivers, 173, 174

Linux script, 66
Solaris script, 66

Browse button to select an installation directory, 31

C
C shell environment settings

ARBORPATH, 69
library path (AIX), 71
library path (HP-UX), 71
library path (Linux), 72
library path (Solaris), 70
set path, 72

Cache Memory Locking
Linux servers, 66
Solaris servers, 66

CALCCOMP sample data file, 138
CALCDAT sample data file, 118
CALCEAST sample data file, 140
Call-Level Interface DB2 driver. See IBM DB2 

drivers
canceling installation, 29
CD-ROM installation

API on UNIX, 158
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client and server simultaneously (Windows), 27
client software on hard disks (Windows), 84
client software on network (Windows), 90
over previous releases on Windows, 27
server software on UNIX, 63
server software on Windows, 29

changing
environment settings

manually on Windows 95/98, 194
manually on Windows NT/2000, 193
Runtime Client, 151
UNIX servers, 69

network protocols, 96
partition definition files, caution, 128
passwords, 38, 76
server names

by editing the Windows HOSTS file, 50
in sample partition definitions, 132

Windows NT network settings, 35
character-set files

API, 161
client software (Windows), 99
UNIX servers, 68
Windows servers, 34

Check Setup Information dialog box
client installation, 93
client network protocol update, 96
shared client installation, 95
shared Runtime Client installation, 149
Windows server installation, 32

choosing network protocols for Runtime Client 
installation, 147

CLI DB2 driver. See IBM DB2 drivers
CLIENT directory, 97
client installations

from network to hard drive, 88
guidelines, 82
Named Pipes network protocols, 186
selecting components, 91
specifying destination directory, 92
TCP/IP network protocols, 184, 185
to hard disks, 84
to network drives, 90

Client Setup and Destination Directory dialog box, 
92

client software

directories created, 97
installing

as shared on network drive, 94
from network drives, 87
to hard disk, 84
to network drive, 90

network protocols, 96
closing Essbase. See quitting from Agent
code pages, setting the ESSLANG environment 

variable, 195
communication protocols. See network protocols
Company database, 113
components

add-on, 20
documentation, xiv
order for installing, xiii, 24
order for uninstalling, 205

Connect command, 48, 102
connection errors, 104, 188
connection protocols. See network protocols
connections

database, 116, 124, 174
displaying

UNIX server, 76
Windows server, 38

increasing numbers, 188
Personal Essbase, 48, 187
terminating, 131
testing, 186
to server from Application Manager, 102
to server from Spreadsheet Add-in, 107
to Windows NT/2000 server from Windows 

95/98 client, 187
troubleshooting, 104

console commands
UNIX servers, 75
Windows servers, 38

copying Hyperion Essbase client application files, 82
creating partition users, 128
cshrc (.cshrc) files, 69
CURRCALC sample data file, 121
Currency Conversion, sample databases for, 113

D
Data Load dialog box
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loading data files for Samppart database, 138
loading data for Basic database, 117
loading data into Sampeast East database, 140

DATA sample data file, 124
database files stored on client hard drive, 97
database instances

define DB2 instance names, 174
set DB2 environment variable, 172

databases
connecting to DB2, 174
default location on UNIX, 67
default location on Windows, 33
migrating, 27
preparing Demo Basic, 124
preparing Sample Basic, 116
sample. See sample databases
starting automatically on Windows, 38

Databases list box, 117
DB2 drivers

implementing, 179, 181
instance names, 172, 174
setting up, 172, 173, 180
switching, 180

DB2INSTANCE setting, 173, 174
DB2INSTANCEPATH setting, 174
DDB (.DDB) files

caution for changing, 128
changing server names, 132
storage for partition definitions, 127

defining server names, 48
defining startup settings on Windows servers, 38
deleting. See removing
Demo application

introduced, 113
loading, 124

detaching from servers, 131
Dial-Up Adapter, configuring, 51
direct I/O on UNIX file systems, 62
directories

API, 160
APPMAN32, 99
BIN, 97, 166
cautions against moving/renaming, 33, 100
CLIENT, 97
client software, 97
DOCS, 98

DOCS\CLIENT, 166
ESSEXC32, 99
ESSLOT32, 99
for installing Spreadsheet Add-in from network, 

99
INCLUDE, 160
LIB, 160
LOCALE, 34, 68, 99, 161
moving/renaming (caution), 33, 100
network installations of Application Manager, 99
ODBCDocs, 166
ownership requirements (UNIX), 63, 158
Personal Essbase, 46
REDIST, 160
RUNTIME, 99
Runtime Client

hard drive, 148
network drives, 146

selecting, 31
specifying client destination, 92
specifying server destination

UNIX, 63
Windows, 31

SQL Interface default, 166, 170
UNIX servers, 67
Windows server default, 32

disconnecting from servers, 131
disk space

AIX system requirements, 59
API requirements, 154, 155, 156
API system requirements, 154
Application Manager, 80
HP-UX system requirements, 60
Linux system requirements, 61
Runtime Client, 144
Solaris system requirements, 58
Spreadsheet Add-in, 80
Windows system requirements, 26

displaying
available applications, 115
Excel Essbase toolbar, 109
Readme file, 32, 93
server information (UNIX), 76
server information (Windows), 38

DLLs. See dynamic-link libraries (DLLs)
DOCS directory, 98
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docs.tz, 160
DOCS\CLIENT directory, 166
documentation

about HTML documentation, xvi
API Reference, xvi
formatting conventions, xiii
HTML, 98
installing with API, 157
licensed separately, 20
listed, xiv
location of, 98
of additional products, 20
readme file

in ESSBASE directory, 24
location, 22

Technical Reference, xvi
dot command in SQL Interface setup on UNIX, 178
driver manager library, 174
dual boot configurations, 46
DUMP command (Agent)

UNIX servers, 76
Windows servers, 38

dynamic-link libraries (DLLs)
Application Programming Interface, 157, 162
backward compatibility, 28
client software, 96
network protocols, 27
Runtime Client, 145

E
East database, 113
embedded server names, changing, 132
entering user name and password

when creating partition user for sample 
applications, 130

when logging into server from Application 
Manager, 102

when starting Essbase, 36
environment

add-in added, 192
API installations, 161, 162
Application Manager, run on network drives, 94
client installation choices, 87, 89, 93
ESSLANG variable for non-English Essbase, 195
manually updating

for API, 161
for Runtime Client, 151
on Windows 95/98, 194
on Windows NT/2000, 193
Windows NT/2000, 193

prerequisites, 23
program group icons, 192
rebooting computer and, 32, 93
Runtime Client

manually updating, 151
network drives, 149
sharing on the network, 149
Windows platforms, 151

sample applications, 127
Spreadsheet Add-in, run on network drives, 94
SQL Interface

on UNIX, 171
updating with shell scripts on UNIX, 178

UNIX
overview, 69
updating, 69

UNIX information in hyperionenv.doc, 69
UNIX servers, 69
updating on UNIX, 69
Windows Registry, 192
Windows server installation choices, 31
Windows updates, 192

error messages
Cannot initialize Essbase, 101
Cannot receive data, 188
File not found, 111
Spreadsheet Add-in, 111
startup, 105
Unable to Connect to hostname, 104, 105
Unable to Locate hostname in Hosts File, 49, 105
when starting UNIX server, 73
when starting Windows server, 36
Windows connections, 188

ESS_JVM_OPTION settings, 204
ESS123.12A

add Lotus 123 manually, 112
for releases 9.1 and 9.5, 110
in BIN directory, 97

ESSADMIN.EXE, 97
Essbase

additional products, 20
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order for installing components, 24
performance, optimizing, 35
product components, 19

selecting client products, 91
quitting from Agent

UNIX servers, 76
Windows, 38

running as a service, 39
starting automatically on Windows, 37
starting on UNIX, 73
starting on Windows, 36
supported protocol stacks, 185, 187
upgrades

client software, 81
licensing, 21
prerequisites, xii
sample applications and, 114

ESSBASE directory, 31
Essbase Perl Module

installed location on UNIX, 68
installed location on Windows, 34, 99

Essbase System Login dialog box
Application Manager, 102
Spreadsheet Add-in, 107

Essbase toolbar, 108
ESSBASE.BAK, 28
ESSBASE.MDB, 101
Essbase.pm

location of, on Windows, 34, 99
essbase.pm

location of, on UNIX, 68
on UNIX, 67
on Windows, 33
UNIX, 67

ESSBASE.SEC
backup of, 28
description, 114
security file, 28

essbase.secure, 75
ESSCMD and Personal Essbase, 46
ESSCMD icon, 100
ESSEXC32 directory, 99
ESSEXCLN.XLL

Add-in file for Excel, 192
add-in file for Excel 97 and Excel 2000, 110
description, 97

upgrades and, 82
used in manually adding Hyperion Essbase 

Spreadsheet Add-in to Excel, 112
essinst

executable file for installing, 64
SQL Interface on UNIX, 65

ESSLANG environment variable, 68, 195
ESSLOT32 directory, 99
essmsh, 67
essmsh (MaxL Command Shell on UNIX), 67
essmsh.exe, 33
essmsh.exe (MaxL Command Shell on Windows), 33
ESSNET.DLL, 27, 96, 145, 157
esssql.cfg, 173
ESSSQL.DLL, 166
ESSTOOLB.XLS, 108
essunins.dll, 33, 100
ESSXLEQD.XLA, 110, 192
example applications. See sample applications
example spreadsheets. See sample spreadsheets
Excel add-in

Essbase toolbar, 108
installation of ESSEXCLN.XLL, 192

executables. See shared executables
exiting

Agent EXIT command (UNIX), 76
Agent EXIT command (Windows), 38

F
file systems on UNIX, 62
File Transfer Protocol (FTP) hosts, 185
files

API library, 143
application log files, 68
application logs

UNIX, 62
Windows, 34

Application Manager, 97
BND (.BND), 166
cautions against moving/renaming, 33, 100
cshrc (.cshrc), 69
essinst, 64
ESSSQL.DLL, 166
essunins.dll, 33, 100
extraneous, 73
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hosts file (Windows), 50
Hyperion Essbase client program files 

(Windows), 97
Hyperion Essbase PDFs, xiv
Hyperion Essbase program files (Windows), 33, 

100
hyperionenv.doc, 69
in BIN directory, 97
INDEX.HTM as documentation starting point, 

xvi
ISU (.ISU), 33, 100
language support, 34
LIC (.LIC), 166
migrating client applications, 82
moving/renaming (caution), 33, 100
network protocol, 27, 96, 145
NLS (.NLS), 34
ODBC drivers and documents, 166
odbc.ini (.odbc.ini), 180
profile (.profile), 69
required to compile API programs, 161
root.sh, 66
Runtime Client

client drives, 148
installation, 143

security files, 28
setup.sh, 63
shared library (.sl), 162
Spreadsheet Add-in, 97
SQL Interface

UNIX, 170
Windows, 166

UNIX activity logs, 68
UNIX default locations, 67
upgrades and Spreadsheet Add-ins, 82
Windows default locations, 33

FTP (File Transfer Protocol) hosts, 185

H
hard disk drives

client software, 84
Runtime Client, 147

HELP command (Agent)
UNIX servers, 76
Windows servers, 38

help for ODBC drivers, 164
host name options for Personal Essbase, 48
hosts file

configuring on Windows, 50
error message, 49
installing TCP/IP, 185

HP-UX servers, 57
API installation, 158

environment setup, 162
system requirements, 155

multithreading, 62
network protocols, 60
SHLIB_PATH setting, 71
system requirements, 60

HTML documentation
about installing, xvi
API Reference, xvi
installing with API

on UNIX, 160
on Windows, 157

installing with Application Manager on 
Windows, 92

location in DOCS directory, 98
recommendation, 92
Technical Reference, xvi

Hyperion Integration Server, 20, 23
hyperionenv.doc, 69

I
I/O types and UNIX file systems, 62
IBM DB2 drivers

instance names, 174
setting up, 173, 180
switching, 180

icons
added to Windows Start Menu, 192
program, 100

implementing network protocols, 27
INCLUDE

directory (API), 160
setting in Path statement (API), 161

INDEX.HTM, xvi, 92, 98
Install to client option, 145
installation

API
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on UNIX, 158
on Windows, 156

canceling, 29
client software

from network to hard disk, 88
sharing on network, 94

HTML documentation
recommendation, 92
requirements, xvi

network protocols
Named Pipes Services, 190

IPX protocol environment, 189
required for LAN Manager, 190
Windows Client, 187

TCP/IP hosts, 185
order for installing Hyperion Essbase products, 

xiii, 24
Personal Essbase, 46
previous releases and, 27
recommendations, 23
Runtime Client

directories created, 146
options, 145

sample applications, 24
server software

on UNIX, 65
on Windows, 29

shared networks, 145
INSTHOME setting, 172
inst-sql.sh

files generated by, 178
linking SQL Interface to ODBC drivers, 175
prerequisite for running, 172

Integration Server, 20, 23
Interntl database

connecting to, 120
introduced, 113

INTERSOLV ODBC drivers. See MERANT ODBC 
drivers

invalid server names, 105
IP addresses

locating, 102
Microsoft Loopback Adapter

adding to host, 50
specifying, 54

TCP/IP-enabled server, 103

J
Java

advanced configuration options, 204
requirements for AIX, 59
requirements for HP-UX, 60
requirements for Solaris, 58
requirements on Windows systems, 26
setting environment variables on UNIX systems, 

202
Java API for XML Parsing

installing manually, 199
Java Runtime Environment

installing manually, 197
Java Virtual Machine

default library location, 201
relationship to Java Runtime Environment, 196

Java, installation requirements, 196
Java, installing automatically on Windows systems, 

30
Java, installing manually, 196
JAXP. See Java API for XML Parsing
JRE. See Java Runtime Environment
JREHOME variable, 200
Just In Time compiler option for Java on HP-UX, 203
JVM. See Java Virtual Machine
JVMMODULELOCATION setting

defined, 200
setting parameter, 200

K
Korn shell

environment settings
ARBORPATH, 69
library path (AIX), 71
library path (HP-UX), 71
library path (Linux), 72
library path (Solaris), 70

L
language support by setting the ESSLANG 

environment variable, 195
LANs. See Microsoft LAN Manager; Novell Netware 

LANs
LD_LIBRARY_PATH setting, 161, 162
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learning aids, 24
LIB

directory (API), 160
setting in Path statement (API), 161

LIBPATH setting
DB2 driver on AIX, 174
UNIX servers, 70

libraries
driver manager, 174
dynamic-link. See dynamic-link libraries
UNIX API, 154, 155, 156
UNIX servers, 69, 70
Windows API, 154

library path
AIX, 71
HP-UX, 71
Linux, 72
Solaris, 70

LIC (.LIC) files, 166
licensing

additional products, 20
add-on products, 20
Personal Essbase, 47
upgrades and, 21
viewing supported products

client software, 91
Windows platforms, 30

Linux servers
API library path, 162
Cache Memory Locking, 66
for Hyperion Essbase OLAP Server, 57
LD_LIBRARY_PATH setting, 72
multithreading, 62
network protocols, 61
post-installation shell script, 66
system requirements, 61
system requirements for API install, 156

loading
data, 138, 140
sample applications, 116

local area networks. See Microsoft LAN Manager; 
Novell Netware LANs

local client installations
directories created, 97

LOCAL server name, 48
locale directory

created under some Hyperion Essbase products, 
99

description, 34, 68
on UNIX, 161
setting the ESSLANG environment variable, 195

localhost server name, 132
log files

UNIX servers, 62, 68
Windows servers, 34

logging in, 102
from Application Manager, 102
from Spreadsheet Add-in, 107
to sample applications, 131

logging out
sample applications, 131
UNIX servers, 76
Windows servers, 38

Logout dialog box, 131
LOGOUTUSER command (Agent)

UNIX servers, 76
Windows servers, 38

Lotus 1-2-3 add-in file
installation of ESS123.12A, 192
manually adding, 112

LPATH setting, 162
ls command (UNIX), 64, 65, 159

M
Manage Add-Ins dialog box (Lotus 1-2-3), 112
manually updating environments

Runtime Client, 151
Spreadsheet Add-ins, 192
UNIX servers, 69

Maximize Throughput for Network Applications 
option, 35

MaxL
documentation installed, xvi
installed on Windows servers, 33
on UNIX, 67
on Windows, 33

memory
AIX system requirements, 59
API requirements, 154, 155, 156
API system requirements, 154
Application Manager, 80
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HP-UX system requirements, 60
Linux system requirements, 61
Runtime Client, 144
Solaris system requirements, 58
Spreadsheet Add-in, 80
Windows system requirements, 26

MERANT ODBC drivers
binding files, 179
DB2, 172, 181
Oracle, 181

MERANTODBC drivers
linking to SQL Interface, 175

Microsoft LAN Manager, 190
Microsoft Loopback

configuring TCP/IP hosts, 54
IP addresses

adding to host, 50
specifying, 54

Windows NT/2000 Personal Essbase, 53
Microsoft Windows. See Windows
migrating. See upgrading
moving files and directories, 33, 100
multiple network protocols, 27
multithreaded UNIX programs, 62

N
Named Pipes Services protocol, 23, 186

client installations, 187, 190
optimizing, 48
server names and, 48
UNIX servers, 190
Windows NT servers, 190
Windows NT/2000 servers, 189

NetBEUI Properties dialog box (Windows), 188
Network dialog box (Windows), 51
Network error

Cannot receive data message, 188
Unable to Create Host Server Socket, 49
Unable to Locate in Hosts File, 49

Network Protocol dialog box used by Windows 
platforms, 31

network protocols
Application Manager, 144

problems with, 104, 105
specifying, 147

changing, 96
client software, specifying, 89
files installed on Windows, 27, 96
files installed with Runtime Client, 145
Microsoft LANs, 190
Named Pipes installations, 187

Windows Client, 190
Windows NT servers, 189, 190

Novell LANs, 187
optimizing Named-Pipes Services, 48
selecting

client installations, 92
Windows platforms, 31

server names and, 48
supported, 183
supported protocol stacks, 185, 187
TCP/IP installations, 185
troubleshooting, 186
types, 23
UNIX servers, 61

AIX platforms, 59
HP-UX platforms, 60
Solaris platforms, 58

Windows servers, 26
network settings, changing (Windows NT), 35
networking

configuring Windows hosts file, 50
Dial-Up simulation method, 51

networks
Application Manager environment setup, 94
client software, 90

directories created, 97
installing, 83, 87

configurations. See network protocols
performance, optimizing on NT, 35
Runtime Client

directories created, 146
installation options, 145
running, 149
sharing on network, 149

Spreadsheet Add-in
running, 106
setting up environment, 94

NLS (.NLS) files
in locale directory

API, 161
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UNIX server, 68
Windows clients, 99
Windows servers, 34

Novell Netware LANs, 187
NWLINK IPX/SPX drivers, 189

O
ODBC drivers

implementing, 179, 181
linking to SQL Interface

on UNIX servers, 172
running inst-sql.sh, 175

setting up IBM DB2 .ini files, 180
odbc.csh script, 178
odbc.ini (.odbc.ini)

editing for DB2 driver on AIX, 180
editing for Oracle driver on Solaris, 181

odbc.sh script, 178
ODBCDocs directory, 166
OLAP Server

backward compatibility, 82
connecting to. See connections
names, 128

changing, 132
invalid, 105
IP addresses as, 103
Named Pipes systems and, 48
selecting, 102
Windows connections, 48

sample applications and, 114
starting, 36, 73
UNIX installation

platforms, 57
prerequisites, 63
server software, 63

Windows installation, 25
online HTML documentation

accessing, xvi, 92
installing with API

on UNIX, 160
on Windows, 157

installing with Application Manager on 
Windows, 92

location in DOCS directory, 98
recommended installation, xvi, 92

opening sample applications, 116, 124
operating environments. See environment
order for installing Hyperion Essbase products, xiii, 

24
order for uninstalling Hyperion Essbase products, 

205

P
paging space

AIX system requirements, 59
HP-UX system requirements, 60
Linux system requirements, 61
Solaris system requirements, 58

partition definitions, 127
Partition Manager dialog box, 133
partition users, creating, 128
partitioning, 20, 22, 113
PASSWORD command (Agent)

UNIX servers, 76
Windows servers, 38

passwords
automatically entering, 37
changing, 38, 76
entering, 102, 130
hiding in UNIX process listings, 75
server startup, 36

PATH setting
Application Programming Interface, 161
in Windows 95/98 AUTOEXEC.BAT, 194
installilng Personal Essbase, 46
manually updating, 192
manually updating on Windows 95/98, 194
Runtime Client, 151
Windows NT Service, 41
Windows NT/2000, 193

PCTCP.INI, 185
PDF files, location of, 98
performance, optimizing, 35
Perl module

on UNIX, 67
on Windows, 33

Perlmod directory
UNIX, 68
Windows, 34, 99

Personal Essbase
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components, 46
installation guidelines, 46
licensing, 47
limitations, 47
manually updating environment, 194
using without network connectivity on Windows 

95/98, 51
Windows NT installation, 46

physical memory
AIX system requirements, 59
HP-UX system requirements, 60
Linux system requirements, 61
Solaris system requirements, 58

PING command, 186
ports

available, 21
PORTS command (Agent)

UNIX servers, 76
Windows servers, 38

ports, available
displaying, 38, 76

previous versions, installing over, 27
privileges, assigning, 126
product components, 19

installation order, 24
viewing licensed

client software, 91
Windows platforms, 30

product directory installation (UNIX), 65
products

add-on, 20
independent, 20
order for installing, xiii, 24
order for uninstalling, 205

profile (.profile) files, 69
profile files, 69
program files

Application Manager, 97
copying Spreadsheet Add-ins and, 82
location of, 97
Runtime Client

client drives, 148
location on network, 146

Spreadsheet Add-in, 97
SQL Interface, 166, 170
UNIX default locations, 67

Windows servers, 33
program icons, 100

added to Windows Start Menu, 192
protocol stacks, supported, 185, 187
protocols. See server protocols, network protocols
ps utility, hiding password on UNIX, 75

Q
QUIT command (Agent), 76
quitting

Essbase
from Agent (UNIX), 76
from Agent (Windows), 38

R
RAM. See memory
RATES sample data file, 122
readme file, 22, 24
README.TXT

directory, 24
displaying, 32, 93, 95
in ESSBASE directory, 22

rebooting computer
after installation, 32
Spreadsheet Add-ins, 110
to complete client installation, 93

REDIST directory (API), 160
REGISTER.EXE, 22
registration

new licenses, 22
part of installation, 21

registration utility, 22
registry, environment updates, 192
reinstalling

DB2 drivers, 180
Spreadsheet Add-in, 109

Remove Shared File prompt, 206
removing

Essbase Service (Windows), 45
extraneous UNIX files, 73

renaming files and directories, 33, 100
Report Writer, 113
resetting Essbase Service, 44
restoring security settings, 28
root directory installation (UNIX), 64
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root.sh script, 66
running Application Manager
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UNIX servers, 76
Windows servers, 38
X Windows and, 62
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as Windows NT/2000 Service, 39
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running installation programs
Application Programming Interface

UNIX servers, 159
Windows servers, 156
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hard disk drives, 88
network drives, 94

root.sh script on UNIX, 66
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Windows, 29

running Spreadsheet Add-in, 106
Runtime Client
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network installation, 146
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network protocol files, 145
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prerequisites, 144
to hard disks, 147
to network drives, 145

manually updating the environment, 151
running on network drive, 149
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changing server names, 132
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loading data, 140
setting up environments, 127
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introduced, 113
loading, 116
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accessing, 114, 126
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included, 113
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Sample Xchgrate, 122
Samppart Company, 138
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purpose for, 24
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UNIX servers, 73
upgrades and, 114
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Spreadsheet Add-in, 97

Samppart application
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creating partition user, 128
introduced, 113
loading data, 138
setting up environments, 127

secure password script, 75
security, 28
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Agent commands (UNIX), 76
Agent commands (Windows), 38
backup files, 28
security file, 28

security file, 114
backup of, 28
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Select Components dialog box
client products, 91
Windows platforms, 30

Select Sub-components dialog box
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Windows platforms, 30
selecting network protocols, in Application Manager, 
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Windows platforms, 31
server installations

Named Pipes network protocols, 186
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TCP/IP network protocols, 184
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server licenses, adding, 21
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changing, 132
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invalid, 105
IP addresses as, 103
Named Pipes systems and, 48
selecting, 102
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Application Manager, 144
problems with, 104, 105
specifying, 147
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Windows Client, 187, 190
Windows NT servers, 189, 190

optimizing Named Pipes Services, 48
Runtime Client, 145
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Windows platforms, 31
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Spreadsheet Add-in, 80
supported protocol stacks, 185, 187
TCP/IP installations, 185
troubleshooting, 186
UNIX servers, 61
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HP-UX platforms, 60
Solaris platforms, 58

Windows servers, 26
server.tz files, 73

SET command, viewing environment settings on 
Windows 95/98, 194

Set Network Component Type dialog box 
(Windows), 52

set path command (UNIX), 72
Settings command, 126
Setup Complete dialog box

client installation, 93
shared client installation, 95
Windows platforms, 32

setup directory, SQL Interface environment scripts, 
178

SETUP.EXE
Application Programming Interface, 156
client software on networks, 88
client software on Windows, 90
Runtime Client, 146
server software on Windows, 29

setup.sh, 63, 159
shared executables

client drives, 145
network drives, 145, 146

shared files, uninstalling, 206
shared libraries, UNIX servers, 69, 70
shared network installations, 145
shell environments, 178
SHLIB_PATH setting, 162
SHUTDOWNSERVER command, 75
shutting down UNIX servers, 69, 75
SMP (symmetric multiprocessing), 62
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licensing Personal Essbase, 47
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Software Registration Card, 21
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API installation, system requirements, 155
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Cache Memory Locking, 66
installing SQL Interface, 67
LD_LIBRARY_PATH setting, 70
LIBPATH setting, 70
multithreading, 62
network protocols, 58
post-installation shell script, 66



Index

■ 221Hyperion Essbase Installation Guide

SQL Interface and
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ODBC DB2 driver setup, 172
ODBC driver setup, 172
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added automatically, 192
adding to Excel or 1-2-3 menu, 192
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starting, 106
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troubleshooting, 110
upgrading, 81
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SQL Drill-Through
backwards support, 82
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compatibility with Essbase releases, 164
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on UNIX, 170
on Windows, 166

environment
on UNIX, 171
on Windows NT/2000, 165

environment setup scripts (UNIX), 178
installing

on UNIX, 166
on Windows NT/2000, 164
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simultaneously with OLAP server on 

Windows, 30, 165

linking to ODBC drivers (UNIX), 175
root.sh prompt, 67
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starting
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UNIX servers, 76
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Windows NT/2000 servers, 36
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startup errors

Application Manager, 101, 104
Spreadsheet Add-in, 111
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Windows server, 36
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UNIX servers, 74
Windows NT servers, 36

startup settings
restoring, 28
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static libraries (API), 162
STOP command (Agent)

UNIX servers, 76
Windows servers, 38

stopping Essbase Service on Windows NT/2000, 43
summary panel, Windows platforms, 32
supported protocol stacks, 185, 187
supported server protocols, 23
swap space

AIX system requirements, 59
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Linux system requirements, 61
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symmetric multiprocessing (SMP), 62
system environment variables, manually updating, 
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system passwords, 102
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Windows platforms, 36
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Application Manager, 144
Application Programming Interface, 154
Spreadsheet Add-in, 80
UNIX servers, 58
Windows servers, 26
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target directories (UNIX)

accounts for, 63
creating, 158

TCP/IP protocol, 23, 184
Dial-Up Adapter configurations, 51
installing, 185
server names and, 49
troubleshooting, 186
Windows Personal Essbase servers, 54

telnet
failing TELNET command, 186
viewing application messages (UNIX), 62

terminating server connections, 131
testing server connections, 186
threads

UNIX supported thread libraries, 62
throughput, maximizing, 35
toolbar (Spreadsheet Add-in), installing, 108
troubleshooting

Application Manager connections, 104
Spreadsheet Add-in, 110
Windows hosts file, 49
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uninstalling

cautions, 33, 100
guidelines, 205
order, 205
shared file prompt, 206
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UNIX
file systems and direct I/O, 62
hiding password, 75
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UNIX servers

API installation, 157, 158
prerequisites, 158
setting up environments, 161, 162
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creating target directories, 158
default directories, 67
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installing
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logging out of, 76
multithreaded programs, 62
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HP-UX platforms, 60
installing, 185
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not supported, 190
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registration utility, 22
removing extraneous files, 73
shutting down, 69, 75
SQL Interface

DB2 driver setup (IBM), 173
DB2 driver setup (MERANT), 172
environment overview, 171
library path, 178
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starting Essbase, 73
startup information, 74
supported types, 57
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target directories, 63
updating environment, 69
updating environment for Java, 202

Update Environment dialog box
client software installation, 87, 89, 93
Windows platforms, 31
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Windows NT/2000, 193
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prerequisites, xii
server license, 21

user names
entering, 102, 130
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USERS command (Agent)

UNIX servers, 76
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VERSION command (Agent)
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versions
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Windows
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TCP/IP hosts, 54
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Windows 95/98
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registration utility, 22
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setting program directories, 31
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